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INTRODUCTIONINTRODUCTIONINTRODUCTIONINTRODUCTIONINTRODUCTION

You’ve just been invited to deliver an important presentation. The conference room
will be filled with clients, shareholders, and key officials, and you want this presenta-
tion to be the best you’ve ever given.

Where do you begin? One place to begin is with Microsoft PowerPoint 2000. This
amazing software can make you look like a genius . . . and even earn you an occasional
standing ovation. When it comes to giving presentations, in fact, PowerPoint can be
your best friend from start to finish . . .

. . . which is maybe why you’re reading this book or considering this book. However,
one problem with many books about PowerPoint is this: They’re only about
PowerPoint.

In comparison, we’ve written this book to help you deliver outstanding presentations.
We assume that you don’t need to become an expert authority in using PowerPoint.
You just want to be knowledgeable enough to produce effective presentations with
slides and handouts. You’ll learn plenty about using commands, dialog box buttons,
and animation features; PowerPoint has more capabilities than most executives will
probably ever use. Our focus will be on you and your desire to give presentations that
get your ideas across, satisfy the information needs of your listeners, and earn you the
respect and recognition you deserve.

Effective Executive’s Guide to PowerPoint 2000 does not try to be an encyclopedic
manual. Instead, it focuses on the process of creating a presentation in seven distinct
steps. We think that this logical seven-step approach works best for typical PowerPoint
users: executives and business professionals. Breaking the process into steps gives you
a book that filters everything we could say about PowerPoint into just what most
executive users should know.
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What This Book Assumes About YWhat This Book Assumes About YWhat This Book Assumes About YWhat This Book Assumes About YWhat This Book Assumes About Yououououou
This book makes two assumptions about you. First, you’re not and don’t want to
become a PowerPoint expert. Rather, we assume that you’re a professional working in
business, a nonprofit organization, or public service. And we assume that you want to
use PowerPoint to enhance the presentations you make.

The book also assumes that you’re familiar working with the Microsoft Windows
operating system. As a result, in the pages that follow you won’t get detailed information
about how to choose menu commands or select dialog box buttons and boxes. If you
don’t already possess this knowledge, you’ll need to acquire it by either using the online
help available in Windows, getting a quick tutorial from someone like a co-worker,
or reading a good introductory book.

How This Book Is OrganizedHow This Book Is OrganizedHow This Book Is OrganizedHow This Book Is OrganizedHow This Book Is Organized
As noted, this book breaks the process of using PowerPoint to create a presentation
into seven steps. Each step gets described in its own chapter. These chapters, or steps,
are described here.

Step 1: Learn the LogicStep 1: Learn the LogicStep 1: Learn the LogicStep 1: Learn the LogicStep 1: Learn the Logic
The place to start any discussion of using PowerPoint 2000 is with information about
what the PowerPoint program does and the terms it uses. In Step 1, we provide this
information.

Step 2: Outline YStep 2: Outline YStep 2: Outline YStep 2: Outline YStep 2: Outline Your Contentour Contentour Contentour Contentour Content
After you understand how PowerPoint works, your next step is to create a textual list,
or outline, of the messages and points you want to share. Typically, you’ll do this
using the PowerPoint program, but you can also work in another program, like
Microsoft Word, and then export your outline to PowerPoint.

Step 3: Add ObjectsStep 3: Add ObjectsStep 3: Add ObjectsStep 3: Add ObjectsStep 3: Add Objects
After you outline your content, almost always you’ll want to create objects you can add
to your presentation. Objects are tables, charts, and pictures that augment the textual
information in your outline. You can create a rich variety of useful objects using the
PowerPoint program. You can also create objects using other programs (such as those
that make up Microsoft Office).
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Step 4: Design YStep 4: Design YStep 4: Design YStep 4: Design YStep 4: Design Your Lookour Lookour Lookour Lookour Look
After you’ve outlined your content and created any objects, you move past the
substance of your presentation and address its form, its appearance, and its “look.” One
of the big benefits of using PowerPoint is that it lets you easily create a presentation
that looks professional using built-in tools and features like design templates and color
schemes.

Step 5: Add Special EfStep 5: Add Special EfStep 5: Add Special EfStep 5: Add Special EfStep 5: Add Special Effectsfectsfectsfectsfects
You need to be judicious in adding special effects like slide transitions, animation,
sound, and video. But these garnishments can, with common sense, enhance your
presentation’s impact and value.

Step 6: Prepare YStep 6: Prepare YStep 6: Prepare YStep 6: Prepare YStep 6: Prepare Your Presentationour Presentationour Presentationour Presentationour Presentation
After you’ve created your presentation, you need to prepare for delivering it by creat-
ing speaker’s notes, rehearsing, producing any handouts, and tailoring your
presentation’s slides for the presentation method. Note that PowerPoint provides a rich
set of alternative methods for making presentations, including an onscreen display, the
use of color projectors and 35mm slides, and the World Wide Web.

Step 7: Deliver YStep 7: Deliver YStep 7: Deliver YStep 7: Deliver YStep 7: Deliver Your Presentationour Presentationour Presentationour Presentationour Presentation
The final step is the successful delivery of your presentation. Although this step
represents the culmination of your work, it’s actually the easiest in terms of PowerPoint
mechanics.

NOTENOTENOTENOTENOTE In addition to the seven steps, or chapters, described in the preceding
paragraphs, Effective Executive’s Guide to PowerPoint 2000 includes four
appendixes and a glossary of PowerPoint and presentation terms: Appendix A,
“Using Microsoft Graph,” discusses some fundamentals of good chart design,
strengths and weaknesses of chart types, and avoiding common charting
mistakes. Appendix B, “Creating WordArt Objects,” explains how to use the
WordArt program to turn text into graphical objects. (The Graph and WordArt
programs come with the PowerPoint program.) Appendix C, “Simple Presen-
tation Strategies,” describes strategies you can use to quickly create
presentations that explain, persuade, or recommend. Appendix D, “Custom-
izing PowerPoint,” describes options to customize the set up of your PowerPoint
program.
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Conventions Used in This BookConventions Used in This BookConventions Used in This BookConventions Used in This BookConventions Used in This Book
This book uses three conventions worth mentioning here. First, we view this book as
a conversation among professionals. This statement means that the pronoun we
refers to us, the authors. And it means that the pronoun you refers to you, the reader.
In this case, this conversational style means that you will frequently see the we
pronoun because two of us, Buschmohle and Nelson, wrote the book. Although we
has sometimes been used as a stilted, almost royal, self-reference by writers, please don’t
take it that way. Think of us as workshop presenters or discussion group facilitators,
with jackets off and ties loosened. Think of us, in other words, as colleagues. Think
of this book as a conversation.

Another convention is that we call the main chapters of the book “steps.” The
benefit of doing this is that it lets us focus on and emphasize the process of creating
a presentation. But, unfortunately, there’s a slight problem with this convention. We
also want to provide numbered step-by-step instructions in the chapters, or steps, of
the book. Whenever some task can’t be described in a sentence or two, in fact, we’ll
use numbered steps to make sure that you can follow the discussion. So this
“chapters-that-we-call-steps” convention may confuse matters. If we say, “In the
preceding step, we described how to do such-and-such,” are we referring to the pre-
ceding chapter or to a preceding numbered step? You see the difficulty.

Here’s what we’ve come up with. Whenever we use the term step to refer to a chap-
ter, we’ll just give you the entire chapter name. For example, if we say that in “Step 3:
Add Objects” we describe how to do such-and-such, you’ll know what we mean. If
we don’t give you the chapter name, you’ll know that we’re talking about the preced-
ing numbered step.

A third convention concerns references to the buttons and boxes in PowerPoint
windows and dialog boxes. This book capitalizes the initial letter of the words that label
buttons and boxes, even though they don’t appear that way on-screen. For example,
the check box that is labeled “Loop continuously until Esc” gets referenced in these
pages as the Loop Continuously Until Esc box. The initial caps, then, will be a signal
to you that we’re referring to a label.
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Some CaveatsSome CaveatsSome CaveatsSome CaveatsSome Caveats
As a communication tool, PowerPoint follows an ancient tradition. From the earliest
cave paintings in France to sketches by Leonardo da Vinci to the crayon drawings of
children, people have always sought to present ideas in pictures. With PowerPoint, you
have a true tool that matches or replaces last century’s most popular business commu-
nication media: chalkboards, easel charts, 35mm slides, and overhead transparencies.
These older technologies are still used and valuable; it’s just that now we have so many
more options with computer programs such as PowerPoint.

Nonetheless, before we move into our main discussion about PowerPoint, it ’s
probably useful to issue a caveat or two about using it. Although PowerPoint is rap-
idly becoming the worldwide standard for business and technical presentations,
prudent decisions need to be made about when and whether to use it. Before you rush
to prepare a PowerPoint presentation (or take the time to read any of this book), we
recommend that you answer three basic but important questions:

• Can PowerPoint slides be shown in the room where you’ll be speaking? To use
PowerPoint, obviously, adequate equipment needs to be available: a laptop,
projector, screen, and cables, for example. Furthermore, and assuming that these
prerequisites are met, you want to verify that the room seating and viewing will or
can be arranged to accommodate PowerPoint.

• Is PowerPoint appropriate for the kind of presentation you intend to give? It might
not be necessary if your aim is strictly interactive participation, group sharing, or
discussion. PowerPoint can be used for portions of such meetings when informa-
tion must be presented, of course. But projecting slides might not work if you meet
in a tiny room where PowerPoint will overwhelm listeners. In such cases, you may
want to show slides on a monitor or laptop screen or distribute handouts you’ve
created with PowerPoint.

• What is the attitude toward PowerPoint among members of the audience? Many
business and professional audiences expect and welcome PowerPoint. A few audi-
ences have already overdosed on the program and complain, “Every presentation
looks alike.” Check out beforehand whether listeners would welcome or be turned
off by PowerPoint, and adjust your presentation so that people are willing to listen.
You can help your cause by making sure that your PowerPoint slides look better than
others the audience has seen. Follow the guidelines in this book, and your slides will
stand out.
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Step 1

LEARN THE LOGICLEARN THE LOGICLEARN THE LOGICLEARN THE LOGICLEARN THE LOGIC

Featuring:Featuring:Featuring:Featuring:Featuring:
• What Is PowerPoint?

• How PowerPoint Works

• Key PowerPoint Terms

• Approaches for Creating Presentations

Before you even begin working with PowerPoint, you should understand what
PowerPoint does and how to use it. You’ll also benefit immensely if you understand,
from the beginning, some key PowerPoint terms and the three different approaches
for creating PowerPoint presentations. In this step, we discuss these key topics and
concepts.

What Is PowerPoint?What Is PowerPoint?What Is PowerPoint?What Is PowerPoint?What Is PowerPoint?
You can answer the question “What is PowerPoint?” in two useful ways. You can say
that PowerPoint is a presentation program. That means, in a nutshell, that it simply
helps you create slides, such as the one shown in Figure 1-1.
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Figure 1-1 A PowerPoint title slide.

Figure 1-1 shows what’s called the title slide. But that doesn’t actually matter at this
point. The main thing to recognize is that this slide—which might be a 35mm slide—
is the building block you create with the PowerPoint program.

You can also answer the “What is PowerPoint?” question by saying that PowerPoint
is part of the Microsoft Office suite of programs. This fact has two noteworthy
ramifications:

• If you know how to use one program in the Office suite—such as Microsoft Word
or Microsoft Excel—you already know much of what you need to know about
working with PowerPoint. The things you create in PowerPoint—called documents
or presentations—get created in the same basic way as the pages of a Word docu-
ment and the spreadsheets in an Excel workbook. And the programs in the
Microsoft Office suite resemble each other. In fact, many of the menus, commands,
toolbar buttons and boxes, and dialog boxes are identical or almost identical. For
example, the dialog box you use to name and choose a location for a PowerPoint
presentation you save is identical to the dialog box you use to name and specify a
location for a Word document or Excel spreadsheet you save.

• Almost anything you build using another Microsoft program can be used in a
PowerPoint slide. So, for example, if you create a table or a bulleted list in Word,
that information can easily be used on a PowerPoint slide. And, if you create a chart
or a small spreadsheet in Excel, again, that information can easily be used in a
PowerPoint slide.



Step 1Step 1Step 1Step 1Step 1   Learn the Logic 33333

How PowerPoint WHow PowerPoint WHow PowerPoint WHow PowerPoint WHow PowerPoint Worksorksorksorksorks
PowerPoint provides tools and prefabricated slides you can use to build a presentation
you want to give. The slides in a presentation can look like the one shown in Figure
1-1 and contain only text. But slides in PowerPoint can also easily show other objects,
like tables (see Figure 1-2), charts (see Figure 1-3), organizational charts, drawings
and pictures, and even clipart.

Figure 1-2 A PowerPoint slide that shows a table.

Figure 1-3 A PowerPoint slide that shows a chart.

The other thing to note about PowerPoint is that it not only helps you create the slides
(such as those shown in Figures 1-1, 1-2, and 1-3), but it also provides tools you can
use to present your slides. For example, PowerPoint includes a wizard you can use to
create the raw files you need to send to a film company when you want to create 35mm
slides. PowerPoint includes tools you can employ to create color transparencies and
printed handouts. And PowerPoint includes features that let you easily show the slides
you’ve created onscreen (such as on a laptop) or using a color projector (such as for
larger audience presentations).
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NOTENOTENOTENOTENOTE Wizards are little programs that use dialog boxes to collect information from
you and then use the information to perform some task. If you have ever worked
with Microsoft Excel and created a chart, for example, you have encountered
the Excel Chart Wizard. It asks you questions about the data you want to use
in a chart, and then it creates the chart for you.

Key PowerPoint TKey PowerPoint TKey PowerPoint TKey PowerPoint TKey PowerPoint Termsermsermsermserms
PowerPoint, as mentioned earlier, is not a difficult program to use. What it helps you
do is actually very simple. Nevertheless, you will benefit from the very start by under-
standing several key terms.

SlideSlideSlideSlideSlide
A slide is the basic building block you create using PowerPoint. The elements you see
in Figures 1-1, 1-2, and 1-3 are slides. If you were giving a slide show using, for
example, a 35mm slide projector and you created your slides using PowerPoint, what
you see in these figures would be what you display on a screen or wall.

PresentationPresentationPresentationPresentationPresentation
A presentation consists of the slides you’ve created to show all at the same time. For
example, the slides in Figures 1-1, 1-2, and 1-3 might be a presentation.

A presentation is also, from the PowerPoint perspective, a document file. What is stored
on your hard disk or on a removable disk, like a floppy disk or zip disk, is actually the
presentation file.

If you’ve worked with Microsoft Word or any other word processing program, you can
think of the relationship between a presentation and a slide in the same way you think
of a document and a page. A document, such as a report you create using Word,
consists of individual pages that combine to make the complete document. The indi-
vidual pages of the report are stored in the document. PowerPoint slides combine to
make the complete presentation, which is actually stored in a presentation file.
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TTTTTextextextextext
Text, of course, is simply text. It represents the basic building block and the most
common element you’ll use on your slides. The slide shown in Figure 1-1, for example,
simply uses text to introduce the presentation and the presenter to the audience.
Figure 1-2 showed a table, which is simply a grid of rows and columns, with text in
the cells, or squares, of the table.

Text can also appear in a bulleted list, another common format. Figure 1-4 shows a
simple slide that uses a bulleted list.

Figure 1-4 A PowerPoint slide that shows a bulleted list.

NOTENOTENOTENOTENOTE You enter and edit text in PowerPoint in the same basic way as you enter and
edit text in most other programs. Entering and editing text in PowerPoint, for
example, works the same way it does in Microsoft Word.

PlaceholderPlaceholderPlaceholderPlaceholderPlaceholder
In PowerPoint, you enter text and any other items you use for slides into an area of a
slide called a placeholder. A chunk of text, for example, goes into a text placeholder. A
picture, table, or chart also goes into a placeholder.

Placeholders amount to boxes, or areas, that you use to affix things to a slide. You can
almost think of them as being like glue. Figure 1-5 shows the PowerPoint program
window, which we’ll talk about in just a few paragraphs. Note that the window shows
a slide with a placeholder for entering a chunk of text to title the slide and another
placeholder for entering a bulleted list.
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Figure 1-5 A slide with placeholders.

ObjectObjectObjectObjectObject
In addition to text, as just mentioned, you can place other items on a slide. PowerPoint
calls these items objects. For example, the chart shown in Figure 1-3 is an object—a
chart object, to be precise. But slides can include a wide variety of objects.

Anything you can create or store on your computer can probably be turned into an
object and then placed on a PowerPoint slide. Objects can be chunks of documents
you create using other programs, like Microsoft Word or Microsoft Excel; little
images or pictures stored as files on your hard disk; or even things like charts, such as
organization charts and drawings you create with PowerPoint’s many applets.

NOTENOTENOTENOTENOTE PowerPoint supplies several small programs, called applets. The applets are
essentially miniature programs that are built into the larger PowerPoint program.
PowerPoint includes the Microsoft Graph applet, for example, which lets you
create charts and graphs. The Microsoft Organization Chart applet, also avail-
able from within the PowerPoint program, lets you create organization charts.
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PowerPoint program windowPowerPoint program windowPowerPoint program windowPowerPoint program windowPowerPoint program window
If you’ve worked with any Windows program, the Microsoft PowerPoint program
window won’t surprise you. But just to make sure that you have no questions at the
start, let’s make a few observations about the window. Figure 1-6 shows a PowerPoint
window using the slide from Figure 1-2. There are several things to quickly note about
the PowerPoint program window.

NOTENOTENOTENOTENOTE Sometimes people also call the program window by another term, application

window.

Figure 1-6 The PowerPoint program window with a maximized window.

The program window shows the usual title bar, menu bar, and one or more toolbars.
This information appears at the top of the program window.

In the area beneath the menu bar and toolbars, PowerPoint displays a presentation
window. PowerPoint uses its presentation window to display the presentation you’ve
opened or are creating. This is the same way that a program like Microsoft Word uses
a document window to display the document you are using or creating.
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NOTENOTENOTENOTENOTE A presentation window is the same thing as a document window.

One thing that’s worth mentioning is that you can size the presentation window, or
document window, so that it fills the entire area available to it, as shown in Figure
1-6. When you do this, you don’t actually see the separate presentation window be-
cause it abuts the edge of the program window. You can also resize the presentation
window so that it fits inside the program window, as shown in Figure 1-7.

Figure 1-7 The PowerPoint program window with an unmaximized window.

NOTENOTENOTENOTENOTE To resize windows in PowerPoint or any other Windows program, you click the
Minimize, Restore, and Maximize buttons in the upper right corner of the
program window. These buttons appear next to the Close box.
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PowerPoint viewPowerPoint viewPowerPoint viewPowerPoint viewPowerPoint view
One final term that is useful to understand from the start is view. A view is just a way
of looking at some of the information in a PowerPoint presentation. One way to look
at the information in a PowerPoint presentation is by looking at the slide and
nothing else. This is called Slide Show view. If you were looking at the slide shown in
Figure 1-1 using this view, all you would see is what appears in Figure 1-1. You wouldn’t
see the PowerPoint program window—only the slide.

PowerPoint also supplies other views. Figure 1-8, for example, shows PowerPoint’s
Normal view, which is what you often use to create your presentation. Normal view
shows the presentation’s outline and the slide you are working with inside the
PowerPoint program window. Normal view also provides, at the bottom of the
presentation window, a small area, or pane, that you can use to record speaker’s notes.

Figure 1-8 Normal view.
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Figure 1-9 shows another common view you’ll use. The view shown in Figure 1-9 is
Slide Sorter view. It displays inside the presentation window each of the slides in your
presentation. Slide Sorter view (and we will talk about this subject later in this book,
in “Step 6: Prepare Your Presentation”) lets you rearrange the order of slides and even
easily add or delete slides.

Figure 1-9 Slide Sorter view.

Approaches for Creating PresentationsApproaches for Creating PresentationsApproaches for Creating PresentationsApproaches for Creating PresentationsApproaches for Creating Presentations
You can create PowerPoint presentations in three different ways. “Step 2: Outline Your
Content,” describes this process in more detail, but it is useful to briefly mention and
discuss the three ways here.

Using the AutoContent WizardUsing the AutoContent WizardUsing the AutoContent WizardUsing the AutoContent WizardUsing the AutoContent Wizard
The easiest way for new PowerPoint users to create a PowerPoint presentation is by
using the AutoContent Wizard. In fact, when you start PowerPoint, it displays the
dialog box shown in Figure 1-10.
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Figure 1-10 The PowerPoint dialog box.

This dialog box asks you how you want to go about creating your presentation. The
default answer to this question is by using the AutoContent Wizard. If you accept
PowerPoint’s suggested method, PowerPoint starts the AutoContent Wizard. Figure
1-11 shows the first AutoContent Wizard dialog box.

Figure 1-11 The first dialog box displayed by the AutoContent Wizard.
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To use the AutoContent Wizard, you simply answer PowerPoint’s questions about the
presentation you want to create. The first question you’ll have to answer, for example,
is about the type of presentation you want to give. To identify the type of presenta-
tion you want to give, or create, you click one of the buttons in the AutoContent
Wizard dialog box, as shown in Figure 1-12: General, Corporate, Projects, Sales/
Marketing, or Carnegie Coach. After you’ve selected a category presentation, you then
select one of the specific presentation entries from the List box.

Figure 1-12 The first dialog box displayed by the AutoContent Wizard that asks a
question.

In the other dialog boxes the AutoContent Wizard uses, it asks you for additional
information about the presentation you are creating. For example, the next
AutoContent Wizard dialog box asks how you plan to deliver the presentation, and
the third and final dialog box asks you for the name of your presentation and whether
there is information you want each of your slides to show.

The AutoContent Wizard can be a wonderful way to create a rough-draft outline for
a presentation. And because the AutoContent Wizard suggests good outlines, you
might want to review them even when you want to build your own outlines from
scratch. But presentations produced by the AutoContent Wizard do tend to resemble
each other. And that might be something you want to avoid—especially if you’re
presenting to audiences that will also see PowerPoint presentations from other
(perhaps competitive) speakers on the same subject.
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Using an outlineUsing an outlineUsing an outlineUsing an outlineUsing an outline
A second method or approach for creating a presentation is by building an outline. An
outline simply lists the slides in your presentation by slide title. The outline also
provides any bulleted text for your slides.

Using an outline is the approach we recommend because it focuses your attention on
the content of your presentation and the message you want to deliver. By creating your
own outline from scratch, you also are more likely to create a unique presentation—
one with unique information and one that’s memorable.

Building a presentation with slidesBuilding a presentation with slidesBuilding a presentation with slidesBuilding a presentation with slidesBuilding a presentation with slides
There is a third way to build a presentation: by simply creating individual slides. In
other words, you can tell PowerPoint that you want to add a slide to the open presen-
tation and what you want the slide, roughly speaking, to look like. Then you add text
and other objects to the slide.

This slide-based method is one that people commonly use. But we suspect that it is
also the method  from which most bad PowerPoint presentations originate. A slide-
based construction method too easily produces presentations that don’t make
structural sense and instead resemble patchwork quilts of slides. For this reason, this
book ignores this third presentation-building approach.
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Step 2

OUTLINE YOUR CONTENTOUTLINE YOUR CONTENTOUTLINE YOUR CONTENTOUTLINE YOUR CONTENTOUTLINE YOUR CONTENT

Featuring:Featuring:Featuring:Featuring:Featuring:
• Using the AutoContent Wizard

• Using Outline View to Create Your Outline

• Importing an Outline

• Working on Your Outline

• Saving and Later Opening Your Outline

After you understand the logic and language of PowerPoint, you’re ready to begin
building presentations. The first step you take in this construction process is
outlining your content. In outlining your content, what you really do is create a list of
the slides (and some other information) you want to share.

PowerPoint provides three approaches for creating an outline: You can use the
AutoContent Wizard, you can use PowerPoint’s Outline view, and you can import an
outline from another program—such as an outline you’ve created in Microsoft Word.
All three approaches are discussed in the pages that follow.

Using the AutoContent WizardUsing the AutoContent WizardUsing the AutoContent WizardUsing the AutoContent WizardUsing the AutoContent Wizard
The easiest way for new PowerPoint users to create an outline is by using the
AutoContent Wizard. To use the AutoContent Wizard to create your outline, follow
these steps:

1. Tell PowerPoint that you want to use the AutoContent Wizard.

As you start the PowerPoint program, it displays the dialog box shown in Figure
2-1. This dialog box asks you how you want to create the new presentation. To create



1616161616 Effective Executive’s Guide to PowerPoint 2000 - Electronic Edition

the presentation using the AutoContent Wizard, you click the AutoContent Wizard
button and then the OK button. PowerPoint starts the AutoContent Wizard.

Figure 2-1 The PowerPoint dialog box.

If you want to start the AutoContent Wizard after you’ve already moved past the
first PowerPoint dialog box, choose the File menu’s New command. When
PowerPoint displays the New Presentation dialog box, as shown in Figure 2-2, click
the General tab, click the AutoContent Wizard selection, and then click OK.

Figure 2-2 The New Presentation dialog box.
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2. Begin the AutoContent Wizard.

When you start the AutoContent Wizard, PowerPoint displays an informational
dialog box, as shown in Figure 2-3. This dialog box simply introduces the
AutoContent Wizard. Click the Next button.

Figure 2-3 The first information dialog box the AutoContent Wizard displays.

3. Select the type of presentation you want to create.

When PowerPoint displays the AutoContent Wizard dialog box shown in Figure
2-4, click the button that best describes the general category of presentation you
want to create. This dialog box provides several buttons and category combinations:
General, Corporate, Projects, Sales/Marketing, and Carnegie Coach. When you
click a button, the AutoContent Wizard displays a list of prefabricated presenta-
tions within that category. You select one of these presentations—they’re really just
partially structured presentations—by clicking it. Click the Next button to continue.
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Figure 2-4 The dialog box that the AutoContent Wizard uses to ask you about what
 type of presentation you want to create.

TIPTIPTIPTIPTIP When you are working with the AutoContent Wizard dialog box shown in Fig-
ure 2-4, be sure to explore the presentations in each of the five categories—
or at least do this the first few times you use the AutoContent Wizard. The
AutoContent Wizard supplies a rich set of thoughtful, well-structured presen-
tations, and—especially as you are starting out—you can benefit by using these
presentations as models for your own.

4. Select the presentation style.

When PowerPoint displays the AutoContent Wizard dialog box shown in Figure
2-5, use it to tell the AutoContent Wizard how you’ll deliver your presentation. If
you will deliver your presentation onscreen using your laptop computer, for example,
mark the On-Screen Presentation button. Alternatively, if you are going to publish
your presentation to the Web—this could be either an Internet or intranet web site—
you mark the Web Presentation button. When you finish providing this informa-
tion, click the Next button to continue.
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Figure 2-5 The dialog box that the AutoContent Wizard uses to ask you about how
 you’ll share your presentation.

5. Provide general information about the presentation.

When the AutoContent Wizard displays the dialog box shown in Figure 2-6, use
the Presentation Title box to name your presentation. Optionally, use the Footer
box to provide a footer that will appear at the bottom of each of the slides you
create. If you want the footer to include the date the presentation was last
modified, or updated, and the number of the slide, mark the Date Last Updated
box and the Slide Number box.

NOTENOTENOTENOTENOTE You might use the footer to name the presenting organization. You might also
use the footer to record a copyright notice or a confidential notice.

After you’ve finished filling in the boxes and marking the check boxes provided by
the Presentation Options dialog box, click the Next button. Then click the Finish
button.
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Figure 2-6 The dialog box that the AutoContent Wizard uses to ask you for general
 information it will place on each slide.

After you click Finish, the AutoContent Wizard creates a rough outline of your
presentation and opens the presentation using its Normal view, as shown in Figure
2-7. Normal view includes the outline of the presentation (the outline appears in the
pane along the left edge of the PowerPoint program window). Normal view also shows
the selected slide in the main pane of the PowerPoint program window. You’ll be able
to identify the slide because you’ll see your presentation title on the slide. If you chose
to enter a footer, you’ll also see this information at the bottom of the slide.
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Figure 2-7 Normal view showing an outline created by the AutoContent Wizard.

After you’ve used the AutoContent Wizard to create a rough-cut outline for your
presentation, you next modify the outline so that it matches your presentation require-
ments. To do this, you’ll add slides, add and edit slide text, and probably
remove unneeded slides. For information about how to do this, refer to the “Work-
ing on Your Outline” section, later in this step.

NOTENOTENOTENOTENOTE If you are going to use the AutoContent Wizard as described in the preceding
list of instructions, you don’t need to read the next section, about using Out-
line view to create your outline, or the section “Importing an Outline,” later
in this step. You already created your outline. Nevertheless, you might want to
skim these sections’ information. In the future, you’ll probably move to one of
these other outline methods.
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Using Outline VUsing Outline VUsing Outline VUsing Outline VUsing Outline View to Create Yiew to Create Yiew to Create Yiew to Create Yiew to Create Your Outlineour Outlineour Outlineour Outlineour Outline
If you want to create your own outline from scratch (and avoid the sameness and non-
uniqueness that might stem from using the AutoContent Wizard), you use a differ-
ent approach to create your outline. When PowerPoint displays the dialog box shown
in Figure 2-1 (the dialog box in which PowerPoint asks “How do you want to create
your own presentation?”), you should click the Design Template button or the Blank
Presentation button. By choosing one of these other creation options, you avoid us-
ing the AutoContent Wizard and instead create your own outline from scratch.

Building on a design templateBuilding on a design templateBuilding on a design templateBuilding on a design templateBuilding on a design template
If you choose the Design Template button, PowerPoint displays the New Presenta-
tion dialog box, as shown in Figure 2-8. The Design Templates tab in the New Pre-
sentation dialog box will be the one selected. The list box on the Design Templates
tab lists more than three dozen predesigned presentation templates you can use to build
your presentation. A presentation template is really a design or look that will be used
for the background of your presentation. To see how the presentation design templates
differ, click some of the templates on the list. Figure 2-8, for example, shows the Artsy
design template. If you click other design templates, PowerPoint updates the slide
picture shown in the Preview box. This will show you how different templates vary.

Figure 2-8 The New Presentation dialog box.
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NOTENOTENOTENOTENOTE The list of design templates shown in the New Presentation dialog box includes
templates that aren’t installed. If you select a design template that hasn’t been
installed, PowerPoint might ask you to find the Microsoft Office 2000 CD or
the Microsoft PowerPoint CD. PowerPoint will then use the CD to install the
additional design templates.

Building on a blank presentationBuilding on a blank presentationBuilding on a blank presentationBuilding on a blank presentationBuilding on a blank presentation
The other way to create your new presentation without using the AutoContent Wizard
is simply by clicking the Blank Presentation button. When you click this button,
nothing happens. You simply click the button and then click OK.

Adding the first slideAdding the first slideAdding the first slideAdding the first slideAdding the first slide
If you create an outline based on a design template or blank presentation, PowerPoint
displays the New Slide dialog box when you click the OK button. Figure 2-9 shows
the New Slide dialog box.

Figure 2-9 The New Slide dialog box.

The New Slide dialog box asks you to choose an auto layout for the first slide in the
presentation. What you want to do is select the auto layout from the upper left cor-
ner of the list of auto layout slides that are provided. This is the Presentation Title auto
layout. After you’ve selected this auto layout, click the OK button.
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NOTENOTENOTENOTENOTE Auto layouts are simply blank slides that include placeholders for  text and
other objects. When you select an auto layout, simply pick one that shows the
object placeholder or placeholders you want.

After you select the auto layout for the first slide in your presentation, PowerPoint
displays the presentation in Normal view. Figure 2-10 shows how Normal view looks
when you are creating your outline based on a blank presentation. The only thing that’s
different, if you are creating your outline based on a design template, is that the ex-
ample slide shown in the side pane of the view will include some design elements, such
as color and background graphics.

Figure 2-10 Normal view when you create a presentation based only on a design template.

Filling in the outline detailFilling in the outline detailFilling in the outline detailFilling in the outline detailFilling in the outline detail
After you’ve created the blank presentation file to hold your outline, you are ready to
begin building your outline. As noted earlier in this step and in “Step 1: Learn the
Logic,” an outline is essentially a list of slides you want in your presentation. The outline
also includes bullet points for each slide, if appropriate.
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To create an outline, follow these steps:

1. Name your presentation.

To create the first title slide of your presentation, click the first slide listed in the
Outline pane. This slide shows only a number 1 and a small slide icon. After you
select the slide, type the title of your presentation. Figure 2-11 shows the way Normal
view looks after you complete this step.

Figure 2-11 Normal view after you add the title slide information to the outline.

NOTENOTENOTENOTENOTE PowerPoint uses the title of your first slide to fill the title placeholder on the
slide shown in the Slide pane in Normal view.

2. Describe the next slide.

To describe the next slide in your presentation, press the Enter key or the Return
key. PowerPoint adds a new, blank slide to the outline. To give this slide a title, select
the slide by clicking; then type the slide title.

You need to describe each of the other slides you want in your presentation. To do
this, you can just repeat the process described in the preceding paragraph.



2626262626 Effective Executive’s Guide to PowerPoint 2000 - Electronic Edition

You don’t have to add slides to the outline by entering slide titles into the Outline
pane. You can also insert a slide by choosing the Insert menu’s New Slide command.
When you choose this command, PowerPoint displays the New Slide dialog box,
as shown in Figure 2-12. You can use this command and dialog box to add slides
to the outline when you know what object placeholders you want on the slide. You
don’t need to do this, but you can.

Figure 2-12 The New Slide dialog box.

3. Add bulleted lists to slides, as appropriate.

Presumably, many of your slides, all though perhaps not all, will show bulleted text.
This bulleted text should also be added to your outline. To add bulleted text to a
slide, select the slide by clicking its icon. Then press the End key to move the selec-
tion cursor to the end of the slide title. Next, press the Enter key. PowerPoint adds
a new line to the outline for the new slide that it assumes you want to add. How-
ever, you don’t want to add a new slide. You want to add bulleted text to the slide
listed on the preceding line of the outline. So press the Tab key. PowerPoint indents
the line selected in the outline. Now type the first line of bulleted text. After you’ve
typed the first line, press Enter. PowerPoint inserts a line—only this time it knows
that the line is another line of bulleted text. Type this next line of bulleted text. If
you need to add additional lines of bulleted text, press Enter again and type again.

To add bulleted text to other slides in your presentation, you follow the same pro-
cess described in the preceding paragraph. First, you select the slide, and then you
create bulleted text by adding lines to the outline—only at a lower, indented level.

Figure 2-13 shows the way this bulleted text looks in the Outline pane. As you would
expect, PowerPoint also adds the bulleted text to the slide shown in the Slide pane.
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Figure 2-13 Normal view after you add the bulleted text information to the outline.

TIPTIPTIPTIPTIP Keep an eye on the slide shown in the Slide pane. You don’t have that much
space for text on your slides. Practically speaking, you often don’t have room
for more than a short, punchy title and three or four short bulleted text chunks.

NOTENOTENOTENOTENOTE Later in this step, the section “Working on Your Outline” explains the mechanics
of entering text into the outline and then editing the text. Therefore, don’t worry
too much at this point about doing more than just listing your slides and col-
lecting your most important bulleted text. How you enter and edit text in Outline
view is described in detail later.
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TIPTIPTIPTIPTIP Because people do not read well off walls or screens, keep the number of words
in your outline and, therefore, on your slides to an absolute minimum. If
everything you are going to say is already on your slides, one of you is unnec-
essary. Visuals are meant to aid us, not replace us. Therefore, limit the word-
ing on slides to single words or brief phrases and elaborate verbally on what
you’ve written. Complete sentences should be reserved for direct quotations
of what someone said or for quoting a law, policy, or legal document. Have the
courage to be brief, to omit, and simplify. “Intelligence begins,” wrote Marshall
McLuhan, “with the ability to condense.”

Importing an OutlineImporting an OutlineImporting an OutlineImporting an OutlineImporting an Outline
In many cases, PowerPoint can use an outline you’ve created in another program—such
as an outline you’ve created using your word processing program. If PowerPoint can
interpret your outline—because you’ve used tabs to indicate outline levels or Microsoft
Word styles—simply by opening the outline file for PowerPoint, PowerPoint will use
the outline as the basis for creating an outline.

NOTENOTENOTENOTENOTE When you import an outline, you are in effect starting with a blank presenta-
tion and then copying the outline text from the document that contains the
outline. Although this method might seem to be a good way to create an
outline, especially when you know another program well, it is probably not the
best way to work. It’s to your advantage to work within PowerPoint to create
your presentation outlines because PowerPoint lets you see immediately how
much slide text you are adding by using the Slide pane.

To import an outline, follow these steps:

1. Tell PowerPoint that you want to open the outline document.

To tell PowerPoint that you want to open another document, choose the File menu’s
Open command. PowerPoint displays the Open dialog box, as shown in Figure
2-14. To tell PowerPoint that you want to look at other types of files (which will
include those created by your outlining program), open the Files Of Type list box
and select the All Files entry.
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Figure 2-14 The Open dialog box.

2. Locate the folder with the outline document.

After you’ve done this step, locate the folder that stores the outline document. You
can do this by first opening the Look In drop-down list box and then selecting the
disk and folder location. If your outline document is stored in a subfolder, you might
need to select the subfolder from the list box that appears in the area beneath the
Look In drop-down list box.

NOTENOTENOTENOTENOTE You can also use the Up One Level button, which appears on the toolbar next
to the Look In drop-down list box. The Up One Level button moves you up to
the next-higher folder. Or, if you are already at the highest-level folder on a disk,
the Up One Level button moves you up to the disk.

3. Open the outline document.

After you’ve located the outline document, select it by clicking it and then click the
Open button. PowerPoint will import the outline document into PowerPoint and
then use its information to build a PowerPoint outline.

NOTENOTENOTENOTENOTE In order for PowerPoint to import an outline document, it uses a converter tool.
If PowerPoint doesn’t have the right converter tool already installed and avail-
able for use, you might need to install the converter tool first. To do this, all
you need to do is find the Microsoft Office 2000 or Microsoft PowerPoint 2000
CD and insert it into your CD drive. PowerPoint will install the needed converter
tool automatically, simply as part of the outline import process.
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After you’ve imported the outline document, you can work with it in the exact same
way as you work with an outline you’ve created using the AutoContent Wizard or
an outline you’ve created by typing text into the Outline pane. Typically, however,
you’ll have more work to do with your outline. The next section, “Working on Your
Outline,” describes how you work with the outline text.

WWWWWorking on Yorking on Yorking on Yorking on Yorking on Your Outlineour Outlineour Outlineour Outlineour Outline
If you used another Windows program, and especially if you have used and become
comfortable with another Microsoft Office program, like Microsoft Word, you’ll have
little trouble working with outline text. In fact, you might want to simply skip this
discussion and move ahead to “Step 3: Add Objects.” However, if you are not all that
comfortable working with the Windows programs or other Microsoft Office programs,
you might want to quickly review the following paragraphs. They describe how text
editing and outline manipulation works in PowerPoint.

Entering and editing textEntering and editing textEntering and editing textEntering and editing textEntering and editing text
You enter and edit text in the Outline pane in the same way as you enter text in other
programs. To begin entering text, you first click at the point where you want to enter
the text. Windows moves the insertion point to the exact location where you type.
Anything you then type gets entered at the insertion point.

By default, PowerPoint inserts text as you type. You can, however, override text. To do
this, press the Insert key. The Insert key is a toggle switch. By pressing Insert, you toggle
between text-insertion mode and text-override mode.

If you want to edit text, you generally select the text you want to edit by clicking and
dragging. Then you replace the selected text by typing the correct text.

You have a variety of ways to select text. You can click at the first character you want
to select and then drag the mouse to the last character you want to select. If you want
to select an individual word, you can double-click the word. If you want to select an
entire line, you can click the area in front of the line, just in front of the bullet or the
slide icon. But note that if you select a slide title line of text, you’ll also select the bulleted
text.

To delete text, select the text and then choose the Edit menu’s Clear command. Or,
select the text and then press the Delete key.
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Moving and copying textMoving and copying textMoving and copying textMoving and copying textMoving and copying text
You can move text by dragging, or you can move text by cutting and copying. To move
text by dragging, first select the text and then point to the text. While you are hold-
ing down the mouse button, drag the selected text to its new location.

If you want to copy the text rather than move it, simply hold down the Ctrl key while
you drag the text to its new (duplicate) location.

Moving and copying text by dragging takes some getting used to at first—especially
if you are sitting in an airplane and doing it on a laptop computer. But it is actually a
pretty handy method after you have become comfortable with it.

If you want to copy and move text with menu commands instead, you can use the Edit
menu’s Copy, Cut, and Paste commands. To move text by using the moving commands,
first select text and then choose the Edit menu’s Copy command (if you want to copy
the text) or Cut command (if you want to move the text). Then position the insertion
point at the exact location where you want to move or copy the text and choose the
Edit menu’s Paste command.

The standard toolbar that PowerPoint supplies provides Copy, Cut, and Paste buttons.
You can use these buttons in place of the Edit menu’s Copy, Cut, and Paste commands.

NOTENOTENOTENOTENOTE If you are not sure which toolbar buttons are which, point to the buttons along
the standard toolbar. Any Microsoft Office application displays a pop-up ToolTip
box that names the button you are pointing to.

One confusing feature of Office 2000 programs is that menu commands and toolbar
buttons don’t always appear. Office 2000 programs customize the toolbar and the menu
based on commands you are likely to use or have used in the past. Note, however, that
if you keep a menu open, Office programs like PowerPoint typically add all the hid-
den commands.

 NOTE NOTE NOTE NOTE NOTE If you don’t want PowerPoint to hide infrequently used menus, choose the Tools
menu’s Customize command. When PowerPoint displays the Customize dia-
log box, click the Options tab. Then unmark the Standard and Formatting
toolbars and the Share One Row box, and unmark the menu’s Show Recently
Used Commands First box.
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Using the Outlining toolbarUsing the Outlining toolbarUsing the Outlining toolbarUsing the Outlining toolbarUsing the Outlining toolbar
If you are going to do much work with a PowerPoint outline, use the Outlining toolbar.
It provides several useful buttons you can click to make outlining easier. To display the
Outlining toolbar, choose the View menu’s Toolbar command. PowerPoint displays
the Toolbar submenu. To tell PowerPoint that you want to use the Outlining toolbar,
choose the Outlining command from the Toolbar submenu. When you do, PowerPoint
places a check mark in front of the Outlining command.

Figure 2-15 shows how the PowerPoint program window looks after the Outlining
toolbar is added. The Outlining toolbar appears along the left edge of the Outline pane.

Figure 2-15 The PowerPoint program window with the Outlining toolbar.
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NOTENOTENOTENOTENOTE If you point to an Outlining toolbar button, PowerPoint displays the button
name in a pop-up toolkit box. Use this trick if you are not sure which button is
which.

Promoting and demoting outline levelsPromoting and demoting outline levelsPromoting and demoting outline levelsPromoting and demoting outline levelsPromoting and demoting outline levels
The Outlining toolbar provides Promote and Demote buttons—the first two buttons
on the Outlining toolbar—for promoting or demoting outline text. To promote out-
line text, simply select the text you want to promote and click the Promote button. (The
Promote button is the arrow that points to the left.) If you promote bulleted text, it
moves up to the next-higher level—probably to the level of a slide.

To demote text, predictably, select the text you want to demote and click the Demote
button. (The Demote button shows an arrow pointing to the right.) If you demote a
slide title, the slide title becomes bulleted text on the preceding slide.

PowerPoint allows you to have bulleted text within a bulleted text list. In other words,
you can have bulleted text under a bulleted text item. However, although this situa-
tion is technically feasible, practically speaking, slides rarely provide enough informa-
tion for this level of detail. Typically, the sort of information you might want to place
as bulleted text under another bulleted text line should really be spoken information
that you provide as you are discussing or talking about the slide.

Moving outline textMoving outline textMoving outline textMoving outline textMoving outline text
The Move Up and Move Down Outlining toolbar buttons let you move text up and
down. To move a line of text up, first select the text and then click the Move Up but-
ton. The Move Up button is an arrow pointing upward.

If you want to move text down, first select the text and then click the Move Down
button. The Move Down button shows an arrow pointing downward.

If you move bulleted text up or down, you simply rearrange the bullet points. How-
ever, if you move slides up and down, you rearrange the order of the slides in the
presentation.



3434343434 Effective Executive’s Guide to PowerPoint 2000 - Electronic Edition

Collapsing and expanding the outlineCollapsing and expanding the outlineCollapsing and expanding the outlineCollapsing and expanding the outlineCollapsing and expanding the outline
The Outlining toolbar provides Collapse and Expand buttons you can use to show
more outlining detail and to hide outlining detail. To hide the lower levels of an out-
line—those levels below the slide title level—select the portion of the outline you want
to hide. Then click the Collapse button. The Collapse button shows a minus sign.

If you later want to expand the previously collapsed portion of the outline, select the
previously collapsed lines of the outline. Then click the Expand button. The Expand
button shows a plus symbol.

Beneath the Collapse and Expand buttons on the Outlining toolbar, PowerPoint pro-
vides Collapse All and Expand All buttons. If you click the Collapse All button,
PowerPoint collapses the entire outline so that only the slide titles show. If you col-
lapse the entire outline using the Collapse All toolbar button, you can click the Ex-
pand All button to later uncollapse the outline.

Summarizing an outlineSummarizing an outlineSummarizing an outlineSummarizing an outlineSummarizing an outline
The second-to-last Outlining toolbar button is the Summary Slide button. If you click
the Summary Slide button, PowerPoint adds a summary slide to your outline. If you
are going to use this toolbar button, first position the insertion point at the end of your
outline, and then click the Summary Slide button. You want the summary slide added
to the end of your presentation, and PowerPoint inserts the summary slide, predict-
ably, at the insertion point location.

Showing formattingShowing formattingShowing formattingShowing formattingShowing formatting
The last button on the Outlining toolbar is the Show Formatting tool. If you click the
Show Formatting toolbar button, PowerPoint shows the text using the text format-
ting that PowerPoint is using on the slides. The Show Formatting toolbar button is a
toggle switch, so if you click it again, PowerPoint doesn’t show the text formatting that
will be used on your slides.
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Spell-checking your outlineSpell-checking your outlineSpell-checking your outlineSpell-checking your outlineSpell-checking your outline
After you finalize your outline, check the spelling. Remember that your outline text
appears on your slides, and there is no easier time to check your spelling than when
you complete the outline.

To check your spelling, use the Tools menu’s Spelling command. If PowerPoint dis-
covers no misspellings, it displays a dialog box telling you simply that the spelling check
is complete (see Figure 2-16). That is what you want to see.

Figure 2-16 The Spelling Check is Complete message box.

If PowerPoint finds one or more spelling errors, it displays the Spelling dialog box,
as shown in Figure 2-17. PowerPoint will use the Not In Dictionary text box to identify
the word that appears to be misspelled. PowerPoint selects this word in the outline.
To fix the spelling, you can type the correct spelling in the Change To box. Or, you
can select one of the words listed in the Suggestions list box. PowerPoint fills the
Change To box initially with its best guess about the correct spelling.

Figure 2-17 The Spelling dialog box.

After you or PowerPoint have entered the correct spelling in the Change To box, click
the Change button to correct the misspelling. Or, if you want to change the spelling
everywhere it appears in the outline, click the Change All button.

If the word is not really a misspelling, you can click the Ignore button to ignore the
single occurrence that was found or the Ignore All button to ignore every occurrence
in the outline.
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If you are using words that are correctly spelled but are not in the spelling dictionary—
this might be the case if you are clicking the Ignore or the Ignore All buttons—you
can click the Add button. When you click the Add button, PowerPoint adds the word
shown in the Not In Dictionary box to its custom spelling dictionary. You typically
add things like people’s names and specialized business or industry terms to the cus-
tom spelling dictionary.

If the Spelling command identifies a misspelling but doesn’t identify the correct spelling
using its Suggestions box, you can try to get additional suggestions. To do this, enter
another guess at the spelling into the Change To box, and then click the Suggest button.
PowerPoint will use the word you entered into the Change To box to look for other
suggested spellings.

Saving and Later Opening YSaving and Later Opening YSaving and Later Opening YSaving and Later Opening YSaving and Later Opening Your Outlineour Outlineour Outlineour Outlineour Outline
After you create your outline, make editorial changes, and then check its accuracy and
spelling, you will of course want to save the outline and the presentation it’s part of.
To do this, simply choose the File menu’s Save command. PowerPoint displays the Save
As dialog box, as shown in Figure 2-18.

Figure 2-18 The Save As dialog box.

To save your presentation, click the Save In drop-down list box to choose a folder
location for the presentation. Then use the File Name box to give your presentation
a name. After you’ve identified the appropriate folder location and named the presen-
tation, click the Save button. PowerPoint saves your presentation in the specified lo-
cation using the name you have provided.
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To later open your outline, you choose the File menu’s Open command. When
PowerPoint displays the Open dialog box, use its Look In drop-down list box to identify
the folder location of the presentation. Then double-click the presentation on the list
beneath the Look In drop-down list box. Figure 2-19 shows the Open dialog box.

Figure 2-19 The Open dialog box.
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Step 3

ADD OBJECTSADD OBJECTSADD OBJECTSADD OBJECTSADD OBJECTS

Featuring:Featuring:Featuring:Featuring:Featuring:
• Using Tables

• Using Pictures

• Using Charts

• Using Organization Charts

• Using Other Objects on Slides

After you outline your content, as described in “Step 2: Outline Your Content,” you
typically add objects to your slides. Objects are simply tables, pictures, charts, and other
graphical elements you’ll use to communicate or help communicate your message.

Using TUsing TUsing TUsing TUsing Tablesablesablesablesables
A table is a grid of columns and rows. The cells that make up the table—a cell is the
intersection of a column and row—can contain text, number values, or even pictures.
Tables are powerful tools for organizing information, and, in fact, people and businesses
commonly use tables to display information—especially quantitative information, like
financial data.

Adding a tableAdding a tableAdding a tableAdding a tableAdding a table
To add a table to a slide, follow these steps:

1. Select the slide.

Assuming that you’ve displayed the presentation using Normal view, you can
select the slide in several different ways. One way is to click the slide in the
Outline pane. If you do this, PowerPoint displays the slide in the Slide pane.
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PowerPoint also selects the slide title in the Outline pane. You can also select a slide
by clicking the scroll bar along the right edge of the Slide pane. As you do this,
PowerPoint pages through the slides of your presentation. Click above the scroll
marker to page up. Click below the scroll bar marker to page down.

NOTENOTENOTENOTENOTE You can also drag the scroll bar marker to move back and forth through the
slides of your presentation and click the arrow buttons at either end of the scroll
bar to move forward and backward a slide at a time.

2. Tell PowerPoint that you want to insert a table.

After you select a slide to which you want to add a table, choose the Insert menu’s
Table command. PowerPoint displays the Insert Table dialog box, as shown in Figure
3-1.

Figure 3-1 The Insert Table dialog box.

3. Describe the table size.

Table size is determined by two simple quantities: the number of columns in the
table and the number of rows in the table. Use the Number Of Columns box to tell
PowerPoint how many columns the new table needs. Use the Number Of Rows box
to tell PowerPoint how many rows the new table needs. After you specify these
dimensions, click OK. PowerPoint then adds the table to the open slide (see
Figure 3-2).
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Figure 3-2 The empty table.

4. Fill the table with information.

After PowerPoint adds the table to the slide, you can fill the slide table with infor-
mation. To do this, click a table cell. Then enter into the cell the information you
want. To fill another cell with information, click it and then enter information there.
Figure 3-3 shows a filled table.
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Figure 3-3 The filled table.

NOTENOTENOTENOTENOTE You can also use the Edit menu’s Cut, Copy, and Paste commands, as well as
the toolbar’s Cut, Copy, and Paste buttons to move text and even pictures or
clipart into the cells of a table you just inserted. To use the Cut, Copy, and Paste
commands, first select whatever it is you want to cut or copy and choose the
Cut or Copy command. Next, click the cell into which you want to paste the
text or item you’ve just cut or copied. Finally, choose the Edit menu’s Paste
command or click the Paste toolbar button.

Positioning and sizing a tablePositioning and sizing a tablePositioning and sizing a tablePositioning and sizing a tablePositioning and sizing a table
After the table holds its information, you can to resize it and then reposition it so that
it looks right and looks like it is in place.

To resize the table, take the following steps:
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1. Select the table.

To verify that the table is selected, click it. When PowerPoint selects the table, it
adds a thick border to the outside edge of the table. Figure 3-4 shows this type of
table selected.

Figure 3-4 A table with selection handles.

2. Resize the table.

After you’ve selected a table, you can resize it by dragging the selection handles that
appear at the corners of the table and at the midpoints of each of the sides of the
table. If you have questions, experiment with a table in a sample PowerPoint slide
to see how this process works. Essentially, all you do is drag a selection handle up
or down, back and forth, or in and out. As you drag a selection handle, PowerPoint
resizes the table for your dragging.

3. Resize the table’s columns and rows.

After you’ve sized the table so that the overall height and width dimensions
are correct, resize the columns and rows of the table’s interior by clicking and
dragging the interior row and column borders. When you point to an interior col-
umn border or row border, PowerPoint changes the mouse pointer icon. After
PowerPoint changes the icon to a double-headed arrow, click the mouse button and
drag the interior column border or row border the way you want to resize it.

To move a table, follow these steps:

1. Select the table.

To verify that the table is selected, click it. PowerPoint selects the table, adding a
thick border to the outside edge of the table, as shown in Figure 3-4.

2. Move the table.

To move the table, point to the outside border of the table—the border that shows
the thick selection border—and then drag the table to the correct location. After
the table is in the correct position, simply release the mouse button.
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TIPTIPTIPTIPTIP When you add an object like a table, clipart, photo, or image to a slide, you
might wonder, “Where should I put it?” Because we read from top to bottom
and from left to right, place the image either at the top or to the left (or top

left). An old advertising design formula commonly places the picture at the top,
the headline underneath the picture, and the text (or copy) below the picture.
Experiment. But you’ll never go wrong beginning with the picture in the top
left position and the text in the bottom right position and moving things around
until the design seems right.

Formatting a tableFormatting a tableFormatting a tableFormatting a tableFormatting a table
When you insert a table into a slide, PowerPoint adds or opens the Tables And
Borders toolbar, as shown in Figure 3-5. You can use this toolbar’s buttons and boxes
to change the format of the table. In fact, the steps that follow simply describe this
toolbar’s tools from left to right.

NOTENOTENOTENOTENOTE You can point to any tool to display the tool’s name in a pop-up Tool Tip box.

Figure 3-5 The Tables And Borders toolbar.

To format a table using the Table And Borders toolbar, take the following steps:

1. Add any rows or columns that are needed.

To add a column or row to an existing table, click the Draw Table tool, which shows
a pencil drawing a line on the face of the Tool button. Then draw a line where the
new border should be created.

If you draw a line that cuts off text in a table cell, PowerPoint might split your text,
putting one part of the text in one cell and the other, cut-off part of the text in
another cell.

2. Erase any cell borders that aren’t needed.

To erase a line in a table that separates two cells, click the Eraser toolbar button.
PowerPoint changes the mouse pointer to an eraser icon. Use the eraser icon to erase
the table border you don’t want in the table.
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3. Specify how the table borders should look.

The Tables And Borders toolbar provides three tools for controlling the way the
table borders look: the Border Style list box, the Border Width list box, and the
Border Color button.

To change the way the table borders look, open the Border Style list box and choose
the border style you want.

To change the weight or width of the table borders, open the Border Width list box
and choose a border width specification.

To change the color of the table borders, click the Border Color button. When
PowerPoint displays a pop-up box of colored squares, click the square that is the
color you want for the table’s borders.

After you’ve used these three toolbar tools to specify the style, thickness, and color
of your table’s borders, you click the Draw Table button. Then you use the Draw
Table tool to trace over the border you want to format according to the current
Border Style, Border Width, and Border Color specifications.

4. Specify how the outside border should look.

The Tables And Borders toolbar provides an outside-border tool you can use to select
where you want borders drawn. To use this tool, click the down-arrow button that
appears to the right of the toolbar button. When PowerPoint displays a box show-
ing pictures of the various table borders in a table, click the picture that most closely
shows the table borders you want to change to match the current Border Style,
Border Width, and Border Color settings.

5. Change the table’s fill color.

To change the color used to fill in the interior of a table, you use the Fill Color tool.
If you just want to accept PowerPoint’s suggested fill color, you can click the Fill
Color button. If you want to choose a fill color, you need to click the small button
just to the right of the Fill Color tool. When you click this button, PowerPoint
displays the box that shows colored squares. The colored squares identify the color
you want to use for the cells in the table.

6. Specify how text should be aligned in the table.

The text you enter into table cells can be aligned in various ways. To align table text,
first select the text or the row or column with the text. You can do this step by click-
ing and dragging the mouse. After you select the text, you specify what alignment
should be used. If you want to align text against the top edge of the table cells, click
the Align Top button. If you want to align text in the center of the cell, click the
Center Vertically toolbar button. If you want the text to align or abut against the
bottom of a cell, click the Align Bottom button.
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Using PicturesUsing PicturesUsing PicturesUsing PicturesUsing Pictures
You can add pictures to slides. These pictures can come from either the ClipArt
Gallery that comes with PowerPoint or the images you’ve collected and stored on your
computer or network.

Adding clipartAdding clipartAdding clipartAdding clipartAdding clipart
Microsoft Office and PowerPoint come with a rich library of clipart. This library
includes photographs, line drawings, and even video.

To add a clipart object to your slide, take these steps:

1. Tell PowerPoint you want to add clipart.

Choose the Insert menu’s Picture command and then the ClipArt command from
the Picture submenu. When you choose this ClipArt command, PowerPoint
displays the Insert ClipArt window, as shown in Figure 3-6.

Figure 3-6 The Insert ClipArt window showing clip categories.

2. Find the clipart category.

Click the clipart category icon that appears to match a piece of clipart you’re
looking for. If you are looking for a business image, for example, you might click
the Business category. PowerPoint displays the clipart images within the selected
category using the Insert ClipArt window. Figure 3-7, for example, shows a por-
tion of the business clipart images that PowerPoint supplies.
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Figure 3-7 The Insert ClipArt window showing business clips.

3. Select the image.

You can scroll through the images displayed in the Insert ClipArt window to find
the one you want to use.

To add the image you select to your slide, right-click the image to display the Short-
cuts menu, as shown in Figure 3-8, and then choose the Insert command from the
Shortcuts menu. PowerPoint adds the clipart image to your slide.

Figure 3-8 The Insert ClipArt window’s Shortcuts menu.

If you’re not going to add another image, close the Insert ClipArt window by clicking
its Close button.

If you want to add another image, repeat steps 2 and 3.
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4. Move the image to its correct location.

You can move a clipart image by dragging it. You can resize a clipart image by first
selecting it and then dragging the selection handles. Moving and resizing a clipart
image isn’t difficult. If you have questions, simply experiment by pointing,
clicking, and dragging the mouse pointer.

Adding picturesAdding picturesAdding picturesAdding picturesAdding pictures
You can add pictures, such as photographic images, to a PowerPoint slide. The only
prerequisite is that the picture file must be stored somewhere on your hard disk.

To insert a picture onto a slide, take these steps:

1. Tell PowerPoint that you want to add a picture.

Choose the Insert menu’s Picture command. Then, when PowerPoint displays the
Picture submenu, choose its From File command. PowerPoint displays the Insert
Picture dialog box, as shown in Figure 3-9.

Figure 3-9 The Insert Picture dialog box.

2. Identify the location of the picture.

Use the Look In box to identify the folder location of the picture.

3. Insert the picture.

After you identify the correct folder location, you’ll see the image listed in the list
box beneath the Look In box. You can insert the image by clicking its filename and
then clicking the Insert button. Or you can double-click the filename.
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4. Move the image to its correct location.

As is the case with clipart images, you can move the inserted picture by dragging
it. You can also resize the inserted picture by first clicking it and then dragging the
selection handles that PowerPoint adds to the corners and sides of the image.

Changing clipart images and picturesChanging clipart images and picturesChanging clipart images and picturesChanging clipart images and picturesChanging clipart images and pictures
After you insert a clipart image or picture onto a slide, PowerPoint adds the Picture
toolbar to the PowerPoint program window (see Figure 3-10).

Figure 3-10 The Picture toolbar.

The Picture toolbar provides tools you can use to change the selected clipart image
or picture, as described in this list:

• The Insert Picture From File button lets you insert a second picture. This button
is equivalent to the From File command on the Picture submenu.

• The Image Control Picture toolbar button displays a list of image-editing options
from which you can choose. Just experiment to see what effect they have.

• The More Contrast and Less Contrast toolbar buttons increase the contrast of a
picture.

• The More Brightness and Less Brightness buttons darken or lighten a picture
image.

• The Crop button might let you crop a portion of an image.

• The Line Style button displays a menu of lines you can use for an image border.

• The Recolor Picture button might let you recolor an image—although this won’t
be possible with all images.

• The Format Picture button displays a dialog box you can use to change elements
of the picture, such as its brightness, contrast, and other characteristics.

• The Set Transparent Color tool lets you tell PowerPoint to remove whatever color
you want from the image you click. To use the Set Transparent Color tool, click the
tool and then click the color you want to make transparent.

• The Reset Picture tool resets the picture to its original condition.
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Using ChartsUsing ChartsUsing ChartsUsing ChartsUsing Charts
PowerPoint comes with a charting tool named Microsoft Graph. Graph lets you
produce charts that you can then use on your PowerPoint slides.

NOTENOTENOTENOTENOTE Appendix A describes how to use Microsoft     Graph.

Understanding how Graph sees dataUnderstanding how Graph sees dataUnderstanding how Graph sees dataUnderstanding how Graph sees dataUnderstanding how Graph sees data
To use Graph, you should first understand three terms: data values, data series, and
data categories.

Data values are the simplest components to understand. In Figure 3-11, for example,
data values are the numbers, or numeric values, that Microsoft Graph will use to
create bars, columns, or lines that visually represent the data.

NOTENOTENOTENOTENOTE The datasheet shown in Figure 3-11 is what you’ll actually use to collect the
to-be-plotted data.

Figure 3-11 A datasheet with some sample data values.
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Data series is the second graphing term you need to understand. Data series, in a nut-
shell, identify the information you’re plotting on a chart. In Figure 3-11, the data
series are Revenues (shown in row 1), Expenses (shown in row 2), and Profits (shown
in row 3).

NOTENOTENOTENOTENOTE If you ask the question “What does my chart show?”, every one-word answer
typically identifies a data series. In the case of the datasheet shown in Figure
3-11, for example, if you asked this question, you would answer correctly by
saying that revenues, expenses, and profits are the three data series.

Data categories is the third term you need to understand. Data categories are often a
little difficult to understand or to interpret correctly the first time you encounter them.
Simply stated, however, data categories organize the data values in the data series. The
datasheet shown in Figure 3-11, for example, uses the years 2001, 2002, and 2003 to
organize the revenue, expenses, and profits data values. Years are this data’s data
categories.

Charts don’t have to use time periods, such as years, however, to organize the data values
in each of the data series. Take a look at the datasheet shown in Figure 3-12. It uses
the same data series and, in fact, the same data values, but uses different data category
names. In Figure 3-12, the data category names are fictitious company divisions: West,
East, and Int’l.
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Figure 3-12 A datasheet with some sample data values and non-time data categories.

NOTENOTENOTENOTENOTE In any chart that shows how data values change over time, the data category
is time, which means that the data category names will be time period identi-
fiers. You might use year numbers such as 2000, 2001, and 2002, for example.
You might also use textual labels, such as year 1, year 2, and year 3. You might
chart data over smaller time intervals, such as by day, by week, or by month.
A chart, or graph, that uses time as the data category, by the way, is called a
time-series chart, or graph.

Adding a chartAdding a chartAdding a chartAdding a chartAdding a chart
To add a chart to a slide, follow these steps:

1. Select the slide to which you want to add the chart.

If you’re using Normal view to work with your presentation, you can select the slide
to which you want to add the chart by clicking the slide title in the Outline pane.
You can also scroll through the individual slides shown in the Slide pane by
dragging the Slide pane’s scroll bar marker. Or you can click the scroll bar buttons.
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2. Tell PowerPoint that you want to add a chart.

Choose the Insert menu’s Chart command to tell PowerPoint that you want to add
a chart to the displayed slide. When you do this step, PowerPoint displays the Data
Sheet window and adds a placeholder to the center of the displayed slide. Figure
3-13 shows the way this element looks before you begin making changes.

Figure 3-13 The datasheet window as it first appears.

3. Provide the data you want to plot in a chart.

You use the datasheet to describe the data you want to plot in a chart. The datasheet,
which looks like a small spreadsheet or table, lets you collect the actual data values
you will plot, data series names, and data category names.

Use the first column for the data series names. Use the first unnumbered row of the
datasheet for the data category names. Use each numbered row for a data series.

After you enter the data values, data series names, and data category names infor-
mation into the datasheet, you can close the datasheet. Microsoft Graph uses the
datasheet information to redraw the graph shown in the placeholder. Figure 3-14
shows how the chart looks on a slide before you begin making changes.
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Figure 3-14 A chart object on a slide.

4. Specify the chart type.

Microsoft Graph initially plots your data in a three-dimensional bar chart, but
Graph supplies more than a dozen types of charts. To choose or review the avail-
able chart types, first verify that the chart object is selected. (If it isn’t, click it to
select it.) Then choose the Chart menu’s Chart Type command. PowerPoint dis-
plays the Chart Type dialog box, as shown in Figure 3-15. You use this dialog box
to choose the type of chart you want. To make this specification, you first select a
chart type from the Chart Type list box. Then you choose a chart subtype by clicking
one of the chart subtype pictures to the right of the Chart Type list box. After you’ve
selected a chart type and chart subtype, click the OK button to make your change.
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Figure 3-15 The Chart Type dialog box.

NOTENOTENOTENOTENOTE Appendix A, “Using Microsoft Graph,” provides additional information on
choosing an appropriate chart type given the data you are working with and
the message you want to convey. If you’re new to charting, you might want
to read that appendix for some useful ideas.

Customizing a chartCustomizing a chartCustomizing a chartCustomizing a chartCustomizing a chart
After you choose the chart type, you can customize the chart so that it best meets your
presentation requirements. To do this, click the chart object to select it. Choose the
Chart menu’s Chart Options command. Microsoft Graph displays the Chart Options
dialog box, as shown in Figure 3-16. The Chart Options dialog box lets you
customize the chart in almost any way imaginable. The following paragraphs quickly
describe the customizations you have available.
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Figure 3-16 The Chart Options dialog box showing the Titles tab.

The Titles tab, which is shown in Figure 3-16, lets you add text to the chart object to
label the chart and the chart axis. You often won’t do this, but if you want to title the
chart, you can enter a title. If you need to label the chart axis to more clearly describe
what is being plotted, you can also do this by using the Titles tab.

The Axes tab, as shown in Figure 3-17, provides two check boxes and three option
buttons you can click or mark or unmark to tell Microsoft Graph whether you want
an axis on the chart—and, when you do, how the axis should be drawn. The Axes tab,
like the other tabs in the Chart Options dialog box, redraw the picture of the chart
using your current specifications. Therefore, your best course of action is often to simply
experiment with different axis settings. You can see which work best for your data.
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Figure 3-17 The Chart Options dialog box showing the Axes tab.

The Gridlines tab, as shown in Figure 3-18, lets you add horizontal and vertical
gridlines to your chart or remove them. To add or remove gridlines, you mark and
unmark check boxes. As with other chart options settings, you can conveniently
experiment by marking and unmarking check boxes. The Chart Options tab includes
a picture of your chart that shows your current chart options settings.

Figure 3-18 The Chart Options dialog box showing the Gridlines tab.

The Legend tab, as shown in Figure 3-19, lets you specify whether you want a
legend. If you do, the Legend tab lets you choose a location for the legend. To specify
whether you want the legend, you mark the check box. To choose a legend location,
you click an option button.
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Figure 3-19 The Chart Options dialog box showing the Legend tab.

The Data Labels tab, as shown in Figure 3-20, provides option buttons you can mark
to indicate whether data markers should be labeled with the actual values they are sup-
posed to plot. The data marker is the graphics element a chart uses to visually
represent a data value. In a bar chart, for example, the bar is the data marker.

Figure 3-20 The Chart Options dialog box showing the Data Labels tab.

The Data Table tab, as shown in Figure 3-21, lets you add a data table to your chart.
For charts you add to PowerPoint slides, data tables would be used infrequently. A data
table shows the actual plotted values in a table—not unlike the datasheet from which
the plotted data comes. To specify whether you want or don’t want a data table, you
mark and unmark check boxes.
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Figure 3-21 The Chart Options dialog box showing the Data Table tab.

Using Organization ChartsUsing Organization ChartsUsing Organization ChartsUsing Organization ChartsUsing Organization Charts
PowerPoint comes with another small program named Organization Chart. You can
use this tool to add organizational chart objects to slides.

Adding an organization chartAdding an organization chartAdding an organization chartAdding an organization chartAdding an organization chart
To add an organizational chart to a slide, follow these steps:

1. Select the slide.

If you’re using Normal view to work with your presentation, you can select the slide
you want to add the organization chart to by clicking the slide title in the Outline
pane. You can also scroll through the individual slides shown in the Slide pane by
dragging the Slide pane’s scroll bar marker or by clicking the scroll bar buttons.

2. Tell PowerPoint that you want to add an organization chart.

Choose the Insert menu’s Picture command. When PowerPoint displays the
Picture submenu, choose its Organization Chart command. PowerPoint starts the
Organization Chart program and displays the Organization Chart window, as
shown in Figure 3-22.
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Figure 3-22 The Organization Chart window.

3. Label the organization chart.

Click the Chart Title placeholder, which appears at the top of the window, and type
the title you want to use. Note, though, that you might not want any chart title if
the slide title gives the same information.

NOTENOTENOTENOTENOTE To enter a chart title, you use the same text-entry and -editing rules as you use
elsewhere in PowerPoint. If you have questions about how to do this, refer to
the discussion in “Step 2: Outline Your Content.”

4. Describe the organization’s structure.

Each of the boxes on the organization chart represents a position. Some positions
are manager positions, and some positions are subordinate positions. Although the
Organization Chart program initially creates a rough guess of your organizational
structure, you need to update this organizational structure to reflect reality. You do
this by removing any unneeded boxes and then adding any new, necessary boxes.
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• To add a subordinate position, click the Subordinate button and then the box that
represents the subordinate’s manager. For example, if you want to add a fourth
subordinate to the Manager box, you click the Subordinate button and then the
Manager box.

• To add a co-worker to a position, click the Co-worker toolbar button, and then click
the position that has the co-worker. There are actually two Co-worker buttons. One
button adds a Co-worker box to the left of the existing box you click. The other
Co-worker button adds a new Co-worker box to the right of the position box you
click.

• To add a manager, click the Manager toolbar button. Then click the position box
that is managed by the manager.

• The Organization Chart toolbar also supplies an Assistant button. You can use the
Assistant button to add an Assistant Position box to some other position box.

NOTENOTENOTENOTENOTE The buttons you use to add subordinates, co-workers, managers, and assistants
aren’t difficult to use, and your best bet is simply to experiment with them. You
can remove any organization position box simply by clicking it and then choos-
ing the Edit menu’s Cut command or by pressing the Delete key.

5. Describe individual positions.

After you describe the organizational structure, you need to describe the positions
in more detail. To do this, click a position box. When you do, Microsoft Organi-
zation Chart turns the box into a text box. Type the position information you want.
Typically, you put the name of the person filling the position on the first line and
put the person’s title on the second line. If you want, you can also include a line or
two of comment or general information. You can edit this position box text in the
same way you edit text anywhere else. You then need to continue to describe the
other positions. Figure 3-23 shows a simple but completed organization chart.
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Figure 3-23 A simple organization chart.

NOTENOTENOTENOTENOTE If you work with a large organization chart, you might want to use the View
menu’s command to resize the image on the organization chart. If you choose
the View menu, Microsoft Organization Chart displays some self-explanatory
commands you can use to resize the organization chart shown in the window.
Remember, however, that you don’t actually have much room on a PowerPoint
slide, so you don’t want organization chart images to get too big.

6. Return to PowerPoint and to your slide.

When you finish creating the organization chart, you can close the Organization
Chart program and return to PowerPoint. To return to PowerPoint, choose the File
menu’s Exit And Return command. PowerPoint closes the Organization Chart
program and returns you to the slide. The slide now shows a copy of the organiza-
tion chart you just created.

NOTENOTENOTENOTENOTE To save a copy of the organization chart in a file, choose the File menu’s Save
Copy As command before you exit the Organization Chart program. When
Organization Chart displays the Save dialog box, specify where you want to save
your chart using the Save In box. Then name the chart using the File Name box.



Step 3 Step 3 Step 3 Step 3 Step 3  Add Objects 6363636363

Customizing an organization chartCustomizing an organization chartCustomizing an organization chartCustomizing an organization chartCustomizing an organization chart
Not surprisingly, the organization chart program includes numerous options you can
use for customizing organization chart objects. Most of these options are straightfor-
ward. Nevertheless, let’s quickly describe how you can make some of the most
important changes to your organization chart’s appearance.

Changing the chart styleChanging the chart styleChanging the chart styleChanging the chart styleChanging the chart style
The Styles menu displays a menu of pictures that show the various organization chart
styles you can use. This definition is too circular, but choose the Styles menu and
take a look at the menu of picture buttons that are displayed. What the Styles menu
commands do becomes clear. All you need to do is choose a button that shows a
picture of what you want your chart to resemble.

Formatting organization chart textFormatting organization chart textFormatting organization chart textFormatting organization chart textFormatting organization chart text
The Text menu displays five commands that let you format the text inside the
position boxes. To use the Text commands, first select the position box or boxes you
want to reformat. You can select one position box by clicking it. If you want to select
all position boxes, or some group of them, choose the Edit menu’s Select command.
When the Select submenu appears, choose the command that corresponds to the group
of position boxes you want to arrange.

After you’ve selected the position boxes you want to change, you can use the Text Font
command to change the font. When you choose the Text Font command, Organiza-
tion Chart displays the Font dialog box, as shown in Figure 3-24. You can use its three
boxes (Font, Font Style, and Size) to specify how you want text in the selected
position box or boxes to appear. Select the font you want to use from the Font list box,
the style you want from the Font Style list box, and the point size you want from the
Size list box. Use the sample area of the Font dialog box to see what your choices look
like.
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Figure 3-24 The Font dialog box.

NOTENOTENOTENOTENOTE The Size box and list box refer to point size. A point equals 1/72 inch.

The Text menu’s Color command displays a Color dialog box, as shown in Figure
3-25. This box simply displays colored squares. To use one of the colors shown for the
text in the selected box or boxes, click the color. The last three commands on the Text
menu (Left, Right, and Center) work like toggle switches. You choose the command
that refers to the text alignment you want to use. Organization Chart places the check
mark in front of the command you have last chosen to show how text is being aligned.

Figure 3-25 The Color dialog box.
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Changing boxes and linesChanging boxes and linesChanging boxes and linesChanging boxes and linesChanging boxes and lines
The Boxes menu displays commands you can use to change the appearance of the
selected position box or boxes. The Color command, for example, displays a dialog box
you can use to specify a background color for the position boxes. The Shadow
command displays a submenu of buttons you can click to add a shadow to the selected
box or boxes. The Border Style command displays a submenu you can use to specify
what the position box border should look like. The Border Color command displays
a dialog box you can use to choose a color for the position box border. The Border Line
Style command displays a submenu you can use to choose a line style for the position
box border. Choose the menu command that shows a line like the one you want to use.

The Lines menu provides three commands that let you change the thickness, style,
and color of the lines used to connect the position boxes. The Lines menu’s Thick-
ness command displays a submenu of line thicknesses. You choose the picture of the
line that corresponds with the thickness of the line you want to use. The Line menu’s
Style command displays a submenu of line style pictures. Again, you click the picture
that shows the line style you want. Finally, the Lines menu’s Color command displays
a Color dialog box. To specify what color you want to use for the line’s connecting
position boxes, click the color square that shows the color.

Using Other Objects on SlidesUsing Other Objects on SlidesUsing Other Objects on SlidesUsing Other Objects on SlidesUsing Other Objects on Slides
In addition to table, picture, chart, and organization chart objects, you can add other
types of objects to slides. The objects already discussed in this step are those you will
most commonly use, but let’s briefly describe some other objects and how to add them.

Using the Insert Object commandUsing the Insert Object commandUsing the Insert Object commandUsing the Insert Object commandUsing the Insert Object command
If you choose the Insert menu’s Object command, PowerPoint displays the Insert
Object dialog box, as shown in Figure 3-26. You can use this dialog box to create a
new object from scratch using some other program you have installed on your
computer. You can also use this dialog box to grab an existing file and use it as an object
on a slide.
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Figure 3-26 The Insert Object dialog box.

To create a brand-new object using a program already on your computer, click the
Create New button. Then select the object type from the list box. When you click OK,
PowerPoint opens the appropriate program and you use it to create the object you want.

To use an existing file as an object, click the Create From File button. Then use the
File box (not shown) to identify the file location and name.

Adding Microsoft OfAdding Microsoft OfAdding Microsoft OfAdding Microsoft OfAdding Microsoft Office objectsfice objectsfice objectsfice objectsfice objects
You can easily use objects created in other Microsoft Office programs, such as chunks
of Word documents, ranges from Excel worksheets, and charts from another program
like Excel. There are several different ways you can grab one of these other objects and
use it in a PowerPoint slide—including the Insert Object command that was just dis-
cussed. However, the easiest way to use one of these other objects is by following these
steps:

1. Copy the object.

Display the object or the document that provides the object using the native
program. For example, if you want to copy an Excel chart, start Excel, open the work-
book with the chart, select the chart, and then choose the Edit menu’s Copy
command. You would use this same rough sequence of steps to copy any other object,
too.

2. Paste the object onto the appropriate PowerPoint slide.

After you’ve copied the object you want to use on a PowerPoint slide, start
PowerPoint, open the appropriate PowerPoint presentation, select the slide on which
you want to paste the object, and then choose the Edit menu’s Paste command.
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NOTENOTENOTENOTENOTE Because the Copy and Paste commands make moving an object from one pro-
gram to another extremely easy, you’ll find it most efficient to create objects
for PowerPoint slides using those programs you know best. For example, if you
are proficient in using Excel, you probably would want to use Excel to create
charts for your PowerPoint presentations. Not only is Excel more capable and
powerful in terms of its chart-creation capabilities, but you also already know
how to use the program.

Adding drawn objectsAdding drawn objectsAdding drawn objectsAdding drawn objectsAdding drawn objects
Managers and professionals who use PowerPoint are unlikely to draw objects for slides.
Most of us, quite frankly, don’t have artistic skills or the time to add this type of
embellishment to our presentations. Nevertheless, you should at least know that
PowerPoint will let you draw objects and include objects on slides. To do this, you
choose the Insert menu’s Picture command. Then, when PowerPoint displays the
Picture submenu, you choose the AutoShapes command. When you choose this com-
mand, PowerPoint displays the AutoShapes toolbar, as shown in Figure 3-27. It pro-
vides a bunch of previously drawn shapes and images you can select and then use on
a PowerPoint slide.

Figure 3-27 The AutoShapes toolbar with the Stars And Banners menu open.

You can also use the Drawing toolbar to draw freehand shapes and images for use on
a slide. To display the Drawing toolbar, choose the View menu’s Toolbar command.
Then choose the Drawing command from the Toolbar’s submenu. When you do this,
PowerPoint adds the Drawing toolbar to the PowerPoint program window, as shown
in Figure 3-28. The Drawing toolbar includes roughly two dozen clickable buttons
you can use to draw objects by hand.
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Figure 3-28 The Drawing toolbar.

Adding WAdding WAdding WAdding WAdding WordArt objectsordArt objectsordArt objectsordArt objectsordArt objects
You can take a chunk of text and turn it into a WordArt object. When you do this,
the text still looks like text but is actually a fancy, often colorful graphics object, as
shown in Figure 3-29. Appendix B, “Using WordArt,” describes the WordArt applet
in more detail.

Figure 3-29 A WordArt object.
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Step 4

DESIGN YOUR LOOKDESIGN YOUR LOOKDESIGN YOUR LOOKDESIGN YOUR LOOKDESIGN YOUR LOOK

Featuring:Featuring:Featuring:Featuring:Featuring:
• Selecting a Design Template

• Customizing the Master Slides

• Formatting an Object

• Working with Special Placeholders

• Using the Formatting Toolbar

The earlier discussions in this book focused on developing content for your presen-
tations—which is only appropriate. A good presentation is fundamentally based on
good, rich, interesting content. But the look or design of your presentation is impor-
tant, too, so in this step we turn from the content of your presentation to its design
and, specifically, the tools that PowerPoint supplies to make your presentations pro-
fessional and appropriate in appearance.

NOTENOTENOTENOTENOTE Your presentation’s slides might already look the way you want. When you
created your new presentation using PowerPoint, you might have based your
presentation on an existing design template, and that design template might
give you just the look you want. If that’s the case in your situation, skip ahead
to “Step 5: Add Special Effects.”
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Selecting a Design TSelecting a Design TSelecting a Design TSelecting a Design TSelecting a Design Templateemplateemplateemplateemplate
PowerPoint supplies design templates. A design template provides a color scheme that
is used for all the presentation’s slides; the title master slide, which shows how your title
slide looks; a slide master slide, which shows how the nontitle slides in your presenta-
tion look; and a set of auto layouts. An auto layout is just a slide that includes one or
more object placeholders.

You can choose a design template in two ways. Which way you choose the design
template depends on whether you’re just starting to create your presentation or have
already created the presentation

Selecting a design template as you startSelecting a design template as you startSelecting a design template as you startSelecting a design template as you startSelecting a design template as you start
One way—and perhaps the most common—is to select a design template before you
begin creating your presentation. When you start PowerPoint, it displays the dialog
box shown in Figure 4-1. This dialog box, which you no doubt have seen before, lets
you indicate whether you want to create a new presentation using the AutoContent
Wizard, a design template, or a blank presentation. You can also indicate that you are
not creating a new presentation and will instead open an existing presentation.

Figure 4-1 The PowerPoint dialog box.
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NOTENOTENOTENOTENOTE To open an existing presentation, you can click the Open An Existing Presen-
tation button and then select the presentation from the list box that PowerPoint
provides.

If you do indicate that you want to create a new presentation using a design template,
PowerPoint displays the New Presentation dialog box, as shown in Figure 4-2. The
Design Templates tab will be selected, and you can select one of the design templates
from the list. The Design Templates tab provides a Preview box you can use to see
roughly what the design template looks like. When you find the appropriate design
template, you can click the OK button.

Figure 4-2 The New Presentation dialog box.

 Selecting a design template after you start Selecting a design template after you start Selecting a design template after you start Selecting a design template after you start Selecting a design template after you start
If you want to use a design template for an existing presentation or you want to change
the design template for a presentation, you follow a slightly different approach. First,
you need to open the presentation—by choosing the File menu’s Open command, for
example—and then use its Look In box and its unlabeled list box to locate and iden-
tify the presentation.

After you open the presentation, you can choose the Format menu’s Apply Design
Template. When you choose this command, PowerPoint displays the Apply Design
Template dialog box, as shown in Figure 4-3. This dialog box works in a fashion very
similar to the Design Templates tab of the New Presentation dialog box shown in
Figure 4-2.
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Figure 4-3 The Apply Design Template dialog box.

To change the design template used for the open presentation, select one of the
design templates from the list box that appears. A preview area next to the list box shows
you what the selected design template looks like. When you locate the design tem-
plate you want, click the Apply button.

NOTENOTENOTENOTENOTE PowerPoint stores its design templates in a folder named Presentation Designs.
The Presentation Designs folder is a subfolder in the Templates folder. The Tem-
plates folder is a folder in whatever folder you chose to install Office 2000.
Presentation design templates, by the way, use the file type specification .pot.

Although you will presumably want to work with the design templates already built
in or included with the PowerPoint program—after all, these design templates were
created by professional artists—you can create your own design template. To do this,
you first want to create a presentation that looks just the way you want. (Predictably,
that means that you want to perform all sorts of design and formatting tasks that are
described in the pages that follow.)

When you do have a presentation that looks exactly the way you want future presen-
tations to look, you can turn this presentation’s formatting and design information into
a design template. To do this, choose the File menu’s Save As command. When
PowerPoint displays the Save As dialog box, as shown in Figure 4-4, first use the Save
In box to select the folder you’ve used to store the design templates. As noted, design
templates are typically stored in the presentation’s Design subfolder, a folder in the
Template folder, which is in turn a subfolder in the Office 2000 folder. Next, use the
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Save As Type list box to indicate that what you want to save is a design template. You
can do this by opening the Save As Type box and then choosing the Design Template
entry. After you provide this information, you can click the Save button.

Figure 4-4 The Save As dialog box.

After you have created a design template, you can use it in the future by choosing the
Format menu’s Apply Design Template command.

Customizing the Master SlidesCustomizing the Master SlidesCustomizing the Master SlidesCustomizing the Master SlidesCustomizing the Master Slides
Changing the design template used for a presentation represents the most fundamental
customization you can make to the appearance of your presentation. The next most
far-reaching change you can make is to the master slides used to create the individual
slides in your presentation. A master slide is essentially just a blueprint for creating
individual slides.

You can make a variety of changes to a master slide, and thereby to all the slides in
your presentation. First, however, you need to display the master slide. To display a
master slide, choose the View menu’s Master command. When you do this, PowerPoint
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displays the Master submenu. The Master submenu lists the four types of master slides:
Slide Master, Title Master, Handout Master, and Notes Master. When you are chang-
ing the appearance of your presentation, you work with the Slide Master (which speci-
fies how the individual slides in your presentation look) and the Title Master (which
specifies how the first title slide in your presentation looks).

After you choose the appropriate Master submenu command—presumably either the
Slide Master command or the Title Master command—PowerPoint displays the
appropriate master slide. Figure 4-5 shows Slide Master view in the PowerPoint
program window. This slide master shows object placeholders and the font styles that
are used.

Figure 4-5 Slide Master view.
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Changing the backgroundChanging the backgroundChanging the backgroundChanging the backgroundChanging the background
You can change the background used for each of the slides based on the master slide
by simply choosing the Format menu’s Background command. When you do,
PowerPoint displays the Background dialog box, as shown in Figure 4-6. To choose
a background fill for the master slide, open the drop-down list box, which appears in
the dialog box. When you do, PowerPoint displays a pop-up box that shows colored
background fill options. To select a fill option shown in one of these colored squares,
simply click the square.

Figure 4-6 The Background dialog box.

When you want to use some other color or pattern besides those shown, you can click
either the More Colors command or the Fill Effects command. When you click the
More Colors command, PowerPoint displays the Colors dialog box, as shown in Figure
4-7. To use the Colors dialog box, click the color hexagon that uses the color you want.
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Figure 4-7 The Colors dialog box.

If you choose the Fill Effects command from the list, PowerPoint displays a Fill
Effects dialog box, as shown in Figure 4-8. To control background fill, click the
Gradient tab and then use its Color option buttons and its Shading option buttons
to produce the fill effect you want. You can easily experiment with these two sets of
option buttons. PowerPoint shows the effect of your color and shading style settings
in the sample box.

Figure 4-8 The Gradient tab in the Fill Effects dialog box.

The Fill Effects dialog box includes a Texture tab, as shown in Figure 4-9. If you click
the Texture tab, PowerPoint displays a collection of boxes that show different textures
you can use for the background fill pattern.
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Figure 4-9 The Texture tab in the Fill Effects dialog box.

The Fill Effects dialog box provides a Pattern tab, as shown in Figure 4-10. The
Pattern tab works similarly to the Texture tab. You simply click the Pattern box that
shows the pattern you want to use. The Pattern tab also includes foreground and
background drop-down list boxes. You use these boxes to select the two colors used
to create a pattern.

Figure 4-10 The Pattern tab in the Fill Effects dialog box.
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The Fill Effects dialog box also provides a Picture tab, which isn’t shown in a figure
in this step. You can use the Picture tab to insert a picture as the background pattern
for your slides. After you’ve specified the background fill you want to use, you can click
the Preview button in the Background dialog box, as shown in Figure 4-6, to see how
your background fill pattern looks. If the background fill looks the way you want, click
the Apply To All button to change the background pattern of all slides in your
presentation.

NOTENOTENOTENOTENOTE You can use the Format menu’s Background command to change only the
background of a single slide or the background of a selected group of slides.
To do this, you don’t make changes to the master slide background but rather
to the slide itself. When you’re working with individual slides or sets of slides
that are part of a large presentation, you can click the Background dialog box’s
Apply button. By clicking Apply, PowerPoint applies the background fill change
to only the selected slide or slides.

Changing the color schemeChanging the color schemeChanging the color schemeChanging the color schemeChanging the color scheme
You can change the eight-color character scheme used for a presentation. To do this,
first display the master slide. Then choose the Format menu’s Slide Color Scheme com-
mand. When you do this, PowerPoint displays the Color Scheme dialog box, as shown
in Figure 4-11.

Figure 4-11 The Standard tab in the Color Scheme dialog box.
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The Standard tab in the Color Scheme box provides clickable buttons you can use to
select an alternative color scheme. Each of these boxes shows the colors these schemes
use. After you select the color scheme, you can click the Preview button to see what
the color scheme does to your presentation. Clicking the Apply To All button tells
PowerPoint to change the color scheme for all the slides in your presentation. Alter-
natively, clicking the Apply button makes the color scheme change to only the selected
slide or slides.

Although you probably will work with the color schemes supplied with a design tem-
plate, you can create your own eight-color color scheme. To do this, click the Custom
tab in the Color Scheme dialog box. Figure 4-12 shows what the Color Scheme
Custom tab looks like. A color scheme is made up of eight colors: a background color,
a text and lines color, a shadows color, a title text color, a fills color, an accent color,
an accent and hyperlink color, and an accent and followed hyperlink color.

Figure 4-12 The Custom tab in the Color Scheme dialog box.

To change one of these colors, click the color square and then the Change Color button.
When you do, PowerPoint displays a Color dialog box like the one shown in Figure
4-13. To pick a color from this dialog box, click the color you want.
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Figure 4-13 The Standard tab in a Color dialog box—in this case, the Background Color
dialog box.

TIPTIPTIPTIPTIP If you change the colors in the color scheme, make sure that your colors pro-
duce high contrast.     To be easy to read, words and pictures on slides need to
be bright and clear and contrast strongly with the color of the background. This
means two things: First, the ambient light in the room must be subdued enough
for the slides to appear bright. Brightness can be achieved with a powerful
projector (projectors are rated in lumens; the higher the lumens, the greater
the brightness; 600 lumens is a minimum) or by having sufficient darkness in
the room or in the end of the room where the slides are being projected.
Second, the letters, graphs, and images on each slide must contrast strongly
with the selected background color or pattern. Generally, the darker the back-
ground color and the lighter the lettering or line color, the greater the contrast
and readability.

You can also use this dialog box’s Custom tab to select the color you want (see Figure
4-14). You can select a color in two ways: Click a color in the Colors box—the
rainbow-colored box you see on the tab—or describe the color using either the Hue,
Sat (saturation), or Lum (luminance) set of boxes or the Red, Green, or Blue boxes.
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Figure 4-14 The Custom tab in a Color dialog box—in this case, the Background Color
dialog box.

To use either set of boxes to describe the color, you enter values into the boxes or use
the box’s spinner controls. After you pick the color you want to use, click the OK
button. PowerPoint returns you to the Custom tab in the Color Scheme box (as shown
in Figure 4-12). You might want to make color changes to other colors that make up
this scheme. When you are done, click either the Apply button or the Apply To All
button.

NOTENOTENOTENOTENOTE When you change a master slide, you change all slides that rely on the master
slide for design information. You can, however, also change the appearance
of individual slides. To do this, you simply display and select the slide you want
to change rather than the master slide. You can also make a change to some
subset of the slides that make up a presentation by using Slide Sorter view to
select the slides you want to change. Slide Sorter view is described in “Step 6:
Prepare Your Presentation.”

Changing text formattingChanging text formattingChanging text formattingChanging text formattingChanging text formatting
You can change the font, font style, point size, and other font specifications for the
slides in your presentation by using the Format menu’s Font command. To use this
command, first display the master slide and then click the text object you want to
change. After you’ve done this, choose the appropriate Format menu command or
toolbar button.
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Changing the fontChanging the fontChanging the fontChanging the fontChanging the font
To change the font for the selected text, choose the Format menu’s Font command.
PowerPoint displays the Font dialog box, as shown in Figure 4-15.

Figure 4-15 The Font dialog box.

To use the Font dialog box, select the font you want from the Font list box. Then choose
the font style you want by clicking one of the entries in the Font Style list box:
Regular, Bold, Italic, or Bold Italic. Finally, specify the correct point size by entering
a point size value in the Size text box or by choosing a point size from the Size list
box. (One point equals 1/72 inch.)

TIPTIPTIPTIPTIP For easy readability, use large point sizes of bold type that fill your slide with
information and convey your message. This means two things. First, don’t
“worship” white or blank space. White space in itself is not sacred (although
many artists think that it is); it should be used to illuminate the text just enough
so that your message is communicated strongly. Yes, you should avoid a clut-
tered look, but make the lettering and images as large as possible so that they
fit and read easily. Second, keep type sizes of titles and text equal. PowerPoint
templates typically give you a large title (44-point type) and a smaller (32-point)
setting for bulleted text. Which is more important on a slide: the title or the
content? We think it’s the content. Therefore, the font size of the bulleted text
should be at least equal to the size of the title. A good way to differentiate titles
and text is to have titles on each slide in one color and bulleted or numbered
points in other colors.
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You probably won’t have an occasion to use them, but the Font dialog box also
provides a set of Effects check boxes you can mark to add special effects, such as
underlining, shadows, embossing, superscripting, and subscripting.

You can also use a Color drop-down list box to specify what color PowerPoint should
use for selected text. This color specification overrides the text color specified for the
color scheme—but only for selected text.

TIPTIPTIPTIPTIP Use bold lettering. It’s not just the height of letters that makes words read far,
it’s the weight: Fat letters read farther. If you want to fill a room with slides that
pack a wallop, choose bold typefaces. Avoid typefaces with serifs, such as Times
New Roman. Note that this means that even though PowerPoint uses Times
New Roman as its default setting for slides, you still want to use it only in bold-
face. The tiny serif “feet” on letters disappear from a distance, robbing words
of impact. Choose instead Arial Bold or Black or Tahoma Bold or the excellent
typeface named Eras (available in font collections and in Corel clipart packages).

Replacing a fontReplacing a fontReplacing a fontReplacing a fontReplacing a font
The Format menu includes a Replace Font command. You can choose this command
to display the Replace Font dialog box, as shown in Figure 4-16. It lets you make a
wholesale replacement of a font in your presentation. You can use the Replace Font
dialog box, for example, to replace every occurrence of the Times New Roman font
with the Helvetica font.

Figure 4-16 The Replace Font dialog box.
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Changing text alignmentChanging text alignmentChanging text alignmentChanging text alignmentChanging text alignment
By default, text is left aligned in text placeholder objects. You can change the
alignment used for the selected text object, however, by choosing the Format menu’s
Alignment command. When you choose this command, PowerPoint displays the
Alignment submenu. It lists the four alignment options that are available: Align Left,
(which, of course, aligns text left), Center (centers text in the object placeholder), Align
Right (right-aligns text), and Justify (stretches out text so that the text is both
left- and right-aligned). You can experiment with the Alignment submenu commands
to fine-tune the text alignment used on your slides.

Changing the caseChanging the caseChanging the caseChanging the caseChanging the case
The Format menu’s Change Case command lets you change the capitalization or case
used for the text in the selected text placeholder. You can also use the Change Case
command to change the case of just the text that is selected. When you choose the
Change Case command, PowerPoint displays the dialog box shown in Figure 4-17.
All you do is mark the Option button that corresponds to the capitalization or case
rule you want to use.

Figure 4-17 The Change Case dialog box.

NOTENOTENOTENOTENOTE The Change Case dialog box’s option buttons are labeled using words or phrases
that show the case for the option.

Changing the bullets and numbers used forChanging the bullets and numbers used forChanging the bullets and numbers used forChanging the bullets and numbers used forChanging the bullets and numbers used for
bulleted textbulleted textbulleted textbulleted textbulleted text
You can change the bullet style that is used or the numbering style used for bulleted
or numbered text. To do this, first display the master slide, and then select the bulleted
list you want to modify. After you’ve done this, choose the Format menu’s Bullets And
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Numbering command. When you do, PowerPoint displays the Bullets And Numbering
dialog box, as shown in Figure 4-18.

Figure 4-18 The Bulleted tab in the Bullets And Numbering dialog box.

NOTENOTENOTENOTENOTE The Size and Color boxes on the Bulleted tab in the Bullets And Numbering dia-
log box let you specify how large the bullet should be as a percentage of the
text size and what color it should be.

To choose a bullet format, simply click the box that uses the bullets you want to use.
If none of the boxes shows a bullet you want to use, you might be able to create a
superior bullet based on a WingDings character or an appropriate picture image. To
create your own bullet character, click the Character button. Then, when PowerPoint
displays the Bullet dialog box, as shown in Figure 4-19, click the character you want
to use. (You might need to first select the WingDings font or some other appropri-
ate font from the Bullets list box.)



8686868686 Effective Executive’s Guide to PowerPoint 2000 - Electronic Edition

Figure 4-19 The Bullet dialog box.

If you want to use an appropriate picture image for your bullet, you can click the
Picture button. When you do, PowerPoint displays a Picture Bullet dialog box (see
Figure 4-20). This dialog box lets you view the PowerPoint Clipart Gallery and se-
lect one of its images for use as a bullet.

Figure 4-20 The Picture Bullet dialog box.

The Numbered tab in the Bullets And Numbering dialog box, as shown in Figure
4-21, lets you select a numbering style for a bulleted list you’ve numbered. You sim-
ply click the box that shows the numbered text the way you want your slide to look.
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Figure 4-21 The Bullets And Numbering dialog box.

TIPTIPTIPTIPTIP When you are displaying a list of information on a slide, you have a choice to
precede each listed item with a bullet or a number. Generally, bullets are a
writer’s tool, and numbers are for speakers. It’s easier to say “Number seven”
than to have to say “Now look at the seventh bullet.” Bullets are fine for a short
list, but numbers work better when a natural sequence occurs or you are
describing steps or you plan to speak about the separate items on the slide.
Numbers also help listeners take notes because they provide a natural index of
information.

Controlling line spacingControlling line spacingControlling line spacingControlling line spacingControlling line spacing
You can specify how widely lines of text should be spaced. To do this, select the text
object for which you want to specify line spacing, or, if you don’t want to do this to
an entire text object, select the text by clicking and dragging the mouse. After you’ve
done this, choose the Format menu’s Line Spacing command. PowerPoint displays the
Line Spacing dialog box, as shown in Figure 4-22.
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Figure 4-22 The Line Spacing dialog box.

Use the Line Spacing boxes to indicate whether text should be single-spaced, double-
spaced, and so on. Use the Before Paragraph box to specify extra lines or whether a
portion of an extra line should be placed for a paragraph. Finally, use the After
Paragraph box to indicate whether an extra line or portion of a line should be placed
after a paragraph.

NOTENOTENOTENOTENOTE PowerPoint, like Microsoft Word, views as a paragraph any block of text that
ends with your pressing the Enter key. Therefore, a paragraph in PowerPoint
is any chunk of text that ends with the Return key’s being pressed. Interestingly,
pressing the Return key actually adds to the text a special, hidden symbol called
the end-of-paragraph marker.

Formatting an ObjectFormatting an ObjectFormatting an ObjectFormatting an ObjectFormatting an Object
In addition to the sorts of customization described in the preceding paragraphs, you
can change the appearance of most objects you place on PowerPoint slides. In fact, with
few exceptions, you can change basically any object you place on a PowerPoint slide.
To do this, you simply right-click the object you want to change and choose the
Format Placeholder command or the Format Object command from the Shortcuts
menu. PowerPoint displays a Format dialog box (the name varies depending on what
you right-clicked) that looks like the one shown in Figure 4-23.
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Figure 4-23 The Colors And Lines tab in a Format dialog box—in this case, Format
AutoShape.

The Format dialog box generally includes a Colors And Lines tab that lets you specify
the fill color that should be used for the object or placeholder. The tab also includes
a set of line boxes that let you choose the line color, the line style, and its weight as a
point size for any lines used in the object or placeholder. Finally, if what you selected
is an arrow or a line, you might be able to use the arrow boxes to control the appear-
ance or specify the appearance of the line.

The Format dialog box also typically includes a Size tab, as shown in Figure 4-24. This
tab generally lets you size an object by providing its height and width. You can also
use the Size tab to rotate an object by entering a value in the Rotation box. If you want,
you can even scale the object or resize its original dimensions by using the Scale Height
and Scale Width boxes. To use these boxes, you enter the percentage of the original
size you want the newly rescaled image to be.
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Figure 4-24 The Size tab in a format dialog box—in this case, Format AutoShape.

The Format dialog box also provides other tabs you can use to control or change the
appearance of some object or placeholder:

• The Position tab, for example, lets you specify the object location of the object using
text boxes and drop-down list boxes.

• The Picture tab lets you crop a picture image and make modest changes to the
image’s color, brightness, and contrast.

• The Text box lets you specify how text should be anchored inside a text placeholder
box and what internal margins PowerPoint should use for positioning text inside
the placeholder. The Text Box tab also provides check boxes you can use to tell
PowerPoint how it should wrap text inside the placeholder, resize the placeholder
if the text is too large to fit, and even rotate text inside a placeholder.

• The Web tab lets you specify some text replacement for a graphics object. You use
the Web tab when you are publishing a PowerPoint presentation on the Web. By
specifying a text replacement for an object, you give someone who doesn’t have a
Web browser capable of displaying graphic images the chance to still be able to see
your presentation’s information.
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TIPTIPTIPTIPTIP To make your slides look just right, take advantage of an optical illusion: Our
eyes want to see the horizontal center of a page 5 percent above the actual
measured center. This is the visual, or optical, center of a page. Therefore, al-
ways allow more blank space to show at the bottom of slides, beneath the text,
than you allow at the top, above the title. If you place lettering all the way to
the bottom of a slide, it will look heavy, as though it’s falling off the slide. So
“lift” your text, and your slides will satisfy people’s aesthetic sense.

WWWWWorking with Special Placeholdersorking with Special Placeholdersorking with Special Placeholdersorking with Special Placeholdersorking with Special Placeholders
If you display a master slide, you’ll notice that PowerPoint provides placeholders to
provide date and time information and a slide number near the bottom of each slide.
You’ll probably want to use this information on your slides, but if you don’t, you can
delete any of these items by clicking the appropriate placeholder to select it and then
using the Edit menu’s Clear command.

Using the Formatting TUsing the Formatting TUsing the Formatting TUsing the Formatting TUsing the Formatting Toolbaroolbaroolbaroolbaroolbar
There isn’t much reason to spend lots of time talking about the Formatting toolbar,
but let’s just quickly mention this much: After you’ve become comfortable working
with the Format menu command, particularly the Format menu’s Font command and
the Bullets And Numbering command, you will want to explore the tools provided by
the Formatting toolbar, as shown in Figure 4-25.

Figure 4-25 The Formatting toolbar.

NOTENOTENOTENOTENOTE Figure 4-25 shows a picture of a free-floating toolbar to make it easy to see,
but typically the Formatting toolbar is anchored just below the menu bar.
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The Formatting toolbar provides several boxes and numerous clickable buttons you
can use to, in effect, quickly choose some formatting option. For example, if you
select some text and click the button with the large B on it, you have boldfaced the
selected text. Other Formatting toolbar buttons let you make further specifications,
control text alignment, and change text into a bulleted or numbered list, for example.
You won’t have any problem figuring out what various buttons do by experimenting
to see their effect. If you make a mistake or use a button that has an effect you don’t
want to keep, simply click the Undo button, which appears on the Standard toolbar.
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Step 5

ADD SPECIAL EFFECTSADD SPECIAL EFFECTSADD SPECIAL EFFECTSADD SPECIAL EFFECTSADD SPECIAL EFFECTS

Featuring:Featuring:Featuring:Featuring:Featuring:
• Using Special Slide Transitions

• Animating Slide Text

• Controlling Text Animation

• Creating Custom Animations

• Adding Sounds and Movies

One of the most interesting and controversial features of PowerPoint is the special
effects it lets you add to slides. You can use special slide-to-slide transitions, anima-
tion, sound effects, and even multimedia objects, like video clips, to enhance and enrich
your presentations. Admittedly, these special effects are often overused and overdone,
but the tools are also appropriate and useful for many presentations. Accordingly, this
step explains how to use the them.

Using Special Slide TUsing Special Slide TUsing Special Slide TUsing Special Slide TUsing Special Slide Transitionsransitionsransitionsransitionsransitions
If you don’t specify otherwise, PowerPoint simply displays the next slide. In other
words, PowerPoint uses no fancy or noticeable slide-to-slide transition. You can, how-
ever, specify that PowerPoint should use a slide-to-slide transition. To do so, take the
following steps:

1. Display the presentation using Slide Sorter view.

To display the open presentation using Slide Sorter view, choose the View menu’s
Slide Sorter command. When you do, PowerPoint displays the presentation’s slides
using Slide Sorter view, as shown in Figure 5-1.
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Figure 5-1 Slide Sorter view.

2. Indicate that you want to use a slide transition.

To indicate you want to use a slide transition, choose the Slide Show menu’s Slide
Transition command. When you do, PowerPoint displays the Slide Transition dialog
box, as shown in Figure 5-2.

Figure 5-2 The Slide Transition dialog box.
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3. Choose the transition effect.

You use the drop-down list box in the Effect area to choose the transition effect you
want. The Slide Transition dialog box lets you choose from at least two dozen
different slide-to-slide transition effects, so you’ll need to do some exploration to
find which one you will want to use. When you’ve chosen an effect, click one of the
speed buttons (Slow, Medium, or Fast) to indicate how quickly PowerPoint should
perform the effect.

NOTENOTENOTENOTENOTE When you choose an effect from the drop-down list box, PowerPoint uses the
Preview area, also shown in the Effect area, to show you what the effect looks
like.

4. Tell PowerPoint what triggers the transition.

You use the check boxes in the advance area to tell PowerPoint what event should
trigger or start the slide-to-slide transition.

• If you want PowerPoint to transition to the next slide when you click the mouse
or press the space bar, mark the On Mouse Click check box.

• If you want to automatically transition to the next slide, mark the Automati
cally After check box and enter the number of seconds that PowerPoint should
show the slide.

5. (Optional) Choose a sound.

If you want to also have PowerPoint play a sound as part of the slide transition, select
the sound from the Sound drop-down list box. PowerPoint provides several sounds
you can choose: Applause, [Breaking] Glass, Gunshot, and Laser, for example.

You can also choose the Other Sound entry from the Sound drop-down list box.
If you do, PowerPoint displays the Add Sound dialog box, as shown in Figure 5-3.
You can use the Add Sound dialog box to choose some other sound for the transi-
tion. To use the Add Sound dialog box, first specify the location of the sound file
using the Look In drop-down list box. Then, double-click the sound file from the
list of files displayed in the list box area.
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Figure 5-3 The Add Sound dialog box.

NOTENOTENOTENOTENOTE Later in this step, in the “Adding Sounds and Movies” section, we’ll describe
the other ways you can add sound to your presentation.

Animating Slide TAnimating Slide TAnimating Slide TAnimating Slide TAnimating Slide Textextextextext
You can add movement, or animation, to text. In fact, this will probably be the most
common animation you use for your presentations.

NOTENOTENOTENOTENOTE Later in this step, in the “Creating Custom Animations” section, we’ll also de-
scribe how to animate other objects on a slide.

Animating title and slide textAnimating title and slide textAnimating title and slide textAnimating title and slide textAnimating title and slide text
PowerPoint provides several ways you can animate slide text, although the easiest
approach is to use the Animation Effects toolbar. To use this toolbar, you first need
to display it. You can do this by choosing the View menu’s Toolbar command and then
choosing the Toolbar submenu’s Animation Effects command. When you do,
PowerPoint adds the Animation Effects toolbar to the PowerPoint window, as shown
in Figure 5-4.
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Figure 5-4 The Animation Effects toolbar.

The first two Animation Effects tools are the Animate Title button and the Animate
Slide Text button. Both buttons are toggle switches. You click the Animate Title button
to animate the slide title of the selected slide, and you click the Animate Slide Text
button to animate the slide text of the selected slide.

How PowerPoint animates, or adds movement, to the slide text depends on the slide
text you are animating. In general, if you tell PowerPoint to animate the slide title,
PowerPoint begins dropping the title into position. And, in general, when you tell
PowerPoint to animate slide text, such as a bulleted list, PowerPoint simply flashes the
text onto the slide. Note, though, that you can override these default animation set-
tings, as we’ll discuss in the next section, “Controlling Text Animation.”
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You can use the Animate Title and Animate Slide Text tools to animate text for only
the selected slide, or you can use these tools to animate text for all slides in a presen-
tation. To animate text for only the current slide, simply display the slide and then click
the tool. To animate text for all slides in your presentation, you can display the mas-
ter slide first—you can do this by choosing the View menu’s Master command—and
then choose the Slide Master command from the Master submenu, or you can dis-
play the presentation in Normal view and select all slides listed in the outline.

To see what effect the Animate Title and Animate Slide Text tools have on your
presentation, click the Animation Preview tool. It is the rightmost toolbar button on
the Animation Effects toolbar. When you click the Animation Preview tool,
PowerPoint displays a small picture of the slide and animates its text according to your
specifications.

NOTENOTENOTENOTENOTE You can learn the name of any toolbar button or box by using the mouse to
point to the tool. If you point to a toolbar tool, PowerPoint displays the tool
name in a small pop-up box.

Controlling TControlling TControlling TControlling TControlling Text Animationext Animationext Animationext Animationext Animation
The Animate Title and Animate Slide Text tools, described in the preceding
paragraphs, let you turn on text animation, and that might be all you want to do.
However, the other seven tools on the Animation Effects toolbar let you control the
way text animation works. These animation tools are described in Table 5-1.

NOTENOTENOTENOTENOTE The Animation Effects tools described in Table 5-1 control how animation works
for text in the selected text placeholder. This means that you will need to se-
lect the text placeholder (if it isn’t already selected) before you choose the
command or tool.

TOOL NAMETOOL NAMETOOL NAMETOOL NAMETOOL NAME WHAWHAWHAWHAWHAT IT DOEST IT DOEST IT DOEST IT DOEST IT DOES

Drive-in Effect Moves text from the right to its appropriate position.

Flying Effect Moves text from the left to its appropriate position.

Camera Effect Flashes text on a slide the way a camera shutter opens.

Flash Once Flashes text once on the screen and then it disappears.
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TOOL NAMETOOL NAMETOOL NAMETOOL NAMETOOL NAME WHAWHAWHAWHAWHAT IT DOEST IT DOEST IT DOEST IT DOEST IT DOES

Laser Text Effect Rains characters down into their current position,
dropping them at a 45-degree angle from right to left.

Typewriter Effect Displays text one character at a time from left to right as
though being typed by a typewriter.

Reverse Text Order Effect Reverses the traditional order in which text in a bulleted
list is displayed. Normally, the items in a bulleted list are
displayed starting from the top of the list. But if you click
the Reverse Text Order Effect tool, PowerPoint displays
the last entry in the bulleted text first, and then the next
to last, and so on.

Table 5-1 Animation Effects tools for controlling text movement.

Specifying the order of text animation efSpecifying the order of text animation efSpecifying the order of text animation efSpecifying the order of text animation efSpecifying the order of text animation effectsfectsfectsfectsfects
You should consider one other useful point concerning animation: PowerPoint
animates individual objects. This means that you might have several objects on a slide
that are all animated.

Be default, PowerPoint plays these animation effects in the same order as you added
the animation to the slide. You can change this order by using the Animation Order
list box, which also appears on the Animation Effects toolbar.

To control the order of the animation effects played on a slide, first display the slide
using Normal view. You can do this by choosing the View menu’s Normal View
command and then by displaying the slide in the Slide pane.

Then click the object you want to animate first, open the Animation Order list box,
and click 1. Next, select the object you want to animate second, open the Animation
Order list box, and select 2. Repeat this process to tell PowerPoint what object you want
to animate third, fourth, and so on.

Creating Custom AnimationsCreating Custom AnimationsCreating Custom AnimationsCreating Custom AnimationsCreating Custom Animations
While the Animation Effects toolbar tools already described will probably be adequate
for most presentations, you should know that you can also use PowerPoint’s Custom
Animation command to exercise more control over how PowerPoint animates slides.
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To choose the Custom Animation command, either click the Custom Animation
button on the Animation Effects toolbar or right-click the object you want to animate
and then choose Custom Animation from the Shortcuts menu. Using either approach,
PowerPoint displays the Custom Animation dialog box shown in Figure 5-5.

Figure 5-5 The Order & Timing tab in the Custom Animation dialog box.

The Custom Animation dialog box lets you make as many as four customizations to
object animation: customizing the order and timing of animation effects, customiz-
ing the actual animation or movement effects, customizing charts when the object is
a chart, and adding multimedia settings. The paragraphs that follow describe each of
these customization opportunities.

Controlling the order and timing of animationControlling the order and timing of animationControlling the order and timing of animationControlling the order and timing of animationControlling the order and timing of animation
The Order & Timing tab in the Custom Animation dialog box lets you control the
order of your animation effects and how quickly the animation occurs. To make these
sorts of customizations, take the following steps:

1. Select the objects for which you want to customize animation.

To indicate for which objects you want to customize animation, use the Check To
Animate Slide Objects list box. To customize animation for a particular slide ob-
ject, check its box. In Figure 5-5, for example, both the Title 1 and Text 2 slide ob-
jects show a check mark. This indicates to PowerPoint that animation for both
objects will be customized using the buttons and boxes on the Order & Timing tab.
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2. Specify the animation order.

Use the Animation Order list box, as shown in the lower left corner of the
Custom Animation dialog box, to control the order in which animation effects occur.
To do this, first select a slide object by clicking. Then click the Move Up and Move
Down buttons that appear next to the Animation Order list box. You can use these
buttons to move the selected slide object to its appropriate location.

3. Describe when animation should start.

Use the Start Animation settings to tell PowerPoint when it should begin the
animation. To begin as soon as you display the slide, mark the On Mouse Click
button. Alternatively, if you want animation to occur a certain number of seconds
after the previous animation effect, mark the Automatically button. If you mark the
Automatically button, enter the number of seconds that you want to elapse between
the previous animation and the current one.

Customizing animation efCustomizing animation efCustomizing animation efCustomizing animation efCustomizing animation effectsfectsfectsfectsfects
The Effects tab in the Custom Animation dialog box, as shown in Figure 5-6, lets you
control the actual animation or movement used for a slide. To use the Effects tab, take
the following steps:

Figure 5-6 The Effects tab in the Custom Animation dialog box.

1. Identify for which objects you want to customize animation.

To indicate for which objects you want to customize animation, use the Check To
Animate Slide Objects list box. To indicate that you want to customize animation
for a particular slide object, check its box.
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2. Choose an animation movement.

To choose how the animation should appear, open the drop-down list box in the
upper left corner of the Entry Animation And Sound area. In Figure 5-6, this
drop-down list box shows the word wipe. If you open this drop-down list box,
PowerPoint displays more than a dozen other animation effects you can choose.

To choose from which direction the animation should move, open the drop-down
list box in the upper right corner of the Entry Animation And Sound area. Then
specify from which direction the animation movement should come: Right, Left,
Top, or Bottom.

3. (Optional) Add sound to the animation.

You can use the larger list box in the Entry Animation And Sound area to choose
a sound for the animation.

4. Describe what should happen after the animation.

Use the After Animation list box that is shown to indicate what should happen after
PowerPoint completes the animation. If you activate the After Animation list box,
you get a pop-up menu of colored squares you can choose and some menu
commands like Don’t Dim, Hide After Animation, and Hide On Next Mouse
Click. If you want PowerPoint to change the color of the animation object, click
the square that shows the color you want to use. If you instead want PowerPoint
to dim or hide the text after the animation, click the appropriate menu command.

5. Specify how the text should be introduced.

You can use the boxes in the Introduce Text area to specify how PowerPoint first
displays, or introduces, the text you are animating.

The drop-down list box at the top of the Introduce Text area, for example, lets you
tell PowerPoint that it should display all the text at one time, one word at a time,
or one letter at a time. To choose one of these text-introduction specifications, you
simply select it from the list.

You can also use the Grouped By check box and the Grouped By list box to
introduce text by paragraph level. To use this introduction option, first check the
Grouped By box. Then use the Grouped By list box to select the paragraph level.

Use the Animate Attached Shape check box to tell PowerPoint that you want to
animate an auto shape along with the text attached to it. Note that PowerPoint will
animate an auto shape before the attached text is moved. In other words, PowerPoint
moves the shape and the text in two separate movements.
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Finally, use the In Reverse Order check box to tell PowerPoint that it should
display bulleted text starting with the last item in the bulleted text rather than with
the first.

Controlling chart animation efControlling chart animation efControlling chart animation efControlling chart animation efControlling chart animation effectsfectsfectsfectsfects
The Chart Effects tab in the Custom Animation dialog box, as shown in Figure
 5-7, lets you control how the animation works on chart objects. To use the Chart
Effects tab, take the following steps:

Figure 5-7 The Chart Effects tab in the Custom Animation dialog box.

1. Select the chart object.

Use the Check To Animate Objects list box to select the chart object. You do this
by simply marking the check box that appears in front of the chart slide object name.

2. Describe how chart elements should be introduced.

Use the Introduce Chart Elements area to specify how chart elements should be
moved. You can select several different introduction options from the Introduce
Chart Elements list box all at one time, by series, or by category. You can also check
or uncheck the Animate Grid And Legend box if you want these moved too.

3. Specify how PowerPoint should animate the objects.

To choose how the animation should appear, open the drop-down list box in the
upper left corner of the Entry Animation And Sound area. In Figure 5-7, this drop-
down list box shows the word fly. If you open this drop-down list box, PowerPoint
displays more than a dozen other animation effects you can choose.
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To choose from which direction the animation should move, open the drop-down
list box in the upper right corner of the Entry Animation And Sound area. Then
specify from which direction the animation movement should come: Right, Left,
Top, or Bottom.

4. Describe what PowerPoint should do after the animation.

Use the After Animation list box that is shown to indicate what should happen after
PowerPoint completes the animation. If you activate the After Animation list box,
you get a pop-up menu of colored squares you can choose and some menu
commands like Don’t Dim, Hide After Animation, and Hide On Next Mouse
Click. If you want PowerPoint to change the color of the animation object, click
the square that shows the color you want to use. If you instead want PowerPoint
to dim or hide the chart object after the animation, click the appropriate menu
command.

Adding Sounds and MoviesAdding Sounds and MoviesAdding Sounds and MoviesAdding Sounds and MoviesAdding Sounds and Movies
PowerPoint lets you add both sounds and movies to your slides. Interestingly,
PowerPoint also comes with sound files and several movies (they are motion clips based
on animated gif files) in its Clip Gallery.

NOTENOTENOTENOTENOTE An animated gif file is an image file that shows movement. You commonly see
animated gif images on web pages.

Adding soundAdding soundAdding soundAdding soundAdding sound
To add sound to a PowerPoint slide, you either choose a sound from the PowerPoint
Clip Gallery or insert a sound file stored somewhere else on your computer.

Using a sound from the Clip GalleryUsing a sound from the Clip GalleryUsing a sound from the Clip GalleryUsing a sound from the Clip GalleryUsing a sound from the Clip Gallery
To insert or use a sound from the PowerPoint Clip Gallery, follow these steps:

1. Choose the Sound From Gallery command.

To choose the Sound From Gallery command, first choose the Insert menu’s Movies
And Sounds command. Then, when PowerPoint displays the Movies And Sounds
submenu, choose its Sound From Gallery command. PowerPoint displays the
Insert Sound window, as shown in Figure 5-8.
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Figure 5-8 The Insert Sound window.

2. Find the sound you want.

You use the Sounds tab in the Insert Sound window to locate the sound you want.
To do this, find the category that seems to most closely match the sound clip you
are looking for and click its button. PowerPoint displays the clips in the selected
category.

If you need to keep looking in other categories, click the Back button and then select
another category. Figure 5-9 shows the sounds in the Entertainment category.
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Figure 5-9 The Insert Sound window showing the clips in its Entertainment category.

3. Play the clip.

To check a clip, click it so that PowerPoint displays the pop-up toolbar, and click
the Play Clip button. PowerPoint opens the sound-clip file using the Windows Me-
dia Player accessory. The Media Player program window, as shown in Figure 5-10,
provides clickable buttons you use to start, stop, pause, and restart the sound. These
buttons should look familiar to you. They mirror those provided on most music CD
and cassette tape players.

Figure 5-10 The Media Player window.

4. Insert the sound.

When you locate the sound you want, click the Sound Clip button so that
PowerPoint displays the pop-up toolbar. Then click its Insert Clip button. When
you do, PowerPoint inserts the sound on the open or selected slide.
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5. Specify when the sound should be played.

When you close the Insert Sound dialog box, you’ll see a Message box like the one
shown in Figure 5-11. PowerPoint displays this Message box to ask you when you
want a sound played. If you want the sound to play automatically when you display
this slide in your presentation, click the Yes button. If you don’t want the sound to
play automatically, click the No button. If you click the No button, you need to click
the Sound File icon on the slide in order to play it.

Figure 5-11 The Message box that asks when you want the sound played.

Using a sound fileUsing a sound fileUsing a sound fileUsing a sound fileUsing a sound file
You can also insert a sound that is stored on your computer or network in a sound file.
To do this, you need to know the sound file’s name and its folder location. Assuming
that you do have this information, you insert a sound file by taking the following steps:

1. Choose the Sound From File command.

To choose the Sound From File command, first choose the Insert menu’s Movies
And Sounds command. When PowerPoint displays the Movies And Sounds
submenu, choose its Sound From File command. PowerPoint displays the Insert
Sound dialog box, as shown in Figure 5-12.

Figure 5-12 The Insert Sound dialog box.
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2. Find the sound.

Use the Look In box to select the folder that holds the sound file. If the sound is
really in a subfolder or in a sub-subfolder, you might need to first select and open
the parent folder.

3. Insert the sound.

When you’ve found the folder with the sound, double click the sound file to insert
the sound on your slide.

When you do this, PowerPoint closes the Insert Sound dialog box. Beneath the
Insert Sound dialog box, PowerPoint displays a Message box just like the one shown
in Figure 5-11. It asks whether you want your sound to play automatically when
the slide is displayed. If you do, click Yes. If you don’t, click No. (If you do click No,
you play the sound by clicking its icon, which will appear on the slide.)

Recording your own sound fileRecording your own sound fileRecording your own sound fileRecording your own sound fileRecording your own sound file
The Movies And Sounds submenu also displays a Record Sound command. If your
computer has a microphone, you can use the Record Sound command to start a small
Sound Recorder program. The Sound Recorder program lets you record sounds
using your computer’s microphone. After you record a sound and save it as a file to
your desktop computer’s hard disk, you can insert the sound onto a slide, as described
in the preceding sequence of numbered steps.

Adding moviesAdding moviesAdding moviesAdding moviesAdding movies
You can add motion clips or video clips to your slides. This process resembles closely
the process used to add sound clips to your slides.

Using a motion clip from the Clip GalleryUsing a motion clip from the Clip GalleryUsing a motion clip from the Clip GalleryUsing a motion clip from the Clip GalleryUsing a motion clip from the Clip Gallery
To add a motion clip to your slide using the Movie Clip Gallery, take the following
steps:

1. Choose the Movie From Gallery command.

To choose the Movie From Gallery command, first choose the Insert menu’s Movies
And Sounds command. Then, when PowerPoint displays the Movies And Sounds
submenu, choose its Movie From Gallery command. PowerPoint displays the
Insert Movie window, as shown in Figure 5-13.
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Figure 5-13 The Insert Movie window.

2. Find the motion clip you want.

You use the Motion Clips tab in the Insert Movie dialog box to locate the sound
you want to use on a PowerPoint slide. To do this, find the category that seems to
most closely match the motion clip you are looking for and click its button.
PowerPoint displays the clips in the selected category. Figure 5-14 shows the mo-
tion clips in the Buildings category.

Figure 5-14 The Insert Movie window showing the motion clips in the Buildings category.
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3. Play the motion clip.

To check a clip, click it so that PowerPoint displays a pop-up menu, and then click
the Play Clip button. If you need to keep looking in other categories, click the Back
button and then select another category.

4. Insert the motion clip.

To insert the motion clip, click it so that PowerPoint displays the pop-up menu, and
then click the Insert Clip button. When you do, PowerPoint inserts the motion clip
on the open or selected slide.

NOTENOTENOTENOTENOTE The pop-up menu, or toolbar, that PowerPoint displays whenever you click a
sound or movie clip provides four buttons: Insert Clip, Play Clip, Add Clip To
Favorites Or Other Categories, and Find Similar Clips.

Using a motion clip fileUsing a motion clip fileUsing a motion clip fileUsing a motion clip fileUsing a motion clip file
To insert a motion or video clip stored as a file on your computer, take the following
steps:

1. Choose the Motion From File command.

To choose the Motion From File command, first choose the Insert menu’s Movies
And Sounds command. When PowerPoint displays the Movies And Sounds
submenu, choose its Movies From File command. When you do, PowerPoint
displays the Insert Movie dialog box, as shown in Figure 5-15.

Figure 5-15 The Insert Movie dialog box.
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2. Find the motion clip or video clip you want to use.

Use the Look In box to select the folder that holds the movie file. If the movie is
really in a subfolder or a sub-subfolder, you might need to first select and open the
parent folder.

3. Find the motion clip or video clip you want to use.

After you’ve found the folder with the movie, double-click the movie file to insert
the movie onto your slide.

When you do this, PowerPoint closes the Insert Movie dialog box. Beneath the
Insert Movie dialog box, PowerPoint displays a Message box, as shown in Figure
5-16, that asks whether you want your movie to play automatically when the slide
is displayed. If you do, click Yes. If you don’t, click No. If you do click No, it means
that you will have to play the movie by clicking it.

Figure 5-16 The Message box that asks when you want the movie shown.

Customizing your multimedia efCustomizing your multimedia efCustomizing your multimedia efCustomizing your multimedia efCustomizing your multimedia effectsfectsfectsfectsfects
You can exert significant control over the way PowerPoint handles any multimedia
objects you place on a PowerPoint slide. To do this, right-click the multimedia object
and then choose Custom Animation command from the Shortcuts menu. When
PowerPoint displays the Custom Animation dialog box, as shown in Figure 5-17, click
the Multimedia Settings tab.
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Figure 5-17 The Multimedia Settings tab in the Custom Animation dialog box.

You can use the Play Using Animation Order check box to indicate whether you want
the media object to play according to the animation order. Remember that the
animation order determines what happens next. You can change the animation or play
order by clicking the Order & Timing tab.

NOTENOTENOTENOTENOTE How you use the Order & Timing tab was discussed earlier in this step, in the
section “Creating Custom Animations.”

If you do choose to play the multimedia effect according to the animation order, use
the While Playing buttons to indicate whether the slide show should pause while you
are playing the song or showing the motion clip, or should continue. To pause the slide
show, click the Pause Slide Show button. To continue the slide show, click the
Continue Slide Show button.

If you tell PowerPoint to continue the slide show while playing the multimedia effect,
you can use the Stop Playing buttons to indicate when the multimedia effect should
stop. To stop the multimedia effect after the current slide, click the After Current Slide
button. To stop after some future slide, use the After button and box.

If you click the More Options button, which also appears on the Multimedia Settings
tab, PowerPoint displays a dialog box like the one shown in Figure 5-18. Note that
the kind of Options dialog box that PowerPoint displays depends on the type of
multimedia object. PowerPoint displays the Movie Options dialog box shown in Figure
5-18 when you are customizing the animation for a movie, but it displays the Sound
Options dialog box when you are customizing the animation for a sound object.
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Figure 5-18 The Movie Options dialog box.

In the case of the Movie Options dialog box, you can use the Play Options check boxes
to specify whether a movie sound should continue to replay or should be simply re-
wound and terminated after it has played.

NOTENOTENOTENOTENOTE Not all multimedia objects can be customized. If you insert animated gif images
on a slide, for example, you might not be able to make any changes to their
animation.

Adding sound from a music CDAdding sound from a music CDAdding sound from a music CDAdding sound from a music CDAdding sound from a music CD
You can also play a CD track during a presentation. To do this, you need, predictably,
the CD in your computer’s CD drive or DVD drive.

To play a sound or track from a CD, choose the Insert menu’s Movies And Sounds
command. Then choose the Play CD Audio Track command from the Movies And
Sounds menu. When you choose this command, PowerPoint displays the Movie And
Sound Options dialog box, as shown in Figure 5-19. Use the Play CD Audio Track
Start boxes to enter the track number of the first track you want to play and the Play
CD Audio Track End boxes to enter the track number of the last track you want to
play. If you want to play only one track, enter the same number into both boxes.
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Figure 5-19 The Movie And Sound Options dialog box

If you want to play only a portion of the track, you can also enter the starting times
in the Start At box and the ending times in the End At boxes. Using the Start At and
End At boxes means, of course, that you need to know the exact time the portion of
the track you want to listen to starts and ends.

If you want to have the track continue to replay, you can check the Loop Until Stopped
box. The Loop Until Stopped box appears near the top of the Movie And Sound
Options dialog box in the Play Options area.
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Step 6

PREPPREPPREPPREPPREPARE YOUR PRESENTARE YOUR PRESENTARE YOUR PRESENTARE YOUR PRESENTARE YOUR PRESENTAAAAATIONTIONTIONTIONTION

Featuring:Featuring:Featuring:Featuring:Featuring:
• Reviewing Your Presentation

• Creating Speaker’s Notes

• Rehearsing Your Presentation

• Setting Up Your Presentation

• Using the Pack And Go Wizard

After you create your PowerPoint presentation by doing the things described in the
preceding pages of this book, you still need to prepare for the actual presentation you’ll
make by standing in front of an audience. Fortunately, preparing your presentation after
you’ve constructed the actual slides isn’t difficult. You want to review the slides in your
presentation, draft any speaker’s notes you’ll use as you present the slides, and prepare
any handout materials you’ll need for presentation aids. How you accomplish this work
is described in the paragraphs that follow.

Reviewing YReviewing YReviewing YReviewing YReviewing Your Presentationour Presentationour Presentationour Presentationour Presentation
After you create the slides that make up your presentation, you’ll want to review them.
You can do this in either of two ways. You can use Slide Sorter view, which is the
equivalent of an onscreen light table that lets you see, at the same time, each of the
slides in your presentation and their order. Or, you can show the presentation slide-
by-slide—seeing onscreen what your audience will later see in the actual presentation.
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Using Slide Sorter viewUsing Slide Sorter viewUsing Slide Sorter viewUsing Slide Sorter viewUsing Slide Sorter view
To use Slide Sorter view, first open the presentation you want to review, and then
choose the View menu’s Slide Sorter command. PowerPoint displays Slide Sorter view,
as shown in Figure 6-1.

Figure 6-1 Slide Sorter view.

Slide Sorter view displays each of the slides in your presentation, although in minia-
turized versions. You can also verify that their order is correct and, if necessary, change
their order.

NOTENOTENOTENOTENOTE The Zoom box on the Standard toolbar lets you control how large the slides
shown in Slide Sorter view appear. If you want to see bigger pictures of these
slides, enter a larger percentage in the Zoom box. If you enter a very large value
in the Zoom box, the slides will probably get too large to all appear in the
window at one time, but you can still scroll up and down to see them.
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You can use Slide Sorter view to reorganize your presentation’s slides:

• To move a slide to a new position, click the slide and then drag it to the new loca-
tion you want to use. When you release the mouse button, PowerPoint moves the
slide to its new position.

• To delete a slide from the presentation, click the slide and then choose the Edit
menu’s Delete Slide command or press the Delete key.

• To remove a slide without actually deleting it, right-click the slide so that PowerPoint
displays the Shortcuts menu. Then choose its Hide Slide command. To identify a
hidden slide, PowerPoint draws an X through the slide’s number. The slide’s
number appears beneath the lower right corner of the slide. To unhide the slide,
right-click the slide and choose the Shortcuts menu’s Hide Slide command again.

You can also use the Slide Sorter window to review the slide-to-slide transitions and
slide animations. Below the left lower corner of each slide, PowerPoint provides two
small, clickable buttons. Click the first button to see the slide-to-slide transition. Click
the second button to see any animation you’re using on the slide.

Running through the presentationRunning through the presentationRunning through the presentationRunning through the presentationRunning through the presentation
You can also quickly run through the presentation at your own computer in order to
review it. To run your presentation, choose the View menu’s Slide Show command.
When you do, PowerPoint displays the first slide in your presentation using the full
screen, as shown in Figure 6-2. PowerPoint will use any animation or special effects
you’ve specified too.

Figure 6-2 A picture of a first presentation slide.
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To move through your presentation, you simply display the next slide. Assuming that
you are manually controlling the movement through the presentation’s slides, either
click the mouse or press the space bar. If you want to play a movie or sound that
requires manual interaction or triggering, point to the object that represents the movie
or sound.

You can use the left- and right-arrow keys to move forward and backward in a
presentation. Pressing the left-arrow key tells PowerPoint to either display the next
slide or perform the next animation. Pressing the right-arrow key tells PowerPoint to
either display the previous slide or undo the previous animation.

NOTENOTENOTENOTENOTE The right-arrow key or left-arrow key only does the next bit of slide movement
or undoes the last bit. This might be a piece of animation that moves some-
thing onto the slide, or it might be the display of the slide itself.

When you get to the end of the slides, PowerPoint displays a blank or black slide. At
the top of the slide, PowerPoint displays in small type the message “End of slide show,
click to exit.” To finish the slide show, click the screen, press the space bar, or press
the Escape key. PowerPoint redisplays the PowerPoint program window using the same
view it used before you started the slide show.

Creating Speaker’Creating Speaker’Creating Speaker’Creating Speaker’Creating Speaker’s Notess Notess Notess Notess Notes
After you’ve reviewed and tested your presentation, you might want to create speaker’s
notes.

Drafting speaker’Drafting speaker’Drafting speaker’Drafting speaker’Drafting speaker’s notess notess notess notess notes
The easiest way to collect speaker’s notes is by using the Speaker’s Notes pane, which
PowerPoint provides in Normal view. Figure 6-3, for example, shows a simple
presentation displayed using Normal view. Along the left edge of the PowerPoint
Presentation window, the presentation outline appears. In the major part of the
window, PowerPoint shows a picture of the selected slide. Beneath this slide, however,
PowerPoint displays a small pane. You can use this Speaker’s Notes pane to enter any
notes you want to use as you talk about the selected or displayed slide.
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Figure 6-3 The Presentation window.

To enter your speaker’s notes, take the following steps:

1. Display Normal view for the presentation.

Open the presentation if necessary, and then choose the View menu’s Normal
command. PowerPoint displays a Presentation window, as shown in Figure 6-3.

2. Select the first slide in your presentation.

To begin adding speaker’s notes, first click the title slide in your presentation.

3. Enter your welcoming comments or introductory remarks.

With the first title slide selected and displayed, click the Speaker’s Notes pane.
PowerPoint places the insertion point cursor at the beginning of the pane. Now type
whatever remarks you want to use for starting your presentation. You might want
to type complete text or simply the bulleted points you want to make as you begin
your presentation.
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4. Create speaker’s notes for the other slides in your presentation.

Click the next slide without speaker’s notes. After PowerPoint shows that slide in
the Slide pane, use the Speaker’s Notes pane to record what you want to say when
that slide is displayed. Again, all you need to do is click the Speaker’s Notes pane
and then type.

When you complete the speaker’s notes for one slide, repeat this same process to
add speaker’s notes to subsequent slides.

NOTENOTENOTENOTENOTE All the same text-entry and text-editing techniques that work in the Outline
pane also work in the Speaker’s Notes pane.

Planning your speaker’Planning your speaker’Planning your speaker’Planning your speaker’Planning your speaker’s notess notess notess notess notes
As you plan what you want to say, consider taking three steps to make sure you present
relevant, interesting information:

1. Study your audience.

Identify to whom you will be speaking. A good way to do this is to consider what
role they will be playing as they listen: Are they listening as members of a safety
committee? As customers? As your sales staff? As shareholders or stakeholders? As
members of a professional association? What do you think the audience wants to
do with the information you’ll present? Address the audience in the role they are
playing as they listen to you. To do so, it helps to find out (ask a person who will
be in the audience in advance or ask the person who invites you to speak) or figure
out (by using your intuition or knowledge of the group) the audience’s wants,
worries, and wonders. For example, what information about your topic do they want
to hear so that they can make intelligent decisions, meet their goals, or achieve their
dreams? What information don’t they want to hear because they already know it,
or they have absolutely no interest in the topic? What problems do audience mem-
bers wrestle with? What are they afraid of in relation to your topic? What do they
most want to know?

2. Determine your purpose.

When you finish speaking, what’s the one main response you want the audience to
make? What specific points do you want them to remember, understand, or be aware
of? Or, what one (or more) specific action do you want them to take (and what steps
should they take first)? When should they act (deadline or frequency)?



Step 6Step 6Step 6Step 6Step 6   Prepare Your Presentation 121121121121121

3. Determine your message.

If the audience forgets everything else you say, what is the one point you want them
to remember, believe, or do? Can you express this in one complete sentence, or in
a 9-second, 25-word (or less) sound bite? Can you summarize your entire message,
theme, or suggestion in one sentence, or in one word? Lawyers often use a one-word
technique with their opening argument to the jury: “Jealousy. This trial is going to
be all about jealousy,” thereby planting a seed in the minds of the jury. Audiences
enjoy crisp, clear statements they can remember or be inspired to act upon.

WWWWWriting your speaker’riting your speaker’riting your speaker’riting your speaker’riting your speaker’s notess notess notess notess notes
If you want a great way to write speaker notes

or to prepare a complete written speech—

one that is easy to read from—

try the format you’re reading right now.

Instead of writing long paragraphs,

which are easy to get lost in,

write separate lines as you see here.

Include one idea per line.

Each line ends with a pause and a breath.

For easier reading,

experiment with lines set space-and-a-half or double-space.

Make the typeface as large and bold as possible,

so the words can be easily read from belt high.

Mark the key words in each line with a highlighter,

so you can emphasize your ideas.
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To read with complete eye contact,

try this technique after you’ve written and rehearsed the lines.

Glance down at line one and put it in your short-term memory.

Lift your eyes and speak the words looking into someone’s eyes.

Glance down at line two and record it in your memory.

Lift your eyes again and say the words into someone else’s eyes.

Repeat this process for maximum eye contact.

To connect with your audience when you speak,

remember to spend most of your time looking at people’s eyes,

not at your notes or at your slides.

Reviewing your speaker’Reviewing your speaker’Reviewing your speaker’Reviewing your speaker’Reviewing your speaker’s notess notess notess notess notes
After you’ve created your speaker’s notes, you will probably want to print a hard copy.
This might make reviewing them easier. (The onscreen pane is rather small—even if
you resize it.) You’ll also eventually want to have, of course, a printed hard copy of the
speaker’s notes to use as a reference when you make your presentation.

To print your speaker’s notes, simply choose the File menu’s Print command. When
PowerPoint displays the Print dialog box, as shown in Figure 6-4, open the Print What
list box and select the Notes Pages entry. Then click OK. PowerPoint prints each slide
and each slide’s speaker’s notes on a single piece of paper. The printed notes pages then
become a handy tool for both reviewing your speaker’s notes and perhaps for later
actually making your presentation.
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Figure 6-4 The Print dialog box.

Rehearsing YRehearsing YRehearsing YRehearsing YRehearsing Your Presentationour Presentationour Presentationour Presentationour Presentation
After you’ve created your speaker’s notes and printed a copy of the notes pages as a
reference, you will probably want to rehearse your presentation. PowerPoint, fortunately,
includes a handy tool you can use to do this. To rehearse your presentation, including
and perhaps especially the spoken part, open the presentation file you want to rehearse.
Then choose the Slide Show menu’s Rehearse Timings command.

Using the Rehearsal TUsing the Rehearsal TUsing the Rehearsal TUsing the Rehearsal TUsing the Rehearsal Timing windowiming windowiming windowiming windowiming window
When you choose this command, PowerPoint starts the slide show and also displays
a Rehearsal Timing window you can use to time your presentation. Figure 6-5 shows
the way your screen looks. The main part of the screen simply displays a slide from
your presentation. In the upper left corner of the screen, as shown in Figure 6-5, you
can see a small Rehearsal Timing window. This Rehearsal Timing window includes
two timers—one that shows the time you’ve spent on that slide and one that shows
the amount of time you’ve already spent on the presentation. The Rehearsal Timing
window also includes a Pause button you can click to stop your rehearsal and the timer,
a Next button you can use to move to the next slide, and a Repeat button you can use
to restart the rehearsal timing.
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Figure 6-5 The Rehearsal Timing window.

To rehearse your presentation, simply say whatever you want to say about a slide
using the same speaker’s notes you’ll use for your actual presentation. Then click the
Next button and continue for the next slide. As you continue to move through the slides
of your presentation, PowerPoint will track your time.

NOTENOTENOTENOTENOTE Aim for a delivery rate of 160 words a minute. This is the current average for
business and technical presentations.

After you complete your presentation, PowerPoint displays a Message box like the one
shown in Figure 6-6. It shows the total time you spent for the slide show. You can also
tell PowerPoint, simply by clicking the Yes button, that you want to record the time
you spent on each slide and store this information with the slide. You might want to
record your rehearsal timing information. You can later use these times to automate
the display of the next slide, as discussed later in this step, in the section “Setting up
for a delivery.”

Figure 6-6 The Message box that PowerPoint uses to report rehearsal timing information.

NOTENOTENOTENOTENOTE Slide timing information appears in Slide Sorter view in the lower left corner
of each slide.
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VVVVVoice and body language tipsoice and body language tipsoice and body language tipsoice and body language tipsoice and body language tips
To look and sound almost as professional as broadcasters and actors when you deliver
your PowerPoint presentations, you can try several simple yet powerful techniques:

1. Speak in short phrases.

Get in the habit of speaking in short phrases rather than endless rambling sentences.
A phrase is a group of words that express an idea. A phrase may not be a complete
sentence. By short, we mean from 2 to 14 words, with the best lengths being about
5 to 9 words. Short phrases are easier to speak and easier to understand.

2. Pause after phrases.

Follow your short phrases with short pauses. Pauses allow time for ideas to sink in.
As a proverb puts it, “When the words cease, the meaning flows on.” Good speak-
ers are not afraid to pause. A pause signals poise.

3. Drop pitch on endings.

To sound convincing and authoritative, end your phrases and sentences by drop-
ping the pitch of your voice on the last syllable of the last word. If your pitch
inflects up, you may sound wishy-washy, uncertain, as if you’re seeking approval.
Pitching down on endings communicates closure, completeness, and authority in
American spoken English. It is the single most important thing you can do vocally
to be a commanding speaker. Use this technique every time you introduce yourself,
as actors and television broadcasters do.

Remember, drop the pitch (the musical note), not the volume. Let the last syllable
be as loud as the first. Pitch down also at the end of most questions; the only ques-
tions we tend to raise our pitch on are questions that ask for a yes or no answer.
Right?

TIPTIPTIPTIPTIP Speaking in short phrases, followed by pauses, with a strong drop in pitch on
endings can help you speak through extreme nervousness, as well as cure the
“ahs” and “ums.”

4. Pitch up for emphasis.

To get your ideas across with impact, you must emphasize your key words vocally.
To make ideas jump out, raise your pitch on the accented syllable of key words. For
example, if you want to say, “We need more cooperation around here,” cooperation
would be your key idea. To make this idea stand out, emphasize the accented
syllable in this word. You would still end the sentence by dropping your pitch.
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5. Gesture naturally.

Let your hands move naturally as you speak to describe what you are saying.
Gesture with both hands, shoulder-high (or higher for large crowds), with lively
fingers (as if you’re holding a beach ball in your hands). When you are not gestur-
ing, your hands can hang loosely at your sides, or rest gently on a lectern. You can
point at slides with your arms or use a laser pointer, as long as you don’t wiggle the
red dot excessively and create a visual distraction.

NOTENOTENOTENOTENOTE If you hold an object to show the audience, please hold it still for five or six
seconds so we can focus clearly on it; hold objects that you can handle easily
right next to the left side of your face.

6. Stand steady.

For a powerful stance, stand in one spot, with your feet planted shoulder-width apart,
heels closer, toes fanned out slightly. Let your body sink into the earth (feel
gravity acting), and let the earth’s energy come up to animate your body. Gener-
ally, it’s best to speak from one place, feet firmly on the floor, body animated from
the ankles up. You can move to various spots as you talk, get set, and speak from
there for a while. The point is: Avoid aimless wandering. Delivering information
on the run waters it down.

TIPTIPTIPTIPTIP To look tall as a speaker, wear vertical, not horizontal lines; a man’s tie should
reach the belt buckle or lower. To look authoritative, wear dark-colored outer
jackets (dark blue, dark gray; women can wear black), with light-colored shirts
or blouses.

Setting Up YSetting Up YSetting Up YSetting Up YSetting Up Your Presentationour Presentationour Presentationour Presentationour Presentation
After you’ve reviewed your presentation, created your speaker’s notes, and rehearsed
your presentation, you are ready to prepare for showing your presentation. This isn’t
difficult work, and it doesn’t take long (especially after you’ve got some experience).
But you often need to complete three basic tasks:
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• Prepare the PowerPoint presentation file.

• Prepare whatever media you’ll use for actually making the presentation. (This task
may be very easy if you are going to simply show your presentation onscreen, but
more difficult and time-consuming if you want to use 35mm slides or color
transparencies.)

• Prepare any necessary handouts for your audience.

Preparing the presentation filePreparing the presentation filePreparing the presentation filePreparing the presentation filePreparing the presentation file
PowerPoint provides two commands you can use to prepare the presentation file for
use in an actual presentation. PowerPoint’s Custom Show command, which appears
on the Slide Show menu, gives you an easy way to create a presentation by using only
a subset of the presentation’s slides. The Set Up Show command, which also appears
on the Slide Show menu, provides some check boxes and option buttons you can use
to fine-tune the way the presentation runs.

Creating a custom slide showCreating a custom slide showCreating a custom slide showCreating a custom slide showCreating a custom slide show
A custom slide show is just a list, or subset, of slides you want to display as a separate,
customized presentation. To create a custom slide show, choose the Slide Show menu’s
Custom Shows command. PowerPoint displays the Custom Shows dialog box, as
shown in Figure 6-7.

Figure 6-7 The Custom Shows dialog box.

When PowerPoint displays the Custom Shows dialog box, click the New button.
PowerPoint then displays the Define Custom Show dialog box, as shown in Figure
6-8. This dialog box lists the slides that make up your presentation using the Slides
In Presentation box.
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Figure 6-8 The Define Custom Show dialog box.

To create a custom presentation or a custom show using some subset of these slides,
click the first slide you want to add to the custom show, and then click the Add
button. PowerPoint adds the slide to the Slides In Custom Show list box. This shows
you that the slide you just added is the first one in your custom show. To add slides,
click them and then click the Add button. Add slides to the custom show in the same
order you want them to appear. After you’ve defined or identified all the slides you want
to appear, click the OK button.

NOTENOTENOTENOTENOTE You can move a slide shown in the Slides In Custom Show list box to a new
position. To do this, click the slide to select it. Then click either the up-arrow
or down-arrow button to the right of the Slides In Custom Show list box. When
you do, PowerPoint moves the slide either up or down in the list.

Setting up for a deliverySetting up for a deliverySetting up for a deliverySetting up for a deliverySetting up for a delivery
If you are going to use PowerPoint or the Pack And Go Wizard to deliver your
presentation, you first want to set up the presentation. This process just ensures that
your slides are fine-tuned for the way you’ll show them.

NOTENOTENOTENOTENOTE The Pack And Go Wizard is discussed in the section “Using the Pack And Go
Wizard.”

To set up your presentation’s slides, choose the Slide Show menu’s Set Up Show
command. When you do, PowerPoint displays the Set Up Show dialog box, as shown
in Figure 6-9.
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Figure 6-9 The Set Up Show dialog box.

You use this dialog box to fine-tune the presentation’s slides and to specify how your
presentation should progress from slide to slide. To use the dialog box, take the
following steps:

1. Indicate how you’ll deliver your presentation.

You mark the button in the Show Type area that corresponds to the way you will
be presenting your presentation. If you will present the information in person, mark
the Presented By A Speaker button. If you’ll present the information by letting
someone browse the slides of the presentation—in other words, you won’t present
the information; instead, audience members will view the information at their own
pace—click the Browsed By An Individual button. If the information will be
browsed at an unattended computer in a kiosk, click the Browsed At A Kiosk
button.

2. Describe how you want to move to the next slide.

Use the check boxes in the Show Type area to describe how the presentation should
move from slide to slide. For example, if you want the presentation to continue, or
loop continuously, mark the Loop Continuously Until ‘Esc’ box. If you mark this
check box, PowerPoint continues to display the slides in the presentation one after
another until someone presses the Escape key. This means that after the last slide
in the presentation is presented, PowerPoint redisplays the first slide.

NOTENOTENOTENOTENOTE The Show Scroll Bar check box provides another method for moving to the next
slide. If you mark the Show Scrollbar check box, PowerPoint displays a scroll bar
on the side of the Slide Show window. The Slide Show window that
appears is available when you mark the Browsed By An Individual button. This
scroll bar lets the individual browsing your presentation scroll through the
presentation using the scroll bar.
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3. Indicate whether you want to use recorded narration.

If you don’t want to include any narration you recorded for the presentation, leave
the Show Without Narration box unchecked. If you do want to record any narra-
tion, check the box. (Typically, a business professional user of PowerPoint won’t
record narration for a PowerPoint presentation.)

NOTENOTENOTENOTENOTE To record narration for a presentation, you use the Slide Show menu’s Record
Narration command.

4. Indicate whether you want to use animation.

If you want to show your presentation without animation, mark the Show
Without Animation check box. If you do want to include any animation you set up
on slides, unmark this check box, of course.

5. Identify the slides that make up your presentation.

Use the Slides area and its buttons to specify which slides should make up the
presentation. For example, if you want to use all slides in the open presentation, mark
the All button. Alternatively, if you want to show only some of the slides, mark the
From button and then enter the first slide number you want in the From box and
the last slide number you want in the To box. If you set up custom slide shows for
a presentation, you can also mark the Custom Show button. When you mark this
button, PowerPoint lets you select the custom show from the Custom Show drop-
down list box.

6. Tell PowerPoint when it should display the next slide.

You can use the Advance Slides buttons—Manually and Using Timings If Present—
to tell PowerPoint how or when it should display the next slide. If you’re going to
present the slide in person, you will probably click the Manually button. If you click
the Manually button, PowerPoint expects someone to tell it that it should display
the next slide. You tell PowerPoint that you want to display the next slide by pressing
the space bar or clicking the slide with the mouse. If you’re not going to display or
deliver a presentation in person, perhaps the slide show will be viewed at a com-
puter in a kiosk, for example, mark the Using Timings If Present button. This tells
PowerPoint that it should use the rehearsal timings you will have created as part
of rehearsing for your presentation.

7. (Optional) Pick a pen color.

One other setup task you might want to complete is picking a pen color. PowerPoint
lets you use a pen pointer if you want—you can draw on the slides using the mouse
pointer during your presentation. You can use the Pen Color drop-down list box
to pick the best color for your scribbling.
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Preparing any necessary presentation mediaPreparing any necessary presentation mediaPreparing any necessary presentation mediaPreparing any necessary presentation mediaPreparing any necessary presentation media
How you will package your presentation and the media you use depends on the
technology you’ve selected. You have roughly three choices available:

• Display the slides of your presentation either on your own computer or by using the
color projector that projects your computer’s screen onto a larger surface.

• You can use 35mm slides.

• You can use color transparencies and an overhead transparency projector.

NOTENOTENOTENOTENOTE Obviously, if you are going to use a 35mm slide media, you’ll need a 35mm slide
projector. If you are going to use color transparencies, you’ll also need an over-
head transparency projector.

NOTENOTENOTENOTENOTE For information on publishing a presentation to a web server, refer to the
section “Delivering Your Presentation Via the Web” in “Step 7: Deliver Your Pre-
sentation.” You can probably also consult your firm’s web administrator.

Showing your presentation on your computerShowing your presentation on your computerShowing your presentation on your computerShowing your presentation on your computerShowing your presentation on your computer
If you are presenting your slides to a small group, you might be able to do this right
from your laptop. For example, if you are making a presentation to a small group around
a conference table, it might be that your laptop, especially if it has a color monitor, works
fine for sharing your slides.

If you are going to go this route, you don’t need to do anything special to prepare your
presentation. All you need to remember is this: to start your presentation, simply choose
the View menu’s Slide Show command.

Using a color projectorUsing a color projectorUsing a color projectorUsing a color projectorUsing a color projector
Using a color projector should be no more complicated than using your own computer’s
monitor or screen. In fact, all you often need to do is plug in the projector’s cable into
the video socket on the back of your laptop. Your laptop computer probably includes
a video output socket such as the one you might use to plug in a full-size monitor. This
same socket is usually the one you use to plug in a color projector. Note, then, that a
color projector—from the perspective of your laptop—works just like another big
monitor.
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When you do have problems using a color projector, you can use the Projector
Wizard. The Projector Wizard will typically correct any problems that PowerPoint
encounters as it attempts to show slides.

To use the Projector Wizard, choose the Slide Show menu’s Set Up Show command.
When you do, PowerPoint displays the Set Up Show dialog box, as shown in Figure
6-9. This dialog box provides some show-type buttons and boxes you can use to
describe how PowerPoint should run the show, as described previously. The Set Up
Show dialog box also provides a Projector Wizard button.

When you click the Projector Wizard button, PowerPoint starts the Projector
Wizard. It lets you connect your computer to a color projector. Figure 6-10 shows the
first dialog box in the Projector Wizard. The dialog box provides instructions you follow
so that PowerPoint will correctly and successfully show your slides.

Figure 6-10 The first Projector Wizard dialog box.

To use the Projector Wizard, you simply answer the questions the wizard asks. For
example, at the bottom of the first Projector Wizard dialog box, the wizard asks whether
you can see this Wizard box on the projector screen. If you can, click the Yes button;
if you can’t, click the No button. To move to the next Projector Wizard dialog box and
its questions, click the Next button. Figure 6-11 shows the second Projector Wizard
dialog box.
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Figure 6-11 The second Projector Wizard dialog box.

Using color transparenciesUsing color transparenciesUsing color transparenciesUsing color transparenciesUsing color transparencies
Many printers, and especially many color printers, will print on blank transparencies.
Therefore you might be able to use color transparencies for your presentation.

If you are going to use color transparencies, you typically take the following steps:

1. Tell PowerPoint that you want to produce overhead slides.

PowerPoint needs to size the slides used for overhead transparencies slightly
differently from the way it sizes slides for other types of presentations. To tell
PowerPoint that you want your slides sized for overhead transparencies, choose the
File menu’s Page Setup command. When PowerPoint displays the Page Setup dialog
box, as shown in Figure 6-12, select the Overhead size from the Slides Sized For
list box.

Figure 6-12 The Page Setup dialog box.
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2. Print the transparencies.

After you’ve told PowerPoint that you want to produce overhead transparencies, you
can print the transparencies, assuming that you have a color printer. To do this,
choose the File menu’s Print command. Use the Print dialog box, as shown in Figure
6-13, to specify that you want to print slides. To do this, select the Slides entry from
the Print What drop-down list box. If you are going to print overhead transparen-
cies on a color printer, verify that the Grayscale check box and the Pure Black And
White check box are both unmarked. After you’ve done this, click the OK button
to print the slides.

Figure 6-13 The Print dialog box.

NOTENOTENOTENOTENOTE If you have a black-and-white printer, you can also print black-and-white
versions of your slides and use them as transparencies. Obviously, your trans-
parencies in this case are going to be in black, gray, and white.
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Using 35mm slidesUsing 35mm slidesUsing 35mm slidesUsing 35mm slidesUsing 35mm slides
You can produce 35mm slides for individual slides that make up your PowerPoint
presentation. How you do this depends on what sort of equipment you have or don’t
have in-house.

If you have a film recorder attached to your network or desktop computer, you can print
your PowerPoint slides directly to the film recorder. The film recorder will then
create 35mm slides based on the PowerPoint slides. You’ll then need to take this
undeveloped film to a film processor that will develop 35mm slides you can use in your
presentation.

To print slides to a film recorder, take the following steps:

1. Size your slides.

To size your slides so that they’re appropriate for 35mm slides, choose the File
menu’s Page Setup command. When PowerPoint displays the Page Setup dialog
box, as shown earlier in Figure 6-12, choose the 35mm Slides entry from the Slides
Sized For drop-down list box. Then click OK.

2. Print the slides to your film recorder.

After you’ve sized the slides so that they work on 35mm slides, choose the File
menu’s Print command. When PowerPoint displays the Print dialog box, choose
the Film Recorder entry from the Name drop-down list box. In other words, you
are going to print to the Film Recorder. After you do this, verify that the Print What
drop-down list box indicates that you’re printing slides, and verify that neither the
Grayscale nor the Pure Black And White check boxes are marked—if you are print-
ing to 35mm slides, you want to use color.

After you’ve specified how PowerPoint should print, click the OK button.
PowerPoint prints the slides to the film recorder. All you’ll need to do next is have
the film developed.

To create 35mm slides when you don’t have a film recorder—most people probably
don’t—you need to send the PowerPoint presentation to a service bureau that will
convert your PowerPoint slides to 35mm slides. As you might guess, this just means
that the service bureau has a computer attached to a film recorder. You might be able
to look up such a service bureau in your local business or telephone directory. You can
also use the Genigraphics Service Bureau.

To use the Genigraphics Service Bureau, choose the File menu’s Send To command.
When PowerPoint displays the Send To submenu, choose its Genigraphics command.
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PowerPoint then starts the Genigraphics Wizard. Figure 6-14 shows the first dialog
box in the Genigraphics Wizard. What this wizard does, in a nutshell, is use the
Internet to send your PowerPoint presentation to the Genigraphics Service Bureau.
The Genigraphics Service Bureau then creates presentation materials, such as 35mm
slides, for your presentation.

Figure 6-14 The first Genigraphics Wizarddialog box.

NOTENOTENOTENOTENOTE To run the Genigraphics Wizard successfully, your computer or the network on
which you work needs to connect to the Internet. If you don’t have such a
connection, you can also call Genigraphics directly for information on how to
work through the mail. The Genigraphics telephone number is 1-800-790-4001.

Preparing any handoutsPreparing any handoutsPreparing any handoutsPreparing any handoutsPreparing any handouts
One final task you probably want to do is prepare any handouts. Handouts commonly
include black-and-white copies of the screens or slides you’ll show. If you hand these
out as part of your presentation, your audience might be able to take notes. Or, alter-
natively, you might choose to hand out handouts after your presentation, as a way to
remind the audience about what you said.

In either case, producing handouts is straightforward. To produce handouts that show
your PowerPoint slides, take the following steps:

1. Tell PowerPoint you want to print slide information.

To tell PowerPoint that you want to print slide information, choose the File menu’s
Print command. When you do, PowerPoint displays the Print dialog box, as shown
in Figure 6-15.



Step 6Step 6Step 6Step 6Step 6   Prepare Your Presentation 137137137137137

Figure 6-15 The Print dialog box.

2. Tell PowerPoint that you want to create handouts.

To tell PowerPoint that you want to create handouts, select Handouts from the Print
What drop-down list box. You should also use the check boxes at the bottom of the
Print dialog box to indicate whether you are printing in gray-scale or pure black-
and-white.

3. Describe the handouts.

Use the Handouts area and its boxes and buttons to describe how you want
PowerPoint to print the handouts. Use the Slides Per Page drop-down list box, for
example, to tell PowerPoint how many slides it should print on each page. Use the
Order buttons to indicate how PowerPoint should arrange slide images on each page.

After you’ve described the handouts you want, click the OK button. PowerPoint
then prints the handouts in the way you specified.

NOTENOTENOTENOTENOTE If you print three slides per page, PowerPoint includes lines that audience
members can use to jot down notes about the slides.

NOTENOTENOTENOTENOTE Use the Number Of Copies box if you want to print multiple copies of your
handouts; otherwise, you’ll need to use a photocopy machine.
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Using the Pack And Go WizardUsing the Pack And Go WizardUsing the Pack And Go WizardUsing the Pack And Go WizardUsing the Pack And Go Wizard
You don’t actually need the PowerPoint program in order to show a presentation. You
can create a stand-alone version of a presentation that includes all the slides in your
presentation and a PowerPoint browser program, which lets you show those slides.

To create such a stand-alone presentation, you first need to create the presentation and
then prepare it so that it is set up just the way you want it, as described in the preced-
ing paragraphs. After you’ve done this, you can use the Pack And Go Wizard to cre-
ate your stand-alone presentation. To do this, choose the File menu’s Pack And Go
command. PowerPoint starts the Pack And Go Wizard. Figure 6-16 shows the first
dialog box that the Pack And Go Wizard displays. To use the wizard, just answer its
questions by clicking buttons and filling in boxes.

Figure 6-16 The first Pack And Go Wizard dialog box.

The Pack And Go Wizard assumes that you want to package the open presentation,
as the wizard’s dialog box shown in Figure 6-17 indicates. But you can package any
presentation you’ve already created.
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Figure 6-17 The second Pack And Go Wizard dialog box.

The Pack and Go Wizard asks which removable disk you want to use to create the
stand-alone presentation using the dialog box shown in Figure 6-18. The wizard’s other
dialog boxes ask you about which building blocks, such as linked files and fonts, you
want to bundle with your presentation. (Your best bet is to simply accept the default
or suggested settings if you have questions.)

Figure 6-18 The third Pack And Go Wizard dialog box.

After you’ve provided this information, you simply click Finish. PowerPoint then
creates a stand-alone version of your presentation and copies this information to the
removal disk you’ve indicated. PowerPoint will also copy the PowerPoint Viewer
program you use to view this stand-alone program.
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NOTENOTENOTENOTENOTE The PowerPoint Viewer program, when it is installed, takes roughly 5 mega-
bytes of disk space.

NOTENOTENOTENOTENOTE How you use the PowerPoint Viewer program is described in “Step 7: Deliver
Your Presentation.”
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Step 7

DELIVER YOUR PRESENTDELIVER YOUR PRESENTDELIVER YOUR PRESENTDELIVER YOUR PRESENTDELIVER YOUR PRESENTAAAAATIONTIONTIONTIONTION

Featuring:Featuring:Featuring:Featuring:Featuring:
• Starting and Ending Your Presentation

• Delivering a Presentation in Person

• Delivering an Individually Controlled PowerPoint Presentation

• Using a Kiosk

• Delivering Your Presentation Via the Web

• Online Meetings and Presentation Broadcasting

After you have created your presentation and made any preparations, you are ready to
deliver it. You actually have some decisions to make here. PowerPoint provides almost
half a dozen different ways you can present your slides. In the pages that follow, we
will discuss and describe each of the available methods.

Starting and Ending YStarting and Ending YStarting and Ending YStarting and Ending YStarting and Ending Your Presentationour Presentationour Presentationour Presentationour Presentation
When you present in person, you encounter the added challenge of standing in front
of your audience and guiding them through your slides. As with many tasks, practice
and experience make this work much easier and smoother. Even new presenters,
however, can improve their performance by taking the following five steps as they start:
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1.  Greet your audience by smiling.

Let your first words greet the audience graciously, with lively energy. Say not, “good
morning,” but “GOOD MORNING!” Roger Ailes wrote, “An ounce of energy is
worth a pound of technique.” Wear a friendly face and a genuine smile. As you speak
words, look into the eyes of one person in the audience for one or two seconds, then
another person, and another. Smile at least at the beginning and end of each
presentation: Let a smile be the bookends of your talk.

NOTENOTENOTENOTENOTE As you greet the audience, you may want to display your first PowerPoint slide
that states the title of your presentation. The slide might include title, name of
organization, name of presenter, logo, and a graphic element.

2. State a question.

After greeting the audience, ask a question. Questions often create a quest because
they grab and then focus the minds of listeners, pulling them into your topic. You
can experiment with four kinds of questions:

• Direct questions, such as “How many of you have ever received great customer
service?” People often raise their hands, giving you information about them.

• Framed questions, such as “The question before us today is: How can we give
outstanding customer service that people will never forget?”

• Story questions, such as “Imagine this…” then tell a brief story, or give a set of
facts, and follow with a direct or framed question.

• Multiple-choice questions, such as “When customers come to us with a com
plaint, what do you think they want most: To be heard with empathy, to have
the problem fixed, or to have it made up to them?” Multiple-choice questions
are popular on TV quiz shows.

NOTENOTENOTENOTENOTE You can put your question on a slide.     Framed questions work especially well
on slides.

3. Make a promise.

After opening your presentation with a greeting and a question, follow with a prom-
ise. Your promise line does two things: It previews what you’ll give (“Today, I will…),
and promises what they’ll gain (“so that you will…”). “Today (this morning, next
20 minutes), I will (explain, present, give, show, teach, explore, share) three (use a
number instead of “some”) easy ways to handle customer complaints so that you will
understand what customers really want, and you’ll be able to send customers away
satisfied and smiling (include at least two benefits or rewards the listeners will gain
from your talk).”
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4. State your name and credentials.

Now introduce yourself by saying your name—if your audience doesn’t already know
it—and then establish credibility by briefly explaining why you are qualified to talk
about this topic. You might choose to share your job title, company or organization,
years of experience, or something you have in common with the audience that
allows them to bond with you. Even if you have been introduced, you may still want
to share something about yourself that was not said to add credibility or heighten
anticipation.

NOTENOTENOTENOTENOTE It’s not common to use a slide for describing your credentials, although you
might choose to do so. More commonly, presenters provide this information
verbally.

5. Invite questions during or later.

Let listeners know when you want their participation with one of two signals: “If
you have questions or comments as I speak, please raise your hand.” Or, “After my
presentation, I’ll be happy to take your questions and comments.”

When you reach the end of your presentation, you should signal the end is near with
lines such as, “Finally,” “In conclusion,” or “In summary.” This is the time the audi-
ence reawakens. It’s the time to do one of two things, or both.

1. Summarize.

You can use a slide to list key points that you’ve covered, of course, as we discuss in
“Step 2: Outline Your Content.” But you may also have other points—perhaps those
raised by the audience in their questions—that you want to summarize, too.

2. Call to action.

If the purpose of your presentation was to persuade listeners to take some action,
be sure to make this request. In fact, you should have a slide that supports or ex-
plicitly makes this request. In making the request, you can use three degrees of
“push”: invite them to take the action; encourage them; or challenge them to act.

Do everything in your power to end all presentations on a note of positive hope. As
Samuel Johnson reminded us, in our minds we live “not from pleasure to pleasure, but
from hope to hope.” Give listeners something to hope for as you conclude, especially
if the presentation contained bad news.

A simple clear way to end presentations is with these four words: “Thank you for lis-
tening.” If you want questions, don’t whimper, “Any questions”? Instead, open your arms
and invite the audience this way: “And now I welcome your questions and comments.”
And wait for several seconds for the first courageous person to speak.
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Delivering a Presentation in PersonDelivering a Presentation in PersonDelivering a Presentation in PersonDelivering a Presentation in PersonDelivering a Presentation in Person
You can deliver your presentation in person, the most common method that is used.
When you deliver your presentation in person, you probably use the PowerPoint pro-
gram itself to show the slides. You aren’t required to use the PowerPoint program
though. You can also use the PowerPoint Viewer. Both techniques are described in the
sections that follow.

Running the slide show using PowerPointRunning the slide show using PowerPointRunning the slide show using PowerPointRunning the slide show using PowerPointRunning the slide show using PowerPoint
If you’re showing your presentation on a laptop computer, simply choose the Slide Show
menu’s View Show command. When you do this, PowerPoint displays the first slide
in your presentation.

If you’ve indicated that you want to move manually from slide to slide, press the space
bar or use the mouse to click on the slide when you want to move to the next slide.

If you’ve indicated that you want to use rehearsal timings to move from slide to slide,
simply wait for the rehearsal time to pass.

At the end of your slide presentation, PowerPoint displays a blank or black screen. You
might want to leave this screen displayed because it is a good way to end your presen-
tation. You can also move beyond this blank, black screen to the PowerPoint program
window or the PowerPoint Viewer window.

TIPTIPTIPTIPTIP If you’re using a color projector, verify that the slides are readable—people sitting
in the last row should be able to read the smallest word or number. To do this,
fill the entire screen with your projected slide. Often, you need to move the
projector back farther from the screen until the image goes close to the edges.
Also, try to project images on the upper portion of the screen rather than on
the lower so that no one’s head blocks the view. Remember: The bigger the
visual aid, the bigger the impact.

If you’ve told PowerPoint that the slide show should loop continuously, remember that
you need to press the Escape key to terminate the slide show. You can also right-click
the slide so that PowerPoint displays the Shortcuts menu. When the Shortcuts menu
is displayed, choose the End Show command to stop the slide show.
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Reviewing the slide Shortcuts menu commandsReviewing the slide Shortcuts menu commandsReviewing the slide Shortcuts menu commandsReviewing the slide Shortcuts menu commandsReviewing the slide Shortcuts menu commands
If you right-click a slide during a presentation, PowerPoint displays a Shortcuts menu
of commands you might find useful during the presentation. Figure 7-1 shows the
Shortcuts menu.

Figure 7-1 The Shortcuts menu.

The first two commands, Next and Previous, do what you expect. If you choose the
Next command, PowerPoint displays the next slide in the presentation. If you choose
the Previous command, PowerPoint displays the previous slide in the presentation.

You can also use the Go command to display a submenu that lets you choose specific
slides. To choose a specific slide, choose the By Title command from the Go submenu.
Then when PowerPoint displays the sub-submenu, choose the slide you want to see.

The Shortcuts menu also displays two commands that let you, in effect, jump outside
the presentation. The Meeting Minder command displays the Meeting Minder
dialog box, as shown in Figure 7-2. The Meeting Minder dialog box lets you keep
minutes or notes of a presentation meeting. You can also use its Action Items tab to
record action items or to-do list items that stem from the presentation and meeting.
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Figure 7-2 The Meeting Minder dialog box.

The Speaker Notes command displays a Speaker Notes dialog box, as shown in
Figure 7-3. This box shows the speaker’s notes for the slide that’s displayed. If you
forgot your speaker’s notes or want to review or share them publicly, you can choose
this command.

Figure 7-3 The Speaker Notes dialog box.

The Pointer Options command on the Shortcuts menu displays a submenu of
commands you can use to control what the mouse pointer looks like and what it does.
What you will typically want to do with this menu is either choose the Hidden
command to remove the mouse pointer from the screen or choose the Pen command
to turn the mouse into a pen. If you turn the mouse pointer into a pen, you can drag
the mouse pointer to mark the slide with temporary drawn lines. You can use this “pen”
to underline, circle, or diagram on the slide, as shown in Figure 7-4.
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Figure 7-4 A slide with pen markings on it.

NOTENOTENOTENOTENOTE If you choose to use the mouse pen pointer, you might want to use the Pen
Color command, which also appears on the Pointer Options submenu. If you
choose the Pen Color command, PowerPoint displays a menu that lists colors
you can use for the pen. Pick a pen color that gives maximum contrast with the
slide background and the colors used for the slide objects. In this way, your pen
markings will be most legible.

The Help command, which also appears on the Shortcuts menu, is worth
mentioning. Figure 7-5 shows the dialog box that appears when you choose this com-
mand. This Slide Show Help dialog box provides a quick list of keys you can press to
accomplish certain actions while showing your presentation. For example, reading from
the top of the Slide Show Help dialog box, you can see that left-clicking, pressing the
space bar, pressing the letter N, pressing the down-arrow or right-arrow key, or pressing
Enter all tell PowerPoint to advance to the next slide. Review the ways you can
navigate through the slides in a show to discover the method that works best for you.
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Figure 7-5 The Slide Show Help dialog box

We won’t repeat the other information shown in this dialog box, but remember that
this help information is easily available to you.

NOTENOTENOTENOTENOTE The term slide show used in Figure 7-5 might not make much sense if you’ve
been reading this book since page 1, because we’ve avoided the term and
instead used the term presentation. You can, however, distinguish between the
two terms. A slide show consists of slides you’ll show to your audience, including
possibly all the slides in your presentation. However, if you have hidden slides
or have created a custom slide show or have just decided to display only a
contiguous range of slides in your presentation, there might be slides in your
presentation that aren’t in your slide show. A presentation, as we discussed in
“Step 1: Learn the Logic,” is the complete set of slides you’ve created.
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Running a slide show using the PowerPoint VRunning a slide show using the PowerPoint VRunning a slide show using the PowerPoint VRunning a slide show using the PowerPoint VRunning a slide show using the PowerPoint Viewerieweriewerieweriewer
If you created a stand-alone presentation using the Pack And Go Wizard, you’ll need
to set up the PowerPoint Viewer program and then start it in order to deliver your
presentation.

Setting up the PowerPoint VSetting up the PowerPoint VSetting up the PowerPoint VSetting up the PowerPoint VSetting up the PowerPoint Viewerieweriewerieweriewer
To set up the PowerPoint Viewer program, first find or create an empty folder. Then
open the setup program on the disk you created using the Pack And Go Wizard. You
can do this by viewing the disk and using a tool like Windows Explorer or the My
Computer window. When you view the disk you created with the Pack And Go
Wizard, you’ll see the setup program, as shown in Figure 7-6. To start the setup
program, double-click its icon.

Figure 7-6 The My Computer window showing a disk created with the Pack And Go
Wizard.

The setup program asks you for the folder in which the PowerPoint Viewer should
be installed, as shown in Figure 7-7. After the PowerPoint Viewer is installed, the setup
program asks whether you want to run the slide show. Click the Yes button.
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Figure 7-7 The Pack And Go Setup dialog box.

Using the PowerPoint VUsing the PowerPoint VUsing the PowerPoint VUsing the PowerPoint VUsing the PowerPoint Viewerieweriewerieweriewer
To start the PowerPoint Viewer, use a program like Windows Explorer or Windows
NT Explorer to see the contents of the folder you used for the installation, as shown
in Figure 7-8. Then double-click the PowerPoint Viewer item.

Figure 7-8 The PowerPoint Viewer folder.

The Microsoft PowerPoint Viewer dialog box, as shown in Figure 7-9, lists the
PowerPoint Presentations folder. You will probably see only one—the one you set up
using the Pack And Go Wizard. To view this presentation using the Viewer, click the
presentation to select it and then click the Show button. When you do, PowerPoint
displays the first slide in the presentation. To move to the next slide, press the space
bar or click the mouse.
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Figure 7-9 The Microsoft PowerPoint Viewer dialog box.

NOTENOTENOTENOTENOTE The Microsoft PowerPoint Viewer dialog box, as shown in Figure 7-9, includes
Advance Slides buttons you can use to override the Advanced Slides setting you
might have created originally for the presentation.

The PowerPoint Viewer dialog box also includes the Print and Option buttons. The
Print button prints slides in the selected presentation. The Options button displays
the Options dialog box, as shown in Figure 7-10. This dialog box lets you change some
of the presentation specifications you would have set up previously.
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Figure 7-10 The Options dialog box.

The Options dialog box also provides three Viewer Settings check boxes: Popup Menu
On Right Mouse Click, Show Popup Menu Button, and End With Black Slide. The
first two check boxes, if marked, tell the PowerPoint Viewer whether it can display
the Shortcuts menu when you right-click or click the Popup Menu button. The End
With Black Slide check box, if marked, tells PowerPoint to display a black or blank
screen at the end of the presentation rather than redisplay the PowerPoint Viewer
dialog box.

If the Password Locked Slide Show check box is checked in the Microsoft PowerPoint
Viewer dialog box, PowerPoint asks for a kiosk password. Figure 7-11 shows the
dialog box that PowerPoint displays as you start the presentation using the PowerPoint
Viewer. This dialog box asks you to enter a password and then confirm the password
you’ve entered. PowerPoint Viewer then starts the presentation, and runs the slide show
according to your specifications. However, it won’t stop the slide show for anyone who
can’t enter the password. In other words, if you or somebody else attempts to stop the
slide show by pressing the Escape key, the PowerPoint Viewer asks for a password. If
the person requesting that the slide show be stopped can supply the password, the
PowerPoint Viewer will stop the slide show. If someone can’t supply the password,
however, the PowerPoint Viewer won’t stop.
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Figure 7-11 The Password Locked Slide Show dialog box.

Delivering an Individually ControlledDelivering an Individually ControlledDelivering an Individually ControlledDelivering an Individually ControlledDelivering an Individually Controlled
PowerPoint PresentationPowerPoint PresentationPowerPoint PresentationPowerPoint PresentationPowerPoint Presentation

If you have indicated, as part of setting up your slide show, that an individual will control
the show, you start the slide show in the normal way. When you do, PowerPoint
displays your slide show using a web browser like the one shown in Figure 7-12. This
web browser works the same as other web browsers. For example, to move from one
slide to another, you simply click the Back and Forward buttons.
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Figure 7-12 The web browser window.

NOTENOTENOTENOTENOTE If you have set up the presentation to use rehearsal timings, you don’t even need
to click the Back and Forward buttons. PowerPoint will automatically advance
to the next slide when the rehearsal timing time has passed.

To stop an individually controlled slide show, press the Escape key. When you do this,
PowerPoint redisplays the PowerPoint program window.

Using a KioskUsing a KioskUsing a KioskUsing a KioskUsing a Kiosk
If you set up the slide show to be delivered using an unattended computer in a kiosk,
choose the View menu’s Slide Show command. PowerPoint then displays the slide
that’s first in your presentation. Based on rehearsal timings, PowerPoint automatically
moves from slide to slide.

If you check the Loop Continuously Until ‘Esc’ box, PowerPoint repeats the
presentation. When PowerPoint displays the last slide in the slide show, it restarts
the presentation and redisplays the first slide in the slide show.
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Delivering YDelivering YDelivering YDelivering YDelivering Your Presentation Vour Presentation Vour Presentation Vour Presentation Vour Presentation Via the Wia the Wia the Wia the Wia the Webebebebeb
If you have a web server, you can publish a PowerPoint presentation to a web site. After
you do this, anyone with the ability to view that web site can view the slides in your
presentation. After the presentation has been published to the web site, the PowerPoint
slides become, in essence, web pages.

Creating PowerPoint web pagesCreating PowerPoint web pagesCreating PowerPoint web pagesCreating PowerPoint web pagesCreating PowerPoint web pages
To publish a PowerPoint presentation to a web site, take the following steps:

1. Open the presentation.

Open the presentation you want to publish. If you have more than one
presentation open, verify that the presentation you want to publish is the active
presentation.

2. Tell PowerPoint that you want to publish the presentation to the Web.

To tell PowerPoint that you want to publish the presentation to the Web, choose
the File menu’s Save As Web Page command. When you do, PowerPoint displays
the Save As dialog box, as shown in Figure 7-13.

Figure 7-13 The Save As dialog box.
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3. Describe how PowerPoint should create the web pages.

With the Save As dialog box displayed, click the Publish button. When you do,
PowerPoint displays the Publish As Web Page dialog box, as shown in Figure
7-14.

Figure 7-14 The Publish As Web Page dialog box.

Use the Publish What? buttons to indicate whether you want to publish the com-
plete presentation or just a range of slides. Use the Browser Support buttons to
indicate for which web browser you want to publish the presentation.

To describe what you want to publish and the browser you want to support, use the
Publish A Copy As area to specify where you want to publish the presentation.

You can enter in the File Name box the pathname you want to use. The full
pathname includes the drive letter, the folder name, any subfolder names, and the
filename. If you don’t know the pathname, click the Browse button to display the
Publish As dialog box. This dialog box lets you work with the familiar Save In box
and Save In list box to identify the location you want to use for the web pages.

4. Publish the web pages.

After you describe where you want to publish the web pages, click the Publish
button. PowerPoint then creates an HTML, or web page, version of your presen-
tation and saves it in the specified location.
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VVVVViewing PowerPoint web pagesiewing PowerPoint web pagesiewing PowerPoint web pagesiewing PowerPoint web pagesiewing PowerPoint web pages
To view the web version of the PowerPoint presentation, simply open the web page,
or HTML document, that PowerPoint creates. Figure 7-15 shows how a PowerPoint
presentation looks after it has been published as a web page. In the frame along the
left edge of the web browser window, PowerPoint displays a list of the slides in the
presentation. This list is actually a list of hyperlinks. You can click a slide to display
the slide in the main portion of the web browser window. In a small frame below the
actual slide frame, the Browser window will also show your speaker’s notes.

Figure 7-15  A PowerPoint web page.

If you publish the PowerPoint web page to a web server that’s connected to the Internet,
you will be able to view the PowerPoint presentation from any other computer that’s
connected to the Internet. This means, of course, that another option you have for
delivering your presentation is by having people view the web pages with their web
browsers.
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Online Meetings and Presentation BroadcastingOnline Meetings and Presentation BroadcastingOnline Meetings and Presentation BroadcastingOnline Meetings and Presentation BroadcastingOnline Meetings and Presentation Broadcasting
PowerPoint includes two advanced delivery technologies: online meetings and presen-
tation broadcasting. An online meeting lets you show a PowerPoint presentation on
multiple computers, if all the computers are connected to a network. An online meeting
also provides a white board you can use to collect comments from the meeting par-
ticipants.

A presentation broadcast lets you deliver a presentation over a network. PowerPoint
comes with the tools and software you need to deliver a presentation broadcast of as
many as 15 people over a network. But Microsoft sells another product, Net Show
Server, which runs on a Windows 2000 server and lets you show presentation broad-
casts to much larger groups of people.

Some business professionals might want to explore the online meeting and
presentation broadcasting tools. However, in our opinion, these tools require
significantly more PowerPoint and Microsoft Windows expertise than the typical
executive user already possesses or wants to acquire. For that reason, these two
PowerPoint delivery tools aren’t discussed here. If you want information about how
to use them, refer to the PowerPoint User’s Guide.
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Appendix A

USING MICROSOFT GRAPHUSING MICROSOFT GRAPHUSING MICROSOFT GRAPHUSING MICROSOFT GRAPHUSING MICROSOFT GRAPH

Featuring:Featuring:Featuring:Featuring:Featuring:
• Fundamentals of Good Chart Design

• Strengths and Limits of Various Chart Types

• Avoiding Common Charting Mistakes

Although Microsoft Graph makes it very easy to create a chart that looks good, you’ll
find creating truly useful graphics more difficult. For this reason, it seems fair to spend
just a few minutes discussing some of the ideas that the people who think about such
things have in regard to creating good charts.

NOTENOTENOTENOTENOTE If you get interested in the subject of using charts to convey quantitative in-
formation, consider looking at one of Edward Tufte’s books. His books on us-
ing charts and other graphics images to display quantitative information are
arguably the very best books on these subjects—and fun to read.

Fundamentals of Good Chart DesignFundamentals of Good Chart DesignFundamentals of Good Chart DesignFundamentals of Good Chart DesignFundamentals of Good Chart Design
Let’s start this discussion by pointing out that when you create a chart, you do so to
let the chart viewer compare data. This seemingly trivial observation usually produces
some valuable insights into good chart design. It turns out that there are really only
five types of data comparisons you or anyone else can make. These data comparisons
largely determine which type of chart you should use.

To add concreteness to this discussion, let’s say that your organization has some rea-
son for researching religious affiliation in the United States. With a complete and rich
data set, you could make any of these five data comparisons:
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• Part-to-whole comparisons.

In a part-to-whole comparison, you show how the pieces make up a whole. For
example, in a graph showing religious affiliation information, the whole might be
the entire U.S. population. The pieces might be the number of people affiliated with
particular religious groups, faiths, sects, and denominations, such as Anglicans,
Baptists, and Catholics. In a part-to-whole comparison, then, you might compare
the number of Anglicans to the entire U.S. population, the number of Baptists to
the entire U.S. population, and so on.

• Whole-to-whole comparisons.

In a whole-to-whole comparison, you compare whole items to each other. You use
whole-to-whole comparisons to compare absolute numbers. For example, if you were
again preparing a chart that shows religious affiliation, you could compare the ab-
solute number of Anglicans to the absolute number of Baptists and to the absolute
number of Catholics. You might also compare the absolute number of atheists to
the absolute number of agnostics, for example. All these comparisons are whole-
to-whole comparisons.

• Time-series comparisons.

In a time-series comparison, you show how some variable or value changes over time.
If you want to show the growth, decline, or steady state of Catholics in the United
States, you would use a time-series chart.

• Correlation comparisons.

A correlation comparison shows how two variables are related or not related. For
example, if you wanted to use a graph that shows how attendance or affiliation with
churches, synagogues, and mosques varies with the changes in the national income
(assume that they do), you might be able to do so using a correlation comparison.

• Data-map comparisons.

In a data-map comparison, you show how some variable changes geographically.
You might use a data-map comparison to show how religious affiliation varies geo-
graphically. You could use such a data-map comparison to see, for example, whether
the largest population of Southern Baptists really does live in the southern United
States.



Appendix A  Appendix A  Appendix A  Appendix A  Appendix A  Using Microsoft Graph 161161161161161

NOTENOTENOTENOTENOTE The Microsoft Graph application that you have available from PowerPoint lets
you create charts that make the first four types of data comparisons listed in
this section. You can’t create the fifth, the data-map comparison, however, using
a Microsoft Graph. Note, though, that Microsoft Office includes another pro-
gram, Map Point, that does allow you to create a data-map comparison. You
could use one of these data-map comparisons created by Map Point on a
PowerPoint slide. For more information about how to use an object created by
one application or program in PowerPoint, refer to the discussion in “Step 3:
Add Objects.”

After you understand that you can make five basic types of data comparisons using a
chart, picking a chart type becomes quite straightforward. Different chart types make
different comparisons. Therefore, by identifying the data comparison you need to make,
you often implicitly pick a chart type and always narrow the list of appropriate charts
you should choose from.

• To make a part-to-whole data comparison, you need to use a pie chart. No other
chart makes this data comparison.

• To make a whole-to-whole data comparison, you need to use a bar chart, column
chart, radar chart, or surface chart. Note that some of these types of charts can be
displayed in either two-dimensional or three-dimensional format.

• To make a time-series data comparison, you need to use a chart that uses a hori-
zontal data category axis—the horizontal axis shows the passage of time. So, you
could use area charts, column charts, combination charts, and line charts for time-
series data comparisons. Again, some of these types of charts can be shown in ei-
ther a two-dimensional or three-dimensional format.

• To show a correlation comparison, you can use only an XY chart, also sometimes
called a scatter chart.

• Finally, as noted earlier, you can’t make a data-map comparison using Microsoft
Graph. You need to use a data-mapping program to create a data map object and
then copy this data map object to the PowerPoint slide.

NOTENOTENOTENOTENOTE If you’re not familiar with the terms data value, data series, and data category,
you might want to refer to the discussion “Using Charts” in “Step 3: Add
Objects.” It defines these three key charting terms.
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Strengths and Limits of VStrengths and Limits of VStrengths and Limits of VStrengths and Limits of VStrengths and Limits of Various Chart Tarious Chart Tarious Chart Tarious Chart Tarious Chart Typesypesypesypesypes
This discussion doesn’t need to take a lot of time, but we want to quickly discuss some
of the commonly ascribed strengths and limits of the different chart types you will have
available as you work with Microsoft Graph. Because we discuss or introduce an al-
leged strength or limit here doesn’t mean that you should or shouldn’t use a chart.
Nonetheless, you might want to reflect on these discussions as you choose your own
chart types. Even if you don’t hold the thoughts shared here, some members of your
audience might.

Area charts strengths and limitsArea charts strengths and limitsArea charts strengths and limitsArea charts strengths and limitsArea charts strengths and limits
Area charts, like the one shown in Figure A-1, possess several noteworthy strengths.
First, they let you plot very large numbers of data values. Individual data values
simply appear as points along the line—meaning you can create an area chart that shows
hundreds of data values. Area charts work well for showing trends in the first data series
and in the total of all the data series.

Figure A-1  An area chart.
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One thing to note is that you can’t really use an area chart for showing a trend in the
second and any subsequent data series. An area chart stacks the data series values—
that’s how it creates the colored areas shown on the chart. This means that it becomes
impossible to really compare trends in the subsequent data series.

One other unique strength of an area chart is that you can often create an implicit data
series and, if the stacked lines equal some meaningful value, the stacked lines amount
to another data series. For example, if you have a data series for expenses and profits
and the sum of expenses and profits is revenue, you can create an area chart that plots
expense data and profit data. The total area shown by these two data series equals a
third, implicit data series: revenues. This is what Figure A-1 shows.

Despite the strengths that area charts offer, they also possess several limits. You can’t
compare individual data points or data values. You probably won’t be able to identify
or guess at individual data values. And area charts might suggest trends that don’t really
exist or might not be meaningful (particularly if you use an axis that is scaled incor-
rectly or unintelligently).

Bar charts strengths and limitsBar charts strengths and limitsBar charts strengths and limitsBar charts strengths and limitsBar charts strengths and limits
Bar charts are very useful for making whole-to-whole comparisons, particularly when
the categories are not time intervals. The reason that this type works so well is that each
data point is shown by an individual data marker, or bar. And as long as you don’t use
three-dimensional bars, it’s relatively easy to precisely compare one bar to another bar
by using an appropriately calibrated values axis. Figure A-2 shows a bar chart.
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Figure A-2 A bar chart.

Two limits are associated with bar charts. Because each individual data value is depicted
on its own bar, you can’t ever work with very large data sets using a bar chart, particularly
when you are talking about a bar chart you want to use on a PowerPoint slide. As you
add bars to a bar chart, bar widths narrow, and, as the bar width narrows, the chart
becomes less legible.

Another limit related to bar charts concerns a bar chart subtype called a stacked bar
chart. This type of chart stacks the bars within a data category. Although a stacked
bar chart can sometimes be useful, it doesn’t really let you make good whole-to-whole
comparisons. You can compare the first data series values using a stacked bar chart,
but you can’t compare subsequent data series.

Column charts strengths and limitsColumn charts strengths and limitsColumn charts strengths and limitsColumn charts strengths and limitsColumn charts strengths and limits
Column charts work well for making time-series data comparisons when you are not
working with a lengthy time horizon. To show how some data value, such as revenues
or profits, changes over a few years, for example, a column chart works very well. The
horizontal category axis depicts the passage of time in a conventional format (at least
for European and American chart viewers), and the individual data markers, or the
columns, precisely indicate the underlined data values. Figure A-3 shows a column
chart.
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Figure A-3 A column chart.

Column charts suffer from several limits. Like their cousin the bar chart, column charts
don’t let you plot a large number of data values. The more data values, series, or cat-
egories you plot, the narrower and less legible the columns become. Another problem
with column charts is that because category labels go under the horizontal axis, you
often don’t have much room for good, descriptive category labels. You won’t have room,
for example, to use full month names or lengthy product names. A column chart used
to make a time-series comparison might suggest a trend that isn’t real. Finally, a stacked
column chart makes calibrating the second column and any subsequent data series
columns very difficult.

Line charts strengths and limitsLine charts strengths and limitsLine charts strengths and limitsLine charts strengths and limitsLine charts strengths and limits
Line charts, like the one shown in Figure A-4, work well when you have a large data
set to plot. As with area charts, individual data values get plotted as points on a line.
For this reason, you’re practically unlimited (at least visually) in regard to the number
of data values you can plot. Line charts also do a good job of showing trends over time—
assuming that a meaningful trend really exists.
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Figure A-4 A line chart.

NOTENOTENOTENOTENOTE One other unique strength of line charts in general is that they allow you to
use logarithmic scaling. This concept, unfortunately, isn’t available for the line
charts you produce with Microsoft Graph. However, logarithmic scaling is avail-
able for charts you produce with Microsoft Excel. Logarithmic scaling lets you
compare relative changes in data series values. Using logarithmic scaling, for
example, you could compare the 1980s growth rate in revenues of Microsoft
Corporation and International Business Machines Corporation (IBM), even
though during the 1980s Microsoft was a much, much smaller company. Nor-
mal scaling of such a line chart would obscure the fact that Microsoft was
growing at a rate much faster than IBM. By using logarithmic scaling, the relative
growth rates in percentage terms become clear.

Line charts, like every other chart, suffer from limits. A line chart might suggest a trend
that doesn’t exist or suggest relationships or a correlation between data series that don’t
exist. If you choose to put symbols along the line to represent the plotted data values,
you can’t plot many data values without quickly losing legibility because the individual
symbol data markers will begin to overwrite each other.
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Pie charts strengths and limitsPie charts strengths and limitsPie charts strengths and limitsPie charts strengths and limitsPie charts strengths and limits
Pie charts display data in a very simple format. Individual data values get displayed
as segments of a circle or slices in a pie, as shown in Figure A-5.

Figure A-5 A pie chart.

Pie charts, for sophisticated business users, don’t actually possess many true strengths.
Many people argue, in fact, that pie charts should never be used. Whenever you show
data values in a pie chart, you will almost always provide more accurate information
by simply replacing the pie chart with a table. A pie chart can show only one data series

Figure A-6 shows a table with the same information that appears in a pie chart, as
shown in Figure A-5. You would almost always do your audience and chart viewers a
service by replacing the pie chart shown in Figure A-5 with the table shown in
Figure A-6. The table provides more accurate information.
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Figure A-6 A table that shows the same information as the pie chart in Figure A-5.

NOTENOTENOTENOTENOTE In spite of the deficiencies pie charts suffer from, there are special situations
in which a pie chart might make sense. Pie charts (children often learn to use
them in elementary school) are the most common and easily recognized chart
type. Therefore, if you’re presenting information to a group of people who
might not have experience in viewing and interpreting more sophisticated chart
types, you might want or need to use pie charts because you don’t have a better
option.

XY charts strengths and limitsXY charts strengths and limitsXY charts strengths and limitsXY charts strengths and limitsXY charts strengths and limits
XY, or scatter, charts, like the one shown in Figure A-7, probably deliver the most value
and information of any chart type you have available. What an XY chart does is plot
pairs of points. This process initially sounds complicated, but if you see an example
of how it works, it usually becomes very understandable.
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Figure A-7 An XY, or scatter, chart.

Take a look, for example, at the datasheet shown in Figure A-8. This datasheet
provides data values that explore the relationship between the amount of money a small
firm spends on local advertising and the sales revenue it enjoys—presumably partially
as a result.
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Figure A-8 The datasheet for the XY, or scatter, chart shown in Figure A-7.

NOTENOTENOTENOTENOTE The independent variables, or X-values, go into the first row of a datasheet
when you’re creating an XY chart. In other words, these values replace the data
category names.

Only an XY graph like the one shown in A-7 lets you visually explore this type of
relationship. The unique feature that differentiates an XY graph from the other types
is that the horizontal axis actually amounts to a second value axis. This value axis in
combination with the vertical value axis is used to plot the data. In Figure A-7, for
example, what you are really exploring is the relationship of the advertising-expense
data values with the revenue data values. In our obviously fictitious example, Figure
A-7 shows that initially the advertising expenditures seem to produce a nice boost in
sales revenue. But, over time, this relationship diminishes. In other words, there is a
diminishing marginal benefit from the advertising.

So that you understand how powerful this feature of an XY graph is, take a look at
the chart shown in Figure A-9. It shows the same information as in the preceding
figure, except this time in a line chart. Notice that you lose the subtleties in this type
of chart. You don’t see the diminishing marginal benefit of the advertising.
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Figure A-9 A line chart using the data shown in Figure A-8.

XY charts possess a very unique strength: They let you explore the correlation or re-
lationship between two data points. In most people’s minds, for this reason XY charts
represent a superior type of chart. They let your audience or chart viewer visually explore
correlation.

Although XY charts don’t have the sort of obvious, painful limits that other chart types
do, one risk should be mentioned: The fact that an XY, or scatter, chart visually shows
the correlation between two data series doesn’t mean that a correlation or even a re-
lationship actually exists. If you want to present XY charts in a PowerPoint presenta-
tion, you might want to first quantitatively explore the correlation or relationship that
exists. You can do regression analysis fairly easily by using Microsoft Excel.



172172172172172 Effective Executive’s Guide to PowerPoint 2000 - Electronic Edition

NOTENOTENOTENOTENOTE Another book published by Redmond Technology Press, MBA’s Guide To

Microsoft Excel 2000, describes how to use Microsoft Excel for performing
regression analysis. This book should be available at any good bookstore and
is available from all major online bookstores.

Doughnut charts strengths and limitsDoughnut charts strengths and limitsDoughnut charts strengths and limitsDoughnut charts strengths and limitsDoughnut charts strengths and limits
Doughnut charts, as shown in Figure A-10, plot a data series in concentric rings.
Doughnut charts are a way to circumvent the basic problem of using a pie chart, which
is that it allows only a single data series. Nonetheless, doughnut charts really suffer
from the same limits that pie charts do. You would rarely want to use the doughnut
chart, although in some business cultures, doughnut charts are very popular and ap-
pear to be generally accepted.

Figure A-10  A doughnut chart.

NOTENOTENOTENOTENOTE Identifying a data series in a doughnut chart can be challenging. In Figure
A-10, the first ring is the revenue data series, the second is the expense data
series, and the third is the profit data series.
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Radar charts strengths and limitsRadar charts strengths and limitsRadar charts strengths and limitsRadar charts strengths and limitsRadar charts strengths and limits
Radar charts, like the one shown in Figure A-11, possess a unique strength. A radar
chart provides a separate value axis for each data category. Because a radar chart does
use a separate value axis for each data category, it might be possible to more precisely
compare data values within a data category.

Figure A-11 A radar chart.

A radar chart, predictably, suffers from some limits. You can’t easily compare data values
in different data categories. This means, for example, that you can’t easily show a time-
series comparison, nor can you show how data values in a data series change. You can
really only make comparisons within a data category. Another possible problem of using
a tool like the radar chart is that many people aren’t used to seeing and interpreting
this chart type. In this case, you obviously reduce the effectiveness of your presenta-
tion because you have people not understanding or even misunderstanding your
information.
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Surface charts strengths and limitsSurface charts strengths and limitsSurface charts strengths and limitsSurface charts strengths and limitsSurface charts strengths and limits
Three-dimensional surface charts represent the most challenging Microsoft Graph
chart type to use well. What a surface chart does is plot your data set by using either
a two-dimensional or three-dimensional surface, as shown in Figure A-12. In gen-
eral, the most differentiating and apparent feature of the surface chart is that color is
used to show value.

Figure A-12  A surface chart.

The principle challenge in using a surface chart is finding a data set that actually
exploits the surface chart’s characteristics. We find it difficult, quite candidly, to even
think of business examples where a surface chart shows its strength. The only easy-
to-grasp example we can come up with is plotting elevations for Mount St. Helens,
the local volcano that erupted in our backyard roughly two decades ago. By plotting
elevations (assuming that we could find all the data), we could construct a surface chart
that resembles the now dormant volcano.
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NOTENOTENOTENOTENOTE The example of using a surface chart to plot elevation levels for Mount St. Helens
also nicely illustrates how you might use color to scale the surface. You could
use the color white to depict that portion of the mountain typically covered in
snow and use the color green to depict the portion of the mountain that is snow
free.

The unique feature and strength of the surface chart is that this type of chart lets you
easily explore relationships both within a data category and within a data series. The
surface chart doesn’t emphasize data series at the expense of data categories—nor data
categories at the expense of data series.

Surface charts, predictably, suffer from some limits. Perhaps the most important one
to note is that there is not a generally agreed-on way to use color to denote value. Is
green bigger than blue? Is yellow less than red? You see the problem.

One other issue relates to the three-dimensional surface chart types. Obviously, with
a three-dimensional surface chart, it is possible that some portion of the surface will
be obscured. Peaks might obscure valleys.

Bubble charts strengths and limitsBubble charts strengths and limitsBubble charts strengths and limitsBubble charts strengths and limitsBubble charts strengths and limits
A bubble chart, like the one shown in Figure A-13, amounts to a sort of supercharged
XY graph. As you might recall from this Appendix’s earlier discussion, an XY, or scatter,
chart lets you compare two sets of data values by using both the horizontal and ver-
tical axes as values axes. A bubble chart does the same thing. In addition, however, it
lets you incorporate a third set of data values, and this third set of data values deter-
mines the size of the bubble data marker used in the chart.
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Figure A-13  A bubble chart.

A bubble chart theoretically offers you the same advantages as an XY chart. However,
the third data series—the one that sizes the bubbles on your chart—might overcom-
plicate the chart. It seems very likely that this rather exotic chart type might be one
that is too unusual or unfamiliar for most audiences.

Figure A-14 shows the data sheet for the bubble chart shown in Figure A-13. Note
that the last row of the datasheet provides the values that determine the size of the
bubbles.
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Figure A-14  The datasheet used for the bubble chart shown in Figure A-13.

Stock charts strengths and limitsStock charts strengths and limitsStock charts strengths and limitsStock charts strengths and limitsStock charts strengths and limits
The stock chart lets you depict stock price and volume information in a high, low, open,
and close chart. A stock chart is really just a column chart; as a result, it possesses the
same strengths and limts as column charts.

NOTENOTENOTENOTENOTE You can sometimes use a stock chart to depict other data sets. We’ve seen stock
charts used to show weather data, such as the temperature at dawn, noon, and
dusk. Sometimes stock charts, particularly because many business users under-
stand them, can be a very useful addition to your repertoire of graphing tools.
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CylinderCylinderCylinderCylinderCylinder, cone, and pyramid charts strengths, cone, and pyramid charts strengths, cone, and pyramid charts strengths, cone, and pyramid charts strengths, cone, and pyramid charts strengths
and limitsand limitsand limitsand limitsand limits

The remaining three chart types that Microsoft Graph supplies are cylinder charts, cone
charts, and pyramid charts. These three chart types are really all the same. The only
thing that differs from one chart type to the next is the type of data marker used. Really,
these charts are all simply three-dimensional column charts—except that the columns
have been replaced. The cylinder chart doesn’t use columns—it uses cylinders; the cone
chart type doesn’t use columns—it uses cones; and the pyramid chart type doesn’t use
columns—it uses pyramids.

Because the cylinder, cone, and pyramid chart types resemble the column chart type,
they predictably possess the same strengths and limits that the column chart does.

AAAAAvoiding Common Charting Mistakesvoiding Common Charting Mistakesvoiding Common Charting Mistakesvoiding Common Charting Mistakesvoiding Common Charting Mistakes
You can unfortunately make many serious mistakes in constructing charts for a pre-
sentation. Nevertheless, by applying some common sense, you can avoid the most
common and most serious mistakes.

Using the wrong chart typeUsing the wrong chart typeUsing the wrong chart typeUsing the wrong chart typeUsing the wrong chart type
The most common charting mistake must be using the wrong chart type. You really
do want to keep in mind the essential data comparison you want to make on your chart.
After you know which type of data comparison you want to make, you should con-
sider only those chart types that emphasize or support the essential data comparison.

Using the dimension of depth inappropriatelyUsing the dimension of depth inappropriatelyUsing the dimension of depth inappropriatelyUsing the dimension of depth inappropriatelyUsing the dimension of depth inappropriately
A more controversial charting mistake, in our opinion, is the inappropriate use of a
third dimension. By adding a third dimension, you do add visual interest to your charts.
The third dimension of depth tends to make your charts look richer—and that is
appealing, at least on a gut level. However, there is a problem with adding depth to
charts: You lose visual precision. This almost always means that chart viewers will find
it more difficult to precisely compare the data markers. Three-dimensional bars and
columns are challenging to use for comparisons, and three-dimensional lines and area
charts are almost impossible to use for comparison.
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NOTENOTENOTENOTENOTE An old rule of thumb about creating charts is this: Your chart shouldn’t have
more dimensions than your data. For this reason, if we were preparing charts
for a presentation, we would stick with two-dimensional charts. Invariably, your
data set will show only two dimensions, and therefore, your chart should use
only two dimensions. If we were presenting information to an audience view-
ing many other presentations using three-dimensional graphics, we might even
consider stating that our presentation used only two-dimensional charts to make
them more precise.

Creating phantom data markersCreating phantom data markersCreating phantom data markersCreating phantom data markersCreating phantom data markers
A third charting mistake is the problem of other nearby graphics objects being per-
haps subconsciously included as part of the chart. For example, look at the chart shown
in Figure A-15. This simple slide, artificial in its construct, consists of three columns
and a legend.

Figure A-15 A chart that includes a phantom data marker.
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If you take a critical look at the chart shown in Figure A-15, you’ll see that something
curious is happening: The legend box that’s about the same color as the chart data
markers almost without realization amounts to a fourth data marker—and thereby
probably overstates the chart’s message. The three data markers that are part of the
chart show that the values are dropping over time, but the legend box acts like a fourth
phantom data marker that overstates this trend and amplifies it in the viewer’s mind.
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Appendix B

USING WORDARUSING WORDARUSING WORDARUSING WORDARUSING WORDARTTTTT

Featuring:Featuring:Featuring:Featuring:Featuring:
• Creating a WordArt Object

• Working with WordArt Objects on a Slide

• Using the WordArt Toolbar

As mentioned in “Step 3: Add Objects,” you can turn text into a graphics object. To
do this, you use the WordArt applet. WordArt, like Microsoft Graph, is a small
program that comes with PowerPoint.

Creating a WCreating a WCreating a WCreating a WCreating a WordArt ObjectordArt ObjectordArt ObjectordArt ObjectordArt Object
To create a piece of text using WordArt, take the following steps:

1. Start the WordArt applet.

Choose the Insert menu’s Picture command, and then choose the WordArt
command from the Picture submenu. When you do, PowerPoint starts the WordArt
program. The first window you’ll see is the WordArt Gallery, shown in Figure
B-1. This window shows you the various ways you can display the selected text as
a graphics image.
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Figure B-1 The WordArt Gallery window.

2. Select the WordArt style that looks like you want your object to look.

To select a WordArt style, click on the images shown on the WordArt Gallery
window. Then click OK. WordArt displays the Edit WordArt Text window, as
shown in Figure B-2.

Figure B-2 The Edit WordArt Text window.

3. Enter the text.

Use the Edit WordArt Text window to enter the text you want to turn into a
WordArt object.
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4. Select the font.

When WordArt displays the Edit WordArt Text window, use the Font list box to
select the font you want to use. You can click the button at the right end of the Font
list box to display a list of available fonts. The Text box shows you how your font
selection looks—this is the preview area beneath the Font and Size boxes and the
Bold and Italic buttons.

5. Select a point size.

Use the Size box to specify the point size you want WordArt to use for the text. One
point equals 1/72 inch. So, if you want your WordArt text object to measure 1 inch
tall, set the size box to 72 points. If you want the size to measure ½ inch in height,
set the Size box to 36 points.

6. As desired, add boldfacing and italicization.

You can click the Bold and Italic buttons that appear to the right of the Font and
Size boxes, to boldface or italicize the text. The Bold and Italic buttons are toggle
switches: To un-bold and un-italicize the text, click the buttons again.

7. Add the WordArt object to your slide.

After you’ve specified the font, size, and any boldfacing and italicization, click the
OK button. WordArt adds the WordArt object to the PowerPoint slide.

NOTENOTENOTENOTENOTE You can double-click the new WordArt image to redisplay the Edit WordArt
window. This time, however, it provides a Preview button. You can click the
Preview button to see what your WordArt style or text looks like on the slide.
You may need to move the window to see the preview image on the slide.

WWWWWorking with Working with Working with Working with Working with WordArt Objects on a SlideordArt Objects on a SlideordArt Objects on a SlideordArt Objects on a SlideordArt Objects on a Slide
After WordArt adds the object to the PowerPoint slide, as shown in Figure B-3, you
can move and resize the object by clicking and dragging. To correctly position the
WordArt object, drag it to the appropriate location. To resize the object, drag the
selection handles that surround the object. To change the WordArt effect, you can also
typically drag the yellow diamond marker. You would drag this marker, for example,
to make a leaning WordArt object lean more or lean less.
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Figure B-3 A WordArt object on a slide.

Using the WUsing the WUsing the WUsing the WUsing the WordArt TordArt TordArt TordArt TordArt Toolbaroolbaroolbaroolbaroolbar
You can use the WordArt toolbar to make additional changes to the WordArt object.
Figure B-4 shows the WordArt toolbar. The following paragraphs briefly describe what
each of the toolbar buttons does.

Figure B-4 The WordArt toolbar.

NOTENOTENOTENOTENOTE If you point to a toolbar button, WordArt displays the toolbar button’s name.
For example, if you point to the first toolbar button on the WordArt toolbar
or the one that shows a big letter A tipping over, you see the Tool Tip Insert
WordArt. It indicates that the tool’s name is Insert WordArt.
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Inserting another WInserting another WInserting another WInserting another WInserting another WordArt objectordArt objectordArt objectordArt objectordArt object
The Insert WordArt button displays the WordArt Gallery window, as shown in Fig-
ure B-1. You can click this button if you want to add another new WordArt object to
the slide.

Editing WEditing WEditing WEditing WEditing WordArt textordArt textordArt textordArt textordArt text
The Edit Text tool redisplays the Edit WordArt Text window, as shown in Figure
B-2. You can use this window, as discussed earlier, to change the font, size, boldface,
and italics specifications for the WordArt object. You can also use this window’s Text
box to edit the text used to create the WordArt object.

Changing the WChanging the WChanging the WChanging the WChanging the WordArt Gallery settingordArt Gallery settingordArt Gallery settingordArt Gallery settingordArt Gallery setting
The third button, the WordArt Gallery button, lets you select a new gallery setting
for the existing, selected WordArt object. If you click this button, WordArt displays
a WordArt Gallery window similar to the WordArt Gallery window shown in Fig-
ure B-1. (This window differs from the one shown in Figure B-1, however, in that it
provides a Preview button.)

Formatting WFormatting WFormatting WFormatting WFormatting WordArt objectsordArt objectsordArt objectsordArt objectsordArt objects
The WordArt toolbar provides several buttons you can use to change the appearance
of your WordArt objects. The Format WordArt button on the WordArt toolbar lets
you change the color used for the WordArt object; the line, color, and style used to
draw the WordArt object; and the size and layout of the WordArt object.

When you choose the Format WordArt button, WordArt displays the dialog box
shown in Figure B-5. You can use its Colors And Lines tab to change, predictably, the
color and lines used to create the WordArt object. To make changes, simply use the
tab’s drop-down list boxes to select different colors, line styles, and so on.
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Figure B-5 The Colors And Lines tab.

You can use the Size tab, as shown in Figure B-6, to change the dimensions of the
WordArt object.

Figure B-6 The Size tab.

You can use the Position tab, shown in Figure B-7, to describe how the WordArt object
should be positioned on a page in relation to other objects.
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Figure B-7 The Position tab.

The other tabs in the Format WordArt dialog box work in a similar fashion. Not every
tab will be available, however. Some tabs make sense only in certain situations.

The WordArt Shape button displays a menu of pictures you can choose from to se-
lect the shape of the WordArt object, as shown in Figure B-8. You simply click the
shape you want the WordArt object to take.

Figure B-8 The WordArt Shape menu.

The Free Rotate button, if clicked, adds selection handles to the WordArt object. You
can use these selection handles to rotate, or spin, the WordArt object on the page.

The WordArt Same Letter Heights tool lets you tell WordArt that each letter in the
WordArt graphics image should be the same height. The WordArt Same Letter
Heights button is a toggle switch. If you click it again, WordArt resizes the letter
heights back to their original sizes.

The WordArt Vertical Text toolbar lets you flip the WordArt text so that it’s vertical
rather than horizontal. WordArt also adds selection handles after you click the tool.
You can use these selection handles to rotate the object.



The WordArt Alignment button displays a menu of text-alignment options, as shown
in Figure B-9. You simply select the menu command that refers to the text alignment
you want to use for text in the WordArt object.

Figure B-9 The Text Alignment menu.

The WordArt Character Spacing tool, the last one on the toolbar,  displays a menu
of character-spacing commands, as shown in Figure B-10. You choose the character-
spacing command that refers to the type of spacing you want for the text that makes
the WordArt object.

Figure B-10 The Character Spacing menu.

To remove the WordArt toolbar, simply click some other object on the PowerPoint
slide to select it. If the WordArt object isn’t selected, PowerPoint removes the WordArt
toolbar. If you later want to make additional changes to the WordArt object, simply
click the WordArt object again. PowerPoint will reopen the WordArt toolbar. You can
use its buttons to make whatever changes you want.
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Appendix C

SIMPLE PRESENTSIMPLE PRESENTSIMPLE PRESENTSIMPLE PRESENTSIMPLE PRESENTAAAAATION STRATION STRATION STRATION STRATION STRATEGIESTEGIESTEGIESTEGIESTEGIES

Featuring:Featuring:Featuring:Featuring:Featuring:
• Explaining with a Presentation

• Persuading with a Presentation

• Recommending with a Presentation

The AutoContent Wizard described in “Step 2: Outline Your Content” is an easy-to-
use tool for creating lengthy outlines and structuring large presentations—especially
as you start using PowerPoint. You can often employ a simpler strategy, however, when
you want to use a presentation to explain, persuade, or recommend. The paragraphs
that follow describe simple three-, four-, and five-slide presentations you can create
for just these purposes.

Explaining with a PresentationExplaining with a PresentationExplaining with a PresentationExplaining with a PresentationExplaining with a Presentation
Speakers find themselves constantly explaining things: a term, a product, a procedure,
a service, a policy, a regulation, or anything new. This is one of the most common types
of presentation, or part of a presentation, and it lends itself perfectly to PowerPoint
slides. Ancient speaking wisdom tells us: “In all things, seek to be clear.” To explain
anything clearly, answer these questions on your slides.
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Slide 1: What?Slide 1: What?Slide 1: What?Slide 1: What?Slide 1: What?
What are you talking about? Tell them what…

   • it is (give a dictionary definition or vivid description)

   • it isn’t (what it’s not; limits; qualifications)

   • it’s like (compare it to something they already know, or use similes [chattering
like a canary], analogies)

Slide 2: How?Slide 2: How?Slide 2: How?Slide 2: How?Slide 2: How?
Tell them how…

   • it works (how it’s made, runs; processes, procedures)

   • it’s organized (structure, order, arrangement, organization chart)

   • it happened (circumstances, the sequence of events)

Slide 3: Why?Slide 3: Why?Slide 3: Why?Slide 3: Why?Slide 3: Why?
Tell them why. What are the reasons this exists? If you are announcing or explaining
something new, explain the past: the causes, problems, circumstances, or past events
that have led up to the creation of what’s new. Explain what the new thing is by an-
swering the What? and How? questions above. Explain the future: the purpose of
what’s new, the expected outcomes, values, or benefits we hope to gain.

Persuading with a PresentationPersuading with a PresentationPersuading with a PresentationPersuading with a PresentationPersuading with a Presentation
We constantly seek to persuade others: to listen to us, to believe what we say, to take
the actions we recommend. Here is an original format for persuading that lends it-
self perfectly to PowerPoint slides. You know the British proverb: You can lead a horse
to water, but you can’t make him drink. Don’t try to make the horse drink, try to make
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him thirsty. Here’s how to create hunger and thirst for your ideas, products, and
services.

Slide 1: So that…Slide 1: So that…Slide 1: So that…Slide 1: So that…Slide 1: So that…
First, list the rewards, benefits, gains, protections, or good feelings the person will get
by doing what you suggest. Or, name (warn about) the negative consequences the
person will avoid by doing as you say. The secret is to begin with benefits, follow with
advice, requests, or features. Promise what they’ll gain before you tell them what
to do.

Slide 2: Do this…Slide 2: Do this…Slide 2: Do this…Slide 2: Do this…Slide 2: Do this…
List the specific action, behavior, or performance you want the person or group to take.
This should be an action that could be recorded with a video camera—a concrete,
observable action—rather than something in the person’s mind (like “change your
attitude,” which can’t be verified without visible actions or words).

Slide 3: Instead of…Slide 3: Instead of…Slide 3: Instead of…Slide 3: Instead of…Slide 3: Instead of…
To clarify your request for action, let the person know what not to do, the exception.
Sometimes it’s better to express the “instead of ” before the “do this.” For example,
“Instead of trying to create more new customers, why not try to sell more products to
existing customers?”

Slide 4: Because…Slide 4: Because…Slide 4: Because…Slide 4: Because…Slide 4: Because…
Finish with the reasons why: the logical, rational, factual, legal, or legitimate reasons
why the person should take the action you suggest. This may also be the proof that
the benefits you promise are attainable. Sometimes the reason why is because of a law,
regulation, or policy. “Because” appeals to our minds, “so that” appeals to our hearts.
For example, if you want to maintain the good will of a person who has complained,
instead of just apologizing, why not try to make it up to the person by offering some-
thing of value. A gift or good-faith offering (reason) may ease the pain of inconve-
nience the person has suffered, and wins back her trust.
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Recommending with a PresentationRecommending with a PresentationRecommending with a PresentationRecommending with a PresentationRecommending with a Presentation
When you have a hot new idea or solution you want to recommend and you need a
great format for presenting it, try this powerful model that works perfectly with a
minimum of five PowerPoint slides.

Slide 1: Burning issueSlide 1: Burning issueSlide 1: Burning issueSlide 1: Burning issueSlide 1: Burning issue
What’s the burning issue? What’s the problem you face or the issue at hand? In
order to get a handle on any problem, give it to your listeners as a question. For
example, if we’re discussing finding qualified employees, state this issue as a question.
On your first slide write: “How can we find more employees who are qualified?”
Often the best way to start the question is with the words, “How can we...?” or “What
would it take…?”

Slide 2: BackgroundSlide 2: BackgroundSlide 2: BackgroundSlide 2: BackgroundSlide 2: Background
To help listeners understand the situation, on your second slide describe as much of
the background as the audience would need to know to understand the nature and
extent of the problem. You might list the known facts. Or answer questions such as,
“How long has this been going on? What conclusions can you draw from the facts?
What are the consequences of these facts? If we do nothing, what will happen?”

Slide 3: Big ideaSlide 3: Big ideaSlide 3: Big ideaSlide 3: Big ideaSlide 3: Big idea
What do you recommend? What do you propose to resolve the problem or change the
situation? On slide three, state the big idea you’ve come up with: a suggestion, a new
approach, a set of action steps, things to avoid or stop doing, or a next step to take to
find out more. This can appear as a statement or a list, with illustrations of your idea
or graphic symbols.

Slide 4: BenefitsSlide 4: BenefitsSlide 4: BenefitsSlide 4: BenefitsSlide 4: Benefits
What benefits can we expect from your big idea? What’s the payoff? On slide four list
the gains, rewards, positive results, problems solved, advantages, improvements,
protections, or satisfactions we can anticipate. Will the benefits you promise offset the
possible costs (time, money, efforts, risks)? Slides could also be prepared to show the
costs versus benefits of your big idea, advantages/disadvantages. When or how soon
can we expect these benefits?
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Slide 5Slide 5Slide 5Slide 5Slide 5: Best thing to doest thing to doest thing to doest thing to doest thing to do
What’s the best thing for the group and its members to do to begin implementing your
suggestion? What do you need from them? What would you want them to do to get
things going? On slide five, list the specific first steps group members can take. Or,
use this step to launch into creative thinking or brainstorming; ask the group, “What
would it take for us to bring about this solution? What are all the things we might do?”

NOTENOTENOTENOTENOTE These basic steps are an adaptation of ideas developed originally by Ron Hoff
in his fine book, Say It In Six (1996). Hoff designed them for a presentation
lasting six minutes or less. The format could be used for a 30-minute presen-
tation, or in conjunction with a several hour meeting if brainstorming is used.
The format has also been tested in college classes and all five steps have been
clearly presented in 43 seconds! This also makes a fine structure for a written
proposal.
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GLOSSARGLOSSARGLOSSARGLOSSARGLOSSARYYYYY

Animated gifAnimated gifAnimated gifAnimated gifAnimated gif
An animated gif is an image file that shows movement. You commonly see animated
gif images on web pages. Many of the motion clips available from the PowerPoint
Motion Clip Gallery are animated gifs.

AnimationAnimationAnimationAnimationAnimation
Animation simply means movement. You can add movement, or animation, to many
of the objects that appear on a slide, including slide text.

AppletsAppletsAppletsAppletsApplets
Applets are essentially miniature programs that are built into the larger PowerPoint
program. PowerPoint supplies several applets, including Microsoft Graph and the
Microsoft Organization Chart applet.

Audio trackAudio trackAudio trackAudio trackAudio track
A song or part of a song from a music CD that is played when a slide is displayed.

AutoContent WizardAutoContent WizardAutoContent WizardAutoContent WizardAutoContent Wizard
The AutoContent Wizard displays dialog boxes that ask about the presentation you
want to create. Based on your answers, the wizard creates a rough-draft version of the
presentation.
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Auto layoutsAuto layoutsAuto layoutsAuto layoutsAuto layouts
Auto layouts are simply blank slides that include placeholders for things like text and
other objects. When you select an auto layout, simply pick one that shows the object
placeholder or placeholders you want.

Bulleted listBulleted listBulleted listBulleted listBulleted list
A bulleted list is the list of text, or bullet points, that appear on a slide underneath the
slide title. Bulleted lists can also be numbered, in which case they’re not bulleted lists
but rather numbered lists.

ChartChartChartChartChart
A chart is a picture that shows quantitative information. Pie charts, line charts, bar
charts, and column charts are all examples of charts. In PowerPoint, you can create
charts using Microsoft Graph.

Clip GalleryClip GalleryClip GalleryClip GalleryClip Gallery
The Clip Gallery is a tool you use to find and then place on slides the sound clips and
motion clips that come with PowerPoint.

Color schemeColor schemeColor schemeColor schemeColor scheme
A color scheme is a set of eight compatible colors that PowerPoint uses for the parts
of the slides in a presentation.

Custom slide showCustom slide showCustom slide showCustom slide showCustom slide show
A custom slide show is just a list, or subset, of slides you want to display as a separate,
customized presentation.
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Data categoryData categoryData categoryData categoryData category
Data categories organize the data values in the data series. On any chart that shows
how data values change over time, the data category is time, which means that the data
category names will be time-period identifiers: years, quarters, months, or some other
time interval.

Data seriesData seriesData seriesData seriesData series
Data series identify the information you’re plotting on a chart. If you ask the ques-
tion “What does my chart show?,” every one-word answer generally identifies a data
series.

Data valueData valueData valueData valueData value
A data value is the number, or numeric value, that Microsoft Graph uses to create bars,
columns, or lines that visually represent the data on a chart.

Design templateDesign templateDesign templateDesign templateDesign template
A design template provides a color scheme that is used for all the presentation’s slides;
a title master slide, which shows how your title slide looks; a slide master slide, which
shows how the non-title slides in your presentation look; and a set of auto layouts.

Drawn objectsDrawn objectsDrawn objectsDrawn objectsDrawn objects
A drawn object is an object you draw using the PowerPoint drawing tools.

GraphGraphGraphGraphGraph
Graph is an applet, or small program, that you use to create charts for your slides.
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HandoutsHandoutsHandoutsHandoutsHandouts
Handouts are printed copies of your slides that you hand out either before your pre-
sentation so that people can take notes or after your presentation so that people have
a record of what you said.

KioskKioskKioskKioskKiosk
You can set up a slide show to be delivered using an unattended computer—or what’s
known as a kiosk presentation. With a kiosk presentation, PowerPoint automatically
advances from slide to slide based on rehearsal timing data.

Master slideMaster slideMaster slideMaster slideMaster slide
A master slide, essentially, is just a blueprint for creating individual slides.

Meeting MinderMeeting MinderMeeting MinderMeeting MinderMeeting Minder
The Meeting Minder lets you keep minutes or notes of a presentation meeting. You
can also use it to record action items or to-do list items that stem from the presenta-
tion and meeting.

Motion clipMotion clipMotion clipMotion clipMotion clip
A motion clip is a movie, video, or animation file placed on a slide and played when
the slide is displayed.

ObjectsObjectsObjectsObjectsObjects
Objects are tables, charts, and pictures you place on a slide to augment any text. You
can create a rich variety of useful objects using the PowerPoint program. You can also
create objects using other programs like those that make up Microsoft Office. In fact,
anything you can create or store on your computer can probably be turned into an object
and then placed on a PowerPoint slide.
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Online meetingOnline meetingOnline meetingOnline meetingOnline meeting
In an online meeting, you give a PowerPoint presentation on multiple computers
connected to a network and then use an electronic white board to collect comments
from the meeting participants.

Organization ChartOrganization ChartOrganization ChartOrganization ChartOrganization Chart
Organization Chart is an applet or small program you use to create organizational
charts for your slides.

OutlineOutlineOutlineOutlineOutline
An outline is just a list of the slides in your presentation. An outline includes both
the slide titles and, if it exists, any bulleted text.

Pack And Go WizardPack And Go WizardPack And Go WizardPack And Go WizardPack And Go Wizard
The Pack And Go Wizard creates a stand-alone version of a presentation that in-
cludes all the slides in your presentation and a PowerPoint browser program that lets
you show these slides. You use the wizard to create a copy of a presentation you can
show on a computer that doesn’t have the PowerPoint program installed.

PicturePicturePicturePicturePicture
A picture is a photograph or other graphics image stored in a file. You can add a pic-
ture to a slide by using the Clip Gallery.

PlaceholdersPlaceholdersPlaceholdersPlaceholdersPlaceholders
Placeholders amount to boxes, or areas, you use to affix objects or text to a slide.
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PowerPointPowerPointPowerPointPowerPointPowerPoint
PowerPoint is a presentation program. That means, in a nutshell, that it helps you
create slides and then helps you show those slides to audiences. PowerPoint is also part
of the Microsoft Office suite of programs.

PowerPoint program windowPowerPoint program windowPowerPoint program windowPowerPoint program windowPowerPoint program window
The PowerPoint program window shows the usual title bar, menu bar, and one or more
toolbars. In the area beneath the menu bar and toolbars, PowerPoint displays a pre-
sentation window.

PowerPoint VPowerPoint VPowerPoint VPowerPoint VPowerPoint Viewerieweriewerieweriewer
If you create a stand-alone presentation using the Pack And Go Wizard, you use the
separate PowerPoint Viewer program to deliver your presentation.

PresentationPresentationPresentationPresentationPresentation
A presentation consists of the slides you’ve both created and stored in the same file
on your computer. A presentation is also, from the PowerPoint perspective, a docu-
ment file.

Presentation broadcastPresentation broadcastPresentation broadcastPresentation broadcastPresentation broadcast
In a presentation broadcast, you deliver a presentation over a network. PowerPoint
comes with the tools and software you need in order to deliver a presentation broad-
cast of as many as 15 people over a network.

Presentation windowPresentation windowPresentation windowPresentation windowPresentation window
A presentation window is the portion of the screen used to display the presentation
you’ve opened or are creating..

Projector WizardProjector WizardProjector WizardProjector WizardProjector Wizard
The Projector Wizard asks questions about the color projector you’re trying to use and
then typically adjusts PowerPoint to correct for any problems.
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Rehearsal TRehearsal TRehearsal TRehearsal TRehearsal Timing tooliming tooliming tooliming tooliming tool
When you’re rehearsing your presentation, the Rehearsal Timing tool provides tim-
ers that show the time you’ve spent on a slide and on the presentation. You can use
the timing information collected by using this tool to automatically advance through
the slides in a presentation.

SlideSlideSlideSlideSlide
A slide is the basic building block you create using PowerPoint. If you were giving a
slide show using, for example, a 35mm slide projector, what you display on a screen
or wall is a slide.

Slide showSlide showSlide showSlide showSlide show
A slide show consists of the slides you want to present to an audience. A slide show
might include all slides in a presentation or consist of some subset of the slides in a
presentation.

Slide SorterSlide SorterSlide SorterSlide SorterSlide Sorter
The Slide Sorter is a view that displays small pictures of each of the slides in your
presentation. You use the Slide Sorter to verify that both the slides and their order
are correct.

Slide transitionsSlide transitionsSlide transitionsSlide transitionsSlide transitions
Normally, PowerPoint simply displays the next slide in a presentation so that no no-
ticeable transition occurs between slides. You can specify, however, that PowerPoint
use a slide-to-slide transition that makes the change from one slide to the next slide
noticeable. For example, you can tell PowerPoint that the current slide should be wiped
away to review the next slide underneath.

Sound clipSound clipSound clipSound clipSound clip
A sound clip is a sound file placed on a slide and played when the slide is displayed.
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Speaker’Speaker’Speaker’Speaker’Speaker’s notess notess notess notess notes
Speaker’s notes are notes or comments you want to use as you talk about the displayed
slide. The Normal view provides a Speaker’s Notes pane you can use to enter and store
these notes.

Special efSpecial efSpecial efSpecial efSpecial effectsfectsfectsfectsfects
Special effects are garnishments (like slide transitions, animation, sound, and video)
that you add to a presentation to enhance your presentation’s impact and value.

TTTTTableableableableable
A table is a grid of columns and rows. The cells that make up the table—a cell is the
intersection of a column and row—can contain text, number values, or even pictures,
thereby making them powerful tools for organizing information, especially quantita-
tive information, like financial data.

TTTTTextextextextext
Text represents the basic building block and the most common element you’ll use on
your slides. Text is used to label slides, and it can also appear in tables and in bulleted
lists.

VVVVViewiewiewiewiew
A view is just a way of looking at some of the information in a PowerPoint presenta-
tion. One way to look at that information is by looking at the slide and nothing else.
This method is called Slide Show view.

WWWWWeb presentationeb presentationeb presentationeb presentationeb presentation
If you have a web server, you can publish a PowerPoint presentation to a web site. After
you do this, anyone with the ability to view that web site can view the slides in your
presentation. After the presentation has been published to the web site, the PowerPoint
slides become, in essence, web pages.
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WWWWWordArtordArtordArtordArtordArt
WordArt is an applet, or small program, that you use to turn chunks of text into
colorful, interesting graphics objects for your slides.
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35mm slides, 135–36

A
action items, 145
Add Sound dialog box, 96
aligning

table text, 84
text in placeholders, 84
text in tables, 45

anchoring text, 90
animated gifs, 104, 217
animation

adding to all slides, 98
adding to chart objects, 103–4
adding to slide text, 96–99
adding to slide titles, 96–99
controlling effects, 98–99
customizing, 99–104
defined, 217
reviewing, 117

Animation Effects toolbar, 96–99
applets, 6, 217. See also Microsoft Graph;
Microsoft Organization Chart

application window. See program window
area charts, 162–63
audience handouts, 136–37
audio tracks, 113–14, 217
AutoContent Wizard

avoiding, 22
glossary definition, 217

overview, 10–13
using to create outlines, 15–21

auto layouts, 23–24, 70, 218
AutoShapes toolbar, 67
axes, chart, 56, 57

  B
Background dialog box, 75
backgrounds

changing for tables, 45
changing master slide, 75–78

bar charts, 103–4
black & white printing, 134
blank presentations

vs. AutoContent Wizard, 22
vs. design templates, 22, 23, 24
for working from scratch, 23–28

body language, tips for presentations, 125–26
bold characters, 82
borders

for organization chart boxes, 65
for tables and table cells, 44–45

boxes. See borders; placeholders; text boxes, for-
matting text in

broadcasting presentations, 158
bubble charts, 175–77
bulleted lists

adding to slides, 26
changing bullet style, 84–86
defined, 218
example, 5, 27

IndexIndexIndexIndexIndex
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multiple levels of bullets, 33
pictures as bullets, 86
rearranging points, 33

Bullets And Numbering dialog box, 85, 86–87

  C
capitalization. See case, changing
case, changing, 84
CDs, music, 113–14
cells, table

changing border appearance, 45
erasing borders, 44
formatting borders, 44–45

centering text, 45, 84
characters. See fonts; WordArt
Chart Options dialog box, 55–59
charts. See also Organization Chart

adding slides, 52–55
animating, 103–4
area, 162–63
axes on, 56, 58
bar, 103–4
bubble, 175–77
column, 164–65
cone, 178
customizing, 55–59
cylinder, 178
data categories for, 51, 52
and data comparison, 159–61
data labels on, 58
data markers on, 179–80
data series for, 51
data tables on, 58, 59
data values for, 50, 52
defined, 218
design overview, 159–61
doughnut, 172
gridlines on, 57
legends on, 57, 58
line, 165–66

overview of Microsoft Graph, 50–52
pie, 167–68
pyramid, 178
radar, 173
scatter, 168–72
specifying type, 54–55
stock, 177
surface, 174–75
tips for avoiding mistakes, 178–80
titles on, 56
types of, 162–80
xy, 168–72

Chart Type dialog box, 54–55
clipart

adding to slides, 46–48
formatting, 49
making changes to, 49
moving, 48
positioning, 48
selecting, 46–47

Clip Gallery
adding objects to slides, 46–48
defined, 46, 218
selecting motion clips, 108–10
selecting sound clips, 104–7

color
changing color schemes, 78–81
changing master slide background color, 75–78
changing table background, 45
choosing for pen pointer, 130, 147

color schemes, 78–81, 218
Colors dialog box, 75–76, 79, 80, 81
color transparencies, 133–34
column charts, 164–65
columns, adding to tables, 44
comparisons, data, 159–61
cone charts, 178
copying

Microsoft Office objects, 66–67
table data, 42
text in outlines, 31

correlation comparisons, 160, 161

bulleted lists  continued
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Custom Animation dialog box, 100–104, 111, 112
Custom Shows dialog box, 127
custom slide shows, 127–28, 130, 218
Customizing PowerPoint, 195-216
cylinder charts, 178

  D
data categories, 51, 52, 53, 219
data comparisons, 159–61
data labels, 58
data-map comparisons, 160, 161
data markers, 179–80
data series, 51, 53, 219
datasheets, 50–52, 53. See also data tables
data tables, 58, 59
data values, 50, 52, 53, 219
date, adding to slides, 91
design templates

vs. blank presentations, 22, 23, 24
changing selection, 71–73
creating from existing presentations, 72–73
defined, 70, 219
location on disk, 72
overview, 22–23
saving, 72–73
selecting for use, 70–73

document window. See presentation window
doughnut charts, 172
Drawing toolbar, 67, 68
drawn objects, 67–68, 219. See also AutoShapes;
pictures

  E
editing text, 30
electronic slide shows. See slide shows
Excel. See Microsoft Excel

  F
files. See presentations
fill color, selecting for tables, 45
Fill Effects dialog box, 76–78
film recorders, 135
Font dialog box, 82
fonts. See also WordArt

bold, 82
changing, 82–83
italic, 82
replacing, 83
specifying point size, 82
underline, 83

footers, 19
Format dialog box, 88–90
formatting

objects, 88–91
tables, 44–45
text, 81–88
viewing in Outline view, 34

Formatting toolbar, 91–92

  G
Genigraphics Service Bureau, 135–36
Graph feature. See Microsoft Graph
graphic image formats. See clip art; pictures
graphs. See charts
gridlines, chart, 57

  H
handouts, 136–37, 220
Help command, 147–48
hidden slides, 117
HTML. See web pages

  I
importing outlines, 28–30
Insert Object dialog box, 65–66
italic characters, 82
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  J
justifying text, 84

  K
kiosks, 129, 152, 154, 220

  L
labels. See data labels
laptop computers, 131. See also Pack And Go Wiz-
ard

layouts. See AutoLayouts
left-aligning text, 84
legends, chart, 57, 58
line charts, 165–66
lines, spacing of, 87–88. See also borders
logarithmic scaling, 166
looping slide shows, 129, 154
lowercase, 84

  M
Map Point, 161
master slides

changing background color, 75–78
customizing, 73–88
defined, 73, 220
vs. design templates, 73
displaying, 73–74
Handout Master slides, 74
Notes Master slides, 74
relationship to individual slides, 73, 81
Slide Master slides, 74
Title Master slides, 74

media, presentation options. See also multimedia,
customizing effects

35mm slides, 135–36
color projectors, 131–33
color transparencies, 133–34
laptop computers, 131

Media Player, 106
Meeting Minder, 145, 220
menus, showing in full, 31
Microsoft Excel, 66, 67, 166, 171, 172
Microsoft Graph, 50–59, 159–80. See also charts
Microsoft Office, 2, 66–67
Microsoft Organization Chart, 59–65
minimizing windows, 8
minutes, meeting, 145
motion clips, 108–11, 220
mouse pointers, 146
movie clips, adding to slides, 108–11. See also
sound

moving
clip art, 48
outline text, 33
slides in Outline view, 33
slides in Slide Sorter view, 33
table data, 42
tables, 43–44
text, 31

multimedia, customizing effects, 111–13. See also
animation; movie clips, adding to slides; sound

music CDs, 113–14

  N
naming presentations, 19, 25
narration, recording, 130
Net Show Server, 158
networks, using in presentation delivery, 158
New Presentation dialog box, 22, 71
New Slide dialog box, 23
Normal view, 9, 20
notebooks. See laptop computers
notes, meeting, 145
notes pages. See speaker’s notes
numbered lists, changing numbering style, 84,
86–87

numbering slides, 91
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  O
objects. See also charts; clipart; movie clips, adding
to slides; sound; tables

adding existing object files, 65–66
adding from Microsoft Office, 66–67
adding to slides, 65–68
changing appearance, 88–91
coloring, 89
copying, 66–67
creating, 65–66
defined, 6, 220
drawn, 67–68
formatting, 88–91
organization charts as, 6, 59, 65
positioning, 90
resizing, 89
WordArt, 68, 181–88

Office, 2, 66–67
online meetings, 158, 221
opening

outlines, 37
presentations, 37

Organization Chart, 59–65
outlines

collapsing and expanding, 34
creating in word processor, 28
creating using AutoContent Wizard, 15–21
creating using Outline view, 22–28
editing text in, 30–31
glossary definition, 221
importing, 28–30
moving slides in, 33
moving text up and down, 33
opening, 37
overview, 13
promoting and demoting text, 33
rearranging slides in, 33
saving, 36
spell-checking, 35–36
summary slides, 34
using to create presentations, 13
viewing slide formatting, 34

Outline toolbar, 32–34
Outline view, 13, 22–28
overhead slides, 133–34

  P
Pack And Go Wizard, 138–40, 149, 150, 221
page numbers. See slide numbers
passwords, kiosk, 152
pen pointer, 130, 146–47
pictures. See also clipart; drawn objects

adding to slides, 48–49
defined, 221
formatting, 49
making changes to, 49
moving, 49
positioning, 49

Picture toolbar, 49
pie charts, 167–68
placeholders, 5–6, 91, 221
pointers, mouse, 146
Popup Shortcuts menu, 145–48, 152
PowerPoint. See also presentations; slides

glossary definition, 222
how it works, 3–4
key terms, glossary, 4–6
overview, 1–2
program window, 7–8, 222
running slide shows, 144–48
Shortcuts menu, 145–48

PowerPoint dialog box, 11–12, 16, 70–71
PowerPoint Viewer

glossary definition, 222
and Pack And Go Wizard, 139–40, 149, 150
running slide shows with, 149–53

presentation broadcasts, 158, 222
presentation files, 127–30
presentations

adding animation, 96–104
adding first slide, 23–24
adding sound, 104–8
blank, 23
broadcasting, 158
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creating from scratch, 13, 22–28
creating in Outline view, 13, 22–28
creating using AutoContent Wizard, 15–21
defined, 4, 222
delivering, 141–58
ending, 143, 152
naming, 19, 25
opening, 37
preparing file, 127–30
rehearsing, 123–26
reviewing, 115–18
running (See slide shows)
running through, 117–18
saving as Web pages, 155–56
saving in designated folders, 36
setting up, 126–28
simple uses for, 189–93
vs. slide shows, 148
spell-checking, 35–36
starting, 141–43
strategies for, 189–93
tips for speaker’s notes, 120–21
tips for starting and ending, 141–43
tips for voice and body language, 125–26
title slide, 19, 20, 25
ways not to create, 13
ways to create, 10–13

presentation window, 7–8, 222
printing

black & white, 134
to film recorder, 135
handouts, 136–37
speaker’s notes, 122–23
transparencies, 134
using PowerPoint Viewer, 151

program window
defined, 7
illustrated, 7
maximizing, 8
minimizing, 8
presentation window in, 7–8
resizing, 8

Projector Wizard, 132–33, 222
publishing presentations to web sites, 155–56
pyramid charts, 178

  R
radar charts, 173
recording sound files, 108
regression analysis, 171, 172
Rehearsal Timing tool, 123–24, 223
rehearsing presentations, 123–26
replacing fonts, 83
resizing

tables, 42–43
windows, 8

right-aligning text, 84
rows, adding to tables, 44

  S
saving

design templates, 72–73
outlines and presentations, 36
presentations as web pages, 155–56

scatter charts, 168–72
service bureaus, 135–36
Set Up Show dialog box, 128–30
shapes. See AutoShapes; drawn objects
Shortcuts menu, 145–48, 152
slide master slide, 70, 74. See also master slides
Slide Master view, 74
slide numbers, 91
slides. See also presentations

35mm, 135–36
adding date and time, 91
adding pictures, 46–49
animating text, 96–99
as building blocks, 2, 4, 13
changing, 81
defined, 4, 223
first, adding, 23–24
hiding, 117
moving in Outline view, 33

presentations  continued
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moving in Slide Sorter view, 117
numbering, 91
rearranging in Outline view, 33
rearranging in Slide Sorter view, 117
relationship to master slide, 73, 81
summary, 34
titles for, 25–26
title slide, 19, 20, 25
too much information on, 28
transition between, 93–96, 117

Slide Show Help dialog box, 147–48
slide shows

custom, 127–28, 130
defined, 148, 223
looping, 129, 154
vs. presentations, 148
rehearsing, 123–26
running through to review, 117–18
running with PowerPoint, 144–48
running with PowerPoint Viewer, 149–53
setting up, 128–30

Slide Show view, 9
Slide Sorter view, 10, 93–94, 115, 116–17, 223
slide transitions, 93–96, 117, 223
sound clips

adding to presentations, 104–8
glossary definition, 223
as part of slide transition, 95, 96
playing music CD tracks, 113–14
recording, 108
selecting from Clip Gallery, 104–7
as sound files, 107–8

Sound Recorder program, 108
spacing lines, 87–88
speaker’s notes

displaying during presentations, 146
drafting, 118–20
glossary definition, 224
planning, 120–21
printing, 122–23
reviewing, 122–23
tips for creating, 120–21

writing for ease of reading, 121–22
special effects. See also animation; movie clips, add-
ing to slides; sound

glossary definition, 224
transitions between slides, 93–96, 117

spell-checking presentations, 35–36
spreadsheets. See Microsoft Excel
stock charts, 177
summary slides, 34
surface charts, 174–75

  T
tables. See also data tables

adding rows or columns, 44
adding to charts, 58, 59
adding to slides, 39–41
changing background color, 45
cutting and pasting in, 42
filling with information, 41–42
formatting, 44–45
formatting borders, 44–45
glossary definition, 224
moving, 43–44
positioning, 43–44
resizing, 42–43

Tables and Borders toolbar, 44–45
templates. See design templates
text

aligning in placeholders, 84
aligning in tables, 45
anchoring in text objects, 90
animating, 96–99
centering, 45, 84
changing case, 84
changing font, 82–83
copying, 31
defined, 5, 224
deleting, 30
editing, 30
formatting, 81–88
justifying, 84
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left-aligning, 84
limiting, 28
line spacing, 87–88
moving, 31
right-aligning, 84
selecting, 30

text boxes, formatting text in, 90
35mm slides, 135–36
time, adding to slides, 91
time-series charts, 52, 160, 161
timing, presentation rehearsals, 123–24, 130
title master slide, 70, 74
titles

animating, 96–99
for chart axes, 56
for charts, 56
for presentations, 19, 20, 25
for slides, 25–26

title slides, 19, 20, 25
toolbars

Drawing toolbar, 67, 68
Formatting toolbar, 91–92
Outlining toolbar, 32–34
Picture toolbar, 49
showing/hiding, 32
Tables and Borders toolbar, 44–45
WordArt, 184

transition between slides, 93–96, 117
transparencies, color, 133–34. See also 35mm slides

  U
underlining, 83
uppercase, 84

  V
video clips, adding to slides, 108–11
viewer. See PowerPoint Viewer
views, 9–10, 224
voice, tips for presentations, 125–26

  W
Web, delivering presentations via, 155–57, 224
web browsers, using to display slide shows, 153–54,
157

web pages
publishing presentations to web sites, 155–56,

224
text replacements for graphic images, 90
viewing presentations as, 157

windows
document, 7–8
maximizing, 8
minimizing, 8
presentation, 7–8, 200
program, 7–8
resizing, 8

Windows Media Player, 106
wizards

AutoContent Wizard, 10–13, 15–21
defined, 4
Pack And Go Wizard, 138–40, 149, 150
Projector Wizard, 132–33

WordArt, 68, 181–88, 225
World Wide Web. See web pages
wrapping text, 90

  X
xy (scatter) charts, 168–72

text  continued
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to the printer as electronic prepress files.
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